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Purpose of This Guide

Preface

About the System  The guides listed below are shipped with the Applied Biosystems StepOne™ and

Documentation

StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

Guide Purpose and Audience PN
Applied Biosystems StepOne™/StepOnePlus™ Real- Explains how to perform experiments on the 4376786
Time PCR System Getting Started Guide for StepOne™ and StepOnePlus™ systems. Each Getting
Genotyping Experiments Started Guide functions as both:
Applied Biosystems StepOne™/StepOnePlus™ Real- * Atutorial, using example experiment data provided | 4376797
ﬂ?)f;)e PCR S)%stem Gettigg Started guide for with the Applied Biosystems SteTp“)nOne Real-Time
Presence/Absence Experiments PCR System Software (StepOne ™ software).
¢ A guide for your own experiments.
Applied Biosystems StepOne™/StepOnePlus™ Real- L 4376785
' ! ; . Intended for laboratory staff and principal
T StepOne ™ or StepOnePlus™ system.
Applied Biosystems StepOne™/StepOnePlus™ Real- 4376784
Time PCR System Getting Started Guide for Standard
Curve Experiments
Applied Biosystems 7500/7500Fast, StepOne™, and 4411937
StepOnePlus™ Real-Time PCR Systems Quick
Reference Card for Comparative C; Experiments and
Studies
Applied Biosystems StepOne™/StepOnePlus™ Real- Explains how to install and maintain the StepOne™ 4376782
Time PCR System Installation, Networking, and and StepOnePlus™ systems.
Maintenance Guide Intended for laboratory staff responsible for the
Applied Biosystems StepOne™/StepOnePlus™ Real- gstagatlo;l and maintenance of the StepOne ™ or 4376783
Time PCR System Installation Quick Reference Card tepOnePlus™ system.
Applied Biosystems StepOne™/StepOnePlus™ Real- Provides information about the reagents you can use | 4379704
Time PCR System Reagent Guide on the StepOne™ and StepOnePlus™ systems,
including:
¢ An introduction to TagMan® and SYBR® Green
reagents
¢ Descriptions and design guidelines for the
following experiment types:
— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments
Intended for laboratory staff and principal
investigators who perform experiments using the
StepOne™ or StepOnePlus™ system.
11
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Preface
Purpose of This Guide

Guide Purpose and Audience PN
Applied Biosystems StepOne™/StepOnePlus™ Real- Explains how to prepare your site to receive and install | 4376768
Time PCR System Site Preparation Guide the StepOne™ or StepOnePlus™ systems.
Intended for personnel who schedule, manage, and
perform the tasks required to prepare your site for
installation of the StepOne™ or StepOnePlus™ system.
Applied Biosystems StepOne™ Real-Time PCR Explains how to use the StepOne™ software to: NA

System Software Help

e Set up, run, and analyze experiments using the
StepOne™ and StepOnePlus™ systems.

¢ Monitor networked StepOne™ and StepOnePlus™
instruments.

¢ Calibrate StepOne™ and StepOnePlus™
instruments.

* \Verify the performance of StepOne™ and
StepOnePlus™ instruments with an RNase P run.

Intended for:

e Laboratory staff and principal investigators who
perform experiments using the StepOne™ or
StepOnePlus™ system.

e Laboratory staff responsible for the installation and
maintenance of the StepOne™ or StepOnePlus™
system.

Text Conventions

This guide uses the following conventions:

» Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.
* Italic text indicates new or important words and is also used for emphasis. For example:
Before analyzing, always prepare fresh matrix.

» Arright arrow symbol ( » ) separates successive commands you select from adrop-down
or shortcut menu. For example:

Select File » Open.

User Attention
Words

Two user attention words appear in the user documentation. Each word implies a particular
level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use of

the product.

IMPORTANT! — Providesinformation that is hecessary for proper instrument operation,
accurate chemistry kit use, or safe use of achemical.

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need avaid user ID.

12 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
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How to Obtain More Information

Safety Alert Words  Safety alert words also appear in user documentation. For more information, see “ Safety

Alert Words’ on page 15.

How to Obtain More Information

Related StepOne™ and StepOnePlus™ System Documents Available for Sale
Documentation

Maintenance Protocol

Document PN
Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Installation | 4376791
Performance Verification Protocol
Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Installation | 4376790
Qualification-Operation Qualification Protocol
Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Planned 4376788

Note: For more documentation, see “How to Obtain Support” on page 14.

Obtaining The StepOne™ Software Help describes how to use each feature of the user interface. Access

Information from  the Help from within the StepOne™ software by doing one of the following:
the Software Help . pressF1
* Click @ inthetoolbar.
o Select Help » SepOne Help.

To find topics of interest in the Help:
* Review the table of contents.
» Search for a specific topic.
 Search an alphabetized index.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
Installation, Networking, and Maintenance Guide
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How to Obtain Support

How to Obtain Support

14

For the latest services and support information for all locations, go to
www.ther mofisher.com, then click the link for Support.
At the Support page, you can:
 Search through frequently asked questions (FAQs)
» Submit a question directly to Technical Support
* Order user documents, SDSs, certificates of analysis, and other related documents
» Download PDF documents
 Obtain information about customer training
» Download software updates and patches

In addition, the Support page provides access to worl dwide telephone and fax numbersto
contact Technical Support and Salesfacilities.

Customer Care Center

Contact the Customer Care Center when directed by this guide, or to schedule maintenance
for your instrument (such as, annua planned maintenance or temperature
verification/calibration). To contact the Customer Care Center call 1-800-762-4001, Option 1
(U.S.A. only). For al other countries, please contact your local support service
representative.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
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Safety Conventions Used in This Document

Safety Conventions Used in This Document

Safety Alert Words  Four safety alert words appear in the user documentation at pointsin the document where you
need to be aware of relevant hazards. Each alert word—I MPORTANT, CAUTION,
WARNING, DANGER—implies aparticular level of observation or action, as defined
below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of achemical.

A (O7:.\1[eN] — Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to aert against unsafe practices.

A WWLGIVIN[ed — Indicates a potentially hazardous situation that, if not avoided, could

result in desath or seriousinjury.

A 2\ [efS5) - Indicates an imminently hazardous situation that, if not avoided, will

result in death or seriousinjury. Thissignal word islimited to the most extreme situations.

Except for IMPORTANTS, each safety alert word in the document appears with an open
triangle figure that contains a hazard symbol. These hazard symbols are identical to the
hazard symbols that are affixed to the instruments (see “ Safety Symbols’ on page 16).

Examples

IMPORTANT! You must create a separate spreadsheet for each 96-well plate.

ACAUTION CHEMICAL HAZARD. TagMan Universal PCR Master Mix may

cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read
the SDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing,
and gloves.

AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

heated cover and sample block can reach temperatures in excess of 100°C.

A pZW[elS5] ELECTRICAL HAZARD. Grounding circuit continuity isvital for the

safe operation. Never operate the system with the grounding conductor disconnected.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 15
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Symbols on the Instruments

Symbols on the Instruments

Electrical Thefollowing electrical symbols may be displayed on the instruments.
Symbols
Symbol Description Symbol Description
Indicates the On position of the J_ Indicates a terminal that may be
I main power switch. — connected to the signal ground
= reference of another instrument.
This is not a protected ground
Indicates the Off position of the terminal.
O main power switch.
Indicates a protective grounding
terminal that must be connected to
( I ) the instrument is switched on to the electrical connections are made to
Standby condition. Hazardous the instrument.
voltage may be present if this
switch is on standby. Indicates a terminal that can receive
L d or supply alternating current or
voltage.
Indicates the On/Off position of a Indicates a terminal that can receive
® push-push main power switch. = or supply alternating or direct
current or voltage.
Safety Symbols Thefollowing safety symbols may be displayed on the instruments. Each symbol may appear

by itself or with text that explainsthe relevant hazard (see* Safety Labels on Instruments’ on
page 17). These safety symbols may also appear next to DANGERS, WARNINGS, and
CAUTIONS that occur in this and other documents.

Symbol

Description

Symbol

Description

/N

Indicates that you should consult
the manual for further information
and to proceed with appropriate
caution.

/5

Indicates the presence of moving
parts and to proceed with
appropriate caution.

/N

Indicates the presence of a hot
surface or other high-temperature
hazard and to proceed with
appropriate caution.

/N

Indicates the presence of an
electrical shock hazard and to
proceed with appropriate caution.

/A

Indicates the presence of a laser
inside the instrument and to
proceed with appropriate caution.

Environmental
Symbols

The following symbol appliesto all al electrical and electronic products placed on the
European market after August 13, 2005.

Symbol

X]
(e

Description

Do not dispose of this product as unsorted municipal waste.
Follow local municipal waste ordinances for proper disposal provisions to reduce
the environmental impact of waste electrical and electronic equipment (WEEE).

European Union customers:

Call your local Customer Service office for equipment pick-up and recycling. See
www.lifetechnologies.com for a list of customer service offices in the European

Union.

16
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Safety Labels on Instruments

Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on the

Locations of
Warnings

instruments in combination with the safety symbols described in the preceding section.

English

Francais

CAUTION Hazardous chemicals. Read the
Safety Data Sheets (SDSs) before handling.

CAUTION Hazardous waste. Refer to SDS(s)
and local regulations for handling and
disposal.

ATTENTION Produits chimiques dangeureux.
Lire les fiches techniques de sireté de
matériels avant la manipulation des produits.

ATTENTION Déchets dangereux. Lire les
fiches techniques de s(ireté de matériels et la
régulation locale associées a la manipulation
et I'élimination des déchets.

CAUTION Hot surface.

ATTENTION Surface brilante.

DANGER High voltage.

DANGER Haute tension.

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.

Refer servicing to qualified service personnel.

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite I'utilisation d'outils.
L’instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Thermo Fisher Scientific.

CAUTION Moving parts.

ATTENTION Parties mobiles.

DANGER Class 3B (lll) visible and/or invisible
LED radiation present when open and

interlocks defeated. Avoid exposure to beam.

DANGER Rayonnement visible ou invisible
d’un faisceau LED de Classe 3B, (lll) en cas
d’ouverture et de neutralisation des
dispositifs de sécurité. Evitez toute
exposition au faisceau.

The system contains awarning at the location shown below:

/A CAUTION HOT

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 17
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General Instrument Safety

General Instrument Safety

Moving and Lifting
the Instrument

Moving and Lifting
Computers and
Monitors

Operating the
Instrument

Cleaning or
Decontaminating
the Instrument

18

AWARNING PHYSICAL INJURY HAZARD. Using theinstrument in amanner not

specified by us may result in personal injury or damage to the instrument.

ACAUTION PHYSICAL INJURY HAZARD. The instrument is to be moved and

positioned only by the personnel or vendor specified in the applicable site preparation guide.
If you decide to lift or move the instrument after it has been installed, do not attempt to lift or
move the instrument without the assistance of others, the use of appropriate moving
equipment, and proper lifting techniques. Improper lifting can cause painful and permanent
back injury. Depending on the weight, moving or lifting an instrument may require two or
more persons.

AWARNING Do not attempt to lift or move the computer or the monitor without the

assistance of others. Depending on the weight of the computer and/or the monitor, moving
them may require two or more people.

Thingsto consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object isto where it is being moved is clear of
obstructions.

» Do not lift an object and twist your torso at the same time.

» Keep your spinein agood neutral position while lifting with your legs.

* Participants should coordinate lift and move intentions with each other before lifting and
carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side and
hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has.

» Receivedinstructionsin both general safety practicesfor laboratories and specific safety
practices for the instrument.

» Read and understood all applicable Safety Data Sheets (SDSs). See “About SDSs’ on
page 19.

A (o7\I[e)\] Before using a cleaning or decontamination method other than those

recommended by the manufacturer, verify with the manufacturer that the proposed method
will not damage the equipment.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
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Chemical Safety

Chemical Safety

Chemical Hazard
Warning

Chemical Safety
Guidelines

About SDSs

AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to the

Safety Data Sheet (SDS) provided by the manufacturer, and observe al relevant precautions.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or storewastein a

glass container because of the risk of breaking or shattering. Reagent and waste bottles can
crack and leak. Each waste bottle should be secured in alow-density polyethylene safety
container with the cover fastened and the handles locked in the upright position. Wear
appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

To minimize the hazards of chemicals;

» Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. (See “ About SDSS’ on page 19.)

» Minimize contact with chemicals. Wear appropriate persona protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective clothing).
For additional safety guidelines, consult the SDS.

» Minimizetheinhaation of chemicals. Do not leave chemical containers open. Use only
with adequate ventilation (for example, fume hood). For additional safety guidelines,
consult the SDS.

» Check regularly for chemical leaks or spills. If aleak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

» Comply with al local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments of
hazardous chemicals to new customers. They aso provide SDSs with the first shipment of a
hazardous chemical to a customer after an SDS has been updated. SDSs provide the safety
information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive anew SDS packaged with ahazardous chemical, be sure to replace the
appropriate SDSin your files.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 19
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Chemical Safety

Obtaining The SDSfor any chemical supplied by usis available to you free 24 hours aday. To
SDSs obtain SDSs:

1. Go to www.lifetchnologies.com/support
2. ClicktheMSDS, COA & other Support Documents link.

3. IntheRedifine your search field:

a. Typethe chemical name, part number, or other information that you expect to
appear in the SDS of interest.

b. Select Material Safety Data Sheetsin the drop-down list.
c. Click Search.
4. To view, download, or print the document of interest:
a. Click thelink below MSDS Files.
b. Click thelink for the language of choice.

The SDS opens in the web broswer. You can print or save the SDS.

Note: For the SDSs of chemicals not distributed by us, contact the chemical
manuf acturer.

20 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
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Chemical Waste Safety

Chemical Waste Safety

Chemical Waste ACAUTION HAZARDOUSWASTE. Refer to Safety Data Sheets and local
Hazard regulationsfor handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by instruments are

potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or storewastein a

glass container because of the risk of breaking or shattering. Reagent and waste bottles can
crack and leak. Each waste bottle should be secured in alow-density polyethylene safety
container with the cover fastened and the handles locked in the upright position. Wear
appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines . Read and understand the Safety Data Sheets (SDSs) provided by the manufacturers of
the chemicals in the waste container before you store, handle, or dispose of chemical
waste.

* Provide primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary
container. Both containers must be compatible with the waste material and meet federal,
state, and local requirements for container storage.)

» Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective clothing).
For additional safety guidelines, consult the SDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only
with adeguate ventilation (for example, fume hood). For additional safety guidelines,
consult the SDS.

» Handle chemical wastesin afume hood.
» After emptying awaste container, seal it with the cap provided.

 Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or nationa environmental and health
regulations.

Waste Disposal If potentialy hazardous waste is generated when you operate the instrument, you must:

» Characterize (by analysisif necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

 Ensure the health and safety of all personnel in your laboratory.

 Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 21
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Electrical Safety

Electrical Safety

Fuses

Power

Overvoltage Rating

LED Safety

22

pL\\[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can result
from operating the system without its instrument panels in place. Do not remove instrument
panels. High-voltage contacts are exposed when instrument panels are removed from the

[

=
4
c
=
2

T

LWL WINTed FIRE HAZARD. Improper fuses or high-voltage supply can damage

the instrument wiring system and cause afire. Before turning on the instrument, verify that
the fuses are properly installed and that the instrument voltage matches the power supply in
your laboratory.

T

LZGWINel FIRE HAZARD. For continued protection against the risk of fire,
eplace fuses only with fuses of the type and rating specified for the instrument.

-

[

pL\\[e]F3] ELECTRICAL HAZARD. Grounding circuit continuity is vital for the
safe operation of equipment. Never operate equipment with the grounding conductor

o
8
3
8
8

>

pZ{ela5) ELECTRICAL HAZARD. Use properly configured and approved line
cords for the voltage supply in your facility.

[

pL\[e]F93] ELECTRICAL HAZARD. Plug the system into a properly grounded
receptacle with adequate current capacity.

The StepOne™ and StepOnePlus™ systems have an installation (overvoltage) category of |1,
and are classified as portable equipment.

To ensure safe LED operation:
* The system must be maintained by a Technical Representative from the company.

« All instrument panels must be in place on the instrument while the instrument is
operating. When all panels are installed, there is no detectable radiation present. If any
panel is removed when the LED is operating (during service with safety interlocks
disabled), you may be exposed to LED emissions in excess of the Class 3B rating.

* Do not remove safety labels or disable safety interlocks.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
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Biological Hazard Safety

General Biohazard BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national regulations.
Wear appropriate protective equipment, which includes but is not limited to: protective
eyewear, face shield, clothing/lab coat, and gloves. All work should be conducted in properly
equipped facilities using the appropriate safety equipment (for example, physical
containment devices). Individuals should be trained according to applicable regulatory and
company/ingtitution reguirements before working with potentially infectious materials. Read
and follow the applicable guidelines and/or regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines published in Biosafety in
Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
bmbl.od.nih.gov)

» Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR§1910.1030;
www.access.gpo.gov/ nara/cfr/waisidx_01/ 29cfr1910a_01.html).

» Your company’gingtitution’s Biosafety Program protocols for working with/handling
potentially infectious materials.

Additional information about biohazard guidelinesis available at:

www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as
fatigue, pain, and strain. Minimize or eliminate these effects by configuring your workstation
to promote neutral or relaxed working positions.

ACAUTION MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD.

These hazards are caused by potential risk factors that include but are not limited to repetitive
motion, awkward posture, forceful exertion, holding static unhealthy positions, contact
pressure, and other workstation environmental factors.

To minimize muscul oskeletal and repetitive motion risks:

» Use equipment that comfortably supports you in neutral working positions and allows
adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head postures.
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Safety and Electromagnetic Compatibility (EMC) Standards

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and Canadian The system has been tested to and complies with standard:

Stansc,ja;f(;qs, UL 61010-1/ CAN/CSA C22.2 No. 61010-1, “ Safety Requirements for Electrical
Equipment for Measurement, Control, and Laboratory Use, Part 1: General

Requirements.”
c(UL)ys R

Canadian EMC  Theinstrument has been tested to and complies with ICES-001, Issue 4: “Industrial,
Standard Scientific, and Medical Radio Frequency Generators.”

European Safety, Safety

RoHS Directive, Thisinstrument meets European requirements for safety (Low Voltage Directive

S?nd dEN(IjC 2014/35/EV). Thisinstrument has been tested to and complies with standards EN 61010-1,
anaaras “Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory

C € Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of
Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic L aboratory
Equipment for Analysis and Other Purposes.”

EMC

Thisinstrument meets European reguirements for emission and immunity (EMC Directive
2014/30/EV). Thisinstrument has been tested to and complies with standard EN 61326
(Group 1, Class B), “Electrical Equipment for Measurement, Control and Laboratory Use —
EMC Requirements.”

Thisinstrument meets European RoHS Directive 2011/65/EU.

Australian EMC  Thisinstrument has been tested to and complies with standard AS/NZS CISPR 11, “Limits
Standards and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,

2 Scientific, and Medica (ISM) Radio-frequency Equipment.”
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This chapter covers:

B About the StepOne™ and StepOnePlus™ Systems. .. ...t 26
B Before YOUBEgIN . . ..o 29
B Select Protective Hardwareand Software .. .......... .. ... . ... 31
B SdectaninstalationLayout. ... ... 33
B Planthelnstallation .. .......... . i 35

Note: For more information about any of the topics discussed in this guide, access the
Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software
by pressing F1, or clicking @ in the toolbar, or selecting Help » StepOne Software
Help.
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About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

System Features
Applied Biosystems StepOne™ Real-Time e 48-well platform
PCR System (StepOne ™ system) e Three-color system
Applied Biosystems StepOnePlus™ Real- ¢ 96-well platform
Time PCR System (StepOnePlus™ system) e Four-color system

* VeriFlex™ sample blocks

The Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems use
fluorescent-based polymerase chain reaction (PCR) reagents to provide:

* Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysisthat occurs
post-PCR).

Notes
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About Data The StepOne™ and StepOnePlus™ systems collect raw fluorescence data at different
Collection pointsduring a PCR, depending on the type of run that the instruments perform:

Run Type Data Collection Point

Real-time runs | Standard curve The instrument collects data following each
extension step of the PCR.
Relative standard curve

Comparative C; (AACy)

Post-PCR Genotyping The instrument collects data:
(endpoint) runs

e Before the PCR (For presence/absence
experiments, data collection before the PCR is
optional, but recommended.)

e (Optional) During the PCR. The instrument can
collect data during the run (real-time);
collecting data during the run can be helpful
for troubleshooting.

e After the PCR

Presence/absence

Regardless of the run type, a data collection point or read on the StepOne™ or
StepOnePlus™ instrument consists of three phases:

1. Excitation — Theinstrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

2. Emission — Theinstrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over afixed time interval. The StepOne™ software stores the
raw fluorescent image for analysis.

After arun, the StepOne™ software uses calibration data (spatial, dye, and background)
to determine the location and intensity of the fluorescent signals in each read, the dye
associated with each fluorescent signal, and the significance of the signal.

Notes
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About the StepOne™ and StepOnePlus™ Systems

Filters and

StepOnePlus™ System Filters and Dyes

Supported Dyes The StepOnePlus™ instrument features a four-color filter set that supports the following

About the
VeriFlex™
Technology

Notes

28

dyes: FAM™ dye, JOE™ dye, NED® dye, ROX™ dye, TAMRA® dye, VIC® dye, and
SYBR® Green dye. The following figure shows the emission spectrum for each dye, and
thefilter at which each dyeisread.

Filters
Wavelength
(nm)

Emission
Spectra

Dyes ~520 nm ~550 nm ~580 nm ~610 nm
* FAM e JOE * NED ¢ ROX
* SYBR Green e VIC e TAMRA

StepOne™ System Filters and Dyes

The StepOne™ instrument features a three-color filter set that supports the following
dyes: FAM™ dye, JOE™ dye, ROX™ dye, VIC® dye, and SYBR® Green dye. The
following figure shows the emission spectrum for each dye, and the filter at which each
dyeisread.

Filters 1 2 3
Wavelength
(nm)
Emission
Spectra
Dyes ~520 nm ~550 nm ~610 nm
* FAM e JOE ¢ ROX

e SYBR Green ¢ VIC

The StepOnePlus instrument contains six independently thermally regulated VeriFlex™
blocks to help you optimize your thermal cycling conditions. You can set a different
temperature for one or more of the VeriFlex blocks, creating up to six different zones for
samples, or you can set the same temperature for each of the VeriFlex blocks.
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Before You Begin

Before you install the Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR
System, familiarize yourself with this guide, read the supporting site preparation
documentation, and obtain the materials required for the installation.

Review You can use this guide to:
This Guide . |ngall the system.

Chapters 2 through 5 of this guide contain all the information necessary for you to
perform a complete installation of the system. You can install the system within

4 hours; however, the installation may require more time if you plan to connect the
system to a network.

* Maintain the system.

Chapter 6 contains all the information necessary to perform routine maintenance of
the system.

Go to Chapter 6 to learn how to:
Archive and back up data
Cdlibrate the instrument
Decontaminate the instrument
Move the instrument

Replace the instrument fuses
Ship the instrument for service

Prepare for the + Read the Applied Biosystems SepOne™ and SepOnePlus™ Real-Time PCR Systems Site
Installation Preparation Guide and complete the preinstallation checklist contained in the guide.

» Obtain the materials for installation (see “ Obtain the Required Materials’ on page 30).

» Read “ Select Protective Hardware and Software” on page 31 and obtain any protective
hardware and software that you want to install to the system.

IMPORTANT! You can use this guide to reinstall the StepOne™ or StepOnePlus™ system
after transportation, but you must have the necessary installation reagents. See “ Check
the Shipped Materials’ on page 41 for alist of materials that are required for the
installation and to order more materials as needed.

Notes
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Before You Begin

Obtain the * Tools and equipment
Required Centrifuge with a reaction plate adapter of the appropriate size
Materials Powder-free gloves

Safety glasses

Scissors or box cutters

Screwdriver, flathead

» Computer (see below)

* (Optional) Protective hardware and software to install to the instrument and the
computer (see “ Select Protective Hardware and Software” on page 31).

Minimum If you did not order a computer with your system, supply one that meets the following
Computer requirements:
Requirements

Minimum Requirements#
C t

omponen For operating the StepOne or StepOnePlus For analyzing experiments in comparative C;
instrument studies

Computer ¢ Intel processor, 1.0 GHz ¢ Intel Core Duo T5500E processor, 1.66 GHz
e 512 MB of RAM ¢ 1 GB of RAM?*
* One 60-GB hard drive * One 60-GB hard drive
e 20/48X IDE CD-ROM e 20/48X IDE CD-ROM
e Ethernet network interface adapter (10BASE-T)S | e Ethernet network interface adapter (10BASE-T)$
e UL-listed e UL-listed
e CE-marked e CE-marked
¢ FCC-labeled ¢ FCC-labeled

Monitor e 1280 x 1024 pixel resolution for full-screen e 1280 x 1024 pixel resolution for full-screen
display display

e 32-bit color e 32-bit color
e UL-listed e UL-listed

Operating Microsoft Windows® XP Professional Operating Microsoft Windows® XP Professional Operating

System** System, Service Pack 2 or later System, Service Pack 2 or later

I Acomputer that meets the minimum requirement provides optimal software performance and is supported by Thermo Fisher
Scientific.
§ Necessary only if you plan to connect the computer to the instrument or to a local area network.

# The number of reaction plates (experiments) that can be analyzed in a comparative C; study depends on the processor speed
and the amount of RAM.

11We support the Windows® Vista Business Operating System, Service Pack 1, for performing data analysis (that is, analyzing
your experiments with the computer). We do not support the Vista operating system for instrument control purposes.

Notes
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Select Protective Hardware and Software

Before installing the system, obtain any of the following optional hardware and/or
software.

Electrical Werecommend severa protective devices to prevent loss of data and to protect the
Protective system from damage resulting from electrical hazards.
Devices
Power Line Regulator

We recommend the use of a 1.5-kVA power line regulator in areas where the supplied
power fluctuatesin excess of £10% of the normal voltage. Power fluctuations can
adversely affect the function of the system.

Note: A power line regulator monitors the input current and adjusts the power supplied to the
instrument or computer. It does not protect against a power surge or failure.

Uninterruptible Power Supply (UPS)

We recommend the use of a 1.5-kVA uninterruptible power supply (UPS), especialy in
areas prone to power failure. Power failures and other events that abruptly terminate the
function of the system can corrupt data and possibly damage the system.

IMPORTANT! UPSs have finite battery lives and they provide power for alimited time.
They are meant to delay the effects of a power outage, not to serve as replacement power
sources. In the event of a power loss, power off the system unless you expect to regain
power within the battery life of the UPS.

Surge Protector

We recommend the use of a 10-kVA surge protector (line conditioner) in areas with
frequent electrical stormsor near devicesthat are electrically noisy, such asrefrigerators,
air conditioners, or centrifuges. Short-duration, high-voltage power fluctuations can
abruptly terminate the function of, and thereby damage the components of, the computer
and the system.

Note: A dedicated line and ground between the instrument/computer and the building's
main electrical service can aso prevent problems caused by power fluctuations.

Data Backup/ We recommend the use of one or more backup storage devices to prevent potential 10ss
Storage Devices of datacaused by unforeseen failures of the instrument or the computer. If your system
includes a computer, then the CD/DVD drive of the computer can serve as the backup
storage device for your system. By saving your experiment files (EDSs) to one or more
writable CD or DVDs on aweekly basis, you can back up the data generated by your
system. Before installing the system, decide on a method for backing up your data
(“Archive and Back Up Data’ on page 142).

Notes
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Third-Party We recommend the use of several types of commercial software to ensure optimal
Software performance of the system and software, including:

» File compression software for archiving data generated by the system

» System optimization software for defragmenting the computer hard drive(s)

» Antivirus and firewall software for protecting the system if you plan to connect it to

anetwork

Before you install third-party software to the computer running the StepOne™ software,
confirm that the software will not:

» Restrict Ethernet communication

+ Interfere with StepOne™ software operation (see below)

To confirm that third-party software does not interfere with the StepOne™ software:

1. Install the software to the computer that contains the StepOne™ software.

2. Perform several test experiments using “dummy” plates (plates that do not contain
reagents).

Note: The goal of the test experimentsis to run plates under conditions that match
normal instrument operation. Therefore, the characteristics of the test experiments
(plate layout and run method) must closely resemble your actual experiments.

3. Confirm that the system performs each test experiment without producing errors.

If the system performs the tests successfully, perform experiments normally. If the
system encounters errors during the test runs, the software may not be compatible
with the StepOne™ software.

Notes
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Select an Installation Layout

Before you install your StepOne™ or StepOnePlus™ system, select the installation layout
that best suits your laboratory environment. The layout that you select affects the flow of
theinstallation, so note your choice for later reference. The StepOne™ and StepOnePlus™
instruments can be installed in the two layouts described below (standalone or
colocated).

Colocated Inthe colocated layout, the instrument is directly connected to the computer by the
Layout yellow StepOne system cable. In this configuration, you can set up, run, and analyze
experiments from the colocated computer. The following figure shows an instrument in a
colocated layout.

Computer Port

—_—

®
ellle

Note: You can control a colocated instrument from the instrument touchscreen, but only
when the StepOne™ software is not performing arun.

Note: Experiment data can be transferred between the standal one instrument and
computer over an Ethernet network (z%) connection. See “Networked Colocated and
Standalone Layouts’ on page 34 for more information.

The following steps summarize the experiment workflow when using a col ocated
system:

1. Create the experiment on the colocated computer using the StepOne™ software.

2. Start the run from the colocated computer.

During the run, use the colocated computer to:
» Monitor the status of arun in progress.
» View temperature and amplification data as they are collected.

3. Analyze the experiment on the colocated computer using the StepOne™ software.

Notes
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Standalone
Layout

Networked
Colocated and
Standalone
Layouts

Notes

34

In the standalone layout, the instrument is not connected to the computer. Instead, a USB
drive ( :f ) isused to transfer data between the instrument and the computer. In this
configuration, you set up and analyze experiments from the computer but run them from
the instrument touchscreen. The following figure shows an instrument in a standalone
layout.

el

Note: Experiment data can be transferred between the standalone instrument and
computer over an Ethernet network (=) connection. See “Networked Colocated and
Standalone Layouts’ below for more information.

The workflow for the standal one layout is more complicated than for the colocated
layout because the system components do not share adirect connection. The following
steps summarize the experiment workflow for a standalone system:

1. Create the experiment on the standalone computer using the StepOne™ software.
2. Transfer the experiment to the standalone instrument on a USB drive.

3. Start the experiment from the instrument touchscreen.
During the run, monitor the run from the instrument touchscreen.

4. Transfer the experiment to the standalone computer on a USB drive.

5. Analyze the experiment on the standal one computer using the StepOne™ software.

You can expand the functionality of a colocated or standalone instrument by connecting
it to an Ethernet network. When an instrument is part of a network, other computers on
the network that are running the StepOne™ software can:

* Monitor the status of the instrument
» Send and download experiments to and from the instrument

IMPORTANT! Computers on the network cannot control the instrument, only monitor it.

Note: Chapter 5, “Connect the System to a Network,” on page 101 contains a detailed
explanation of how to install the instrument to a network.
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Plan the Installation

You can install the system within a 4-hour period. The installation does not require your
constant attention; however, plan to spend most of your time working with the system.

Recommended Unpack and Set Up the
Workflow instrument (Chapter 2)
v

Colocated Installation Standalone Installation
(Chapter 3) (Chapter 4)
v v
Install the Computer
v Set Up the Computer
Connect the system A 4
w Perform the RNase P
Experiment
Perform the RNase P
Experiment
A 4
(Optional) Install the system to a
Network (Chapter 5)

Note: Consult your IT department
to network a colocated computer.
To enable the full functionality of the
StepOne™ software, the colocated
computer requires a network
connection.

Notes
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m Set Up the Instrument

This chapter covers:

B Aboutthelnstallation. . ..........c. i e 38
B Unpack the Instrument . .. ... ..o 39
B Check the Shipped Materials . . ... e 41
B SatUpthelnstrument. ... e e 44
B Completethelnstallation .. ....... ... . i e 47

Note: For more information about any of the topics discussed in this guide, access the
Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software
by pressing F1, or clicking @ in the toolbar, or selecting Help » StepOne Software
Help.

Notes
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About the Installation

M

This chapter explains how to install the Applied Biosystems StepOne™/StepOnePlus’
Real-Time PCR Instrument for both colocated and standal one layouts.

Installation Chapter 1,
Workflow Get Started
v

Unpack and Set Up the Instrument
1. Unpack and place the instrument.
2. Check the shipped materials.

3. Set up the instrument.
a. Prepare the instrument.
b. Set the instrument settings.

v v

Chapter 3, Chapter 4,
Install the Colocated Layout Install the Standalone Layout

Notes
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Chapter 2 Set Up the Instrument

Unpack the Instrument

Prepare the installation site and unpack the instrument.

Before
Unpacking

» Review and complete the preinstallation checklists in the Applied Biosystems
SepOne™ and SepOnePlus™ Real-Time PCR Systems Ste Preparation Guide. The

guide is shipped to you before the instrument arrives, and it contains important
environmental and electrical requirements for the system.

* Prepare the installation site as described in the Applied Biosystems SepOne™ and
SepOnePlus™ Real-Time PCR Systems Ste Preparation Guide.

Confirm the Site
Requirements

IMPORTANT! Avoid placing the system on surfaces that are subject to constant or
intermittent vibration. Tabletop centrifuges, vortex mixers, and other laboratory equipment

can vibrate the instrument during arun and produce data collection errors.

Confirm that the installation site meets the physical and environmental requirements for
the instrument listed in the table below. Refer to the Applied Biosystems SepOne™ and
SepOnePlus™ Real-Time PCR Systems Site Preparation Guide for acomplete summary.

Requirement

Instrument

Additional

Total

Length
(drawer closed)

48.5cm (19.1in)

e Front¥-18.8 cm (7.4 in)
e Rear$-15.2cm (6.0 in)

82.5cm (32.5in)

Width

24.6 cm (9.7 in)

15.2 cm (6.0 in)*

39.8 cm (15.7 in)

Height

Weight

51.8 cm (20.4 in)

30.5cm (12.0in)

81.7 cm (32.4 in)

e StepOne™ Instrument — 23.59 + 0.45 kg (52 + 1 Ibs)¥*
e StepOnePlus™ Instrument — 24.04 + 0.45 kg (53 1 Ibs)

Temperature

15 to 30°C (59 to 86°F) / Maximum change < 15°C every 24 hrs

Humidity

15 to 80% relative humidity, noncondensing

Power

100 to 240 VAC (50 to 60 Hz)

t Clearance required to provide adequate space for the instrument drawer to open.
§ Clearance required to ensure adequate airflow and cooling.
# Clearance at the left and right sides to ensure adequate airflow and cooling.

11 Or at least 38.32 kg (84.5 Ibs) if you plan to place a computer with the instrument. Actual weights
depend on the computer model you use.

—

N
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-
0

Notes
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Place the
Instrument

Notes
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AWARNING PHYSICAL INJURY HAZARD. Do not attempt to lift the

instrument or any other heavy objects unless you have received related training. Incorrect
lifting can cause painful and sometimes permanent back injury. Use proper lifting
techniques when lifting or moving the instrument. At least two people are required to lift
the instrument.

—

. Cut the tape securing the top flaps of the crate and open them.
Remove the system packing kit from the instrument and set it aside.

Remove the packing material from the crate.

0D

Remove the protective cover from the instrument.

5. Position yourselves on either side of the instrument and grasp it firmly at the
corners.

6. Lift and move the instrument to the installation location.

Guidelines for lifting and moving the instrument:
» Keep your spinein aneutral position.
Bend at the knees and lift with your legs.
Do not lift an object and twist your torso at the sametime.
» Coordinate your intentions with your assistant before lifting and carrying.

' (o7:\N)J[e]'] Do not carry the instrument by the instrument drawer. Carrying

the instrument by the drawer can damage the instrument optics.

Yes
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Check the Shipped Materials

After unpacking the instrument, confirm that you have received all of the components
shipped with the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR
Systems.

Instrument and v
Computer Component

StepOne™ and StepOnePlus™ instrument

(Optional) Dell® computer:
¢ Dell® tower computer with a Dell® flat screen monitor, or
¢ Dell® laptop computer with a PCMCIA Network Card

IMPORTANT! If you did not order a computer from us, provide one that meets the
requirements listed in “Minimum Computer Requirements” on page 30.

Packing Kit  StepOnePlus™ System Packing Kit

v Component PN
Business card holder 4333831
Cable, Ethernet (blue) 4376698
Cable, StepOne™ system (yellow) 4376700
Cables, universal voltage kit¥ 4377117
MicroAmp® 96-Well Support Base 4379590
MicroAmp® 96-Well Tray for VeriFlex Blocks 4379983
MicroAmp® Adhesive Film Applicator 4333183
MicroAmp® Cap Installing Tool (Handle) 4330015
MicroAmp® Fast 8-Tube Strip (0.1 mL) 4358293
MicroAmp® Fast Optical 96-Well Reaction Plate with Barcode (0.1-mL) 4346906
MicroAmp® Fast Reaction Tube with Cap (0.1-mL) 4358297
MicroAmp® Optical 8-Cap Strip 4323032
MicroAmp® Optical Adhesive Film 4360954
StepOnePlus™ System USB Drive 4333831
Warranty card, release notes —

¥ Contains Australian, British, European, North American, and Japanese power cords.

Notes
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StepOne™ System Packing Kit

v Component PN
Business card holder 4333831
Cable, Ethernet (blue) 4376698
Cable, StepOne™ system (yellow) 4376700
Cables, universal voltage kit¥ 4377117
MicroAmp® Fast Reaction Tube with Cap (0.1-mL) 4358297
MicroAmp® 48-Well Base Adapter 4375284
MicroAmp® 48-Well Optical Adhesive Film 4375928
MicroAmp® 96-Well Support Base 4379590
MicroAmp® Fast 48-Well Tray 4375282
MicroAmp® Fast 8-Tube Strip (0.1-mL) 4358293
MicroAmp® Fast Optical 48-Well Reaction Plate 4375816
MicroAmp® Optical 8-Cap Strip 4323032
StepOne™ System USB Drive 4333831
Warranty card, release notes —

1 Contains Australian, British, European, North American, and Japanese power cords.

Chemistry  StepOnePlus™ System Chemistry Installation Kit
Installation Kit

v Component PN

TagMan® RNase P Fast 96-Well Instrument Verification Plate 4351979

StepOne™ System Chemistry Installation Kit

v Component PN
TagMan® RNase P Fast 48-Well Instrument Verification Plate 4371439
Notes
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Software and v
Documentation Component PN
Kit

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Site | 4376768
Preparation Guide

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376783
Quick Reference Card

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376782
Installation, Networking, and Maintenance Guide (this document)

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376786
Getting Started Guide for Genotyping Experiments

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376787
Getting Started Guide for Presence/Absence Experiments

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376784
Getting Started Guide for Standard Curve Experiments

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376785
Getting Started Guide for Relative Standard Curve and Comparative Cy

Experiments

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4379740
Reagent Guide

Applied Biosystems StepOne™ Real-Time PCR System Software 4379099
Primer Express® Software v3.0 4363991

Miscellaneous items (mouse pad, registration card, and others) -

Notes
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Set Up the Instrument

After confirming that you have received all system components, perform an initial
system test of the instrument, then define the instrument settings.

Prepare the 1. Connect the power cord to the system.
Instrument

2. (Optional) Install electrical protective devices to the power cord.

We recommend that you install at least one of the electrical protective devices
(power line regulator, uninterruptible power supply, and/or surge protector) to
prevent loss of data and to protect the instrument from damage resulting from
electrical hazards.

Note: For more information on selecting electrical protective devices for the
instrument, see “ Select Protective Hardware and Software” on page 31.

3. Connect the power cord to the power receptacle.

4. Power on the instrument, then wait for it to perform a diagnostic of the system
components.

When you power on the instrument for the first time, it may require morethan 5 min
to boot. Proceed with the installation when the touchscreen displaysthe Main Menu,
indicating that the instrument has completed the boot.

Note: If you are updating the instrument firmware, the instrument may pause for up
to 20 min before completing the boot.

If the instrument displays an error, power off the instrument, wait 30 sec, then power
on the instrument. If the instrument displays the error again, contact Support as
explained in “How to Obtain Support” on page 14.

Notes
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5. Remove the packing material from the sample block(s):
a. Open the instrument drawer.
b. Remove the packing material from the sample block(s).

c. Closetheinstrument drawer.

When removing the packing material from the sample block(s), you must power on
the instrument to lower the instrument drawer. The drawer isin the “raised” position
during transportation and it will not open until the instrument is powered on.

Define the 1. Set the instrument name:

Settings a. Inthe Main Menu, touch Settings M enu, then touch Admin Menu, then

touch Set | nstrument Name.

b. Touch the I nstrument Name field, enter aname for the instrument, then touch
Done.

The instrument name identifies your computer on the network. If you want to
connect the instrument to a network, the name must be unique.

Note: The instrument does not restrict the length or content of the instrument
name. However, if you plan to connect the instrument to a network, limit the

instrument name to fifteen characters and do not include spaces or special
characters(suchas;:"<>* +=\|?,).

c. Touch Done to save the settings, then touch OK when prompted.

( a Instrument Name

1b

Instrument Name: |ca||nua

Allow Remole Auns: s ’ Yes Ho

touch the buttons to allow remote runs

Touch the field to enter the Instrument name, E
on this instrument, then touch Done. »

Notes
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Set Up the Instrument

2. Define the date and time settings:
a. Inthe Admin Menu, touch Set Date & Time.

b. Touch the Date field, then enter the current date (in year/month/day format),
then touch Done.

c. Touch the Timefield, then enter the time in hour:minute format, then
touch Done.

d. Touch AM/PM to display the correct time period.
e. Touch Done to save the settings, then touch OK when prompted.

@ Date & Time

Date: P00G-11-16 S 2b
Time: 02:39 PM Ii 2c/2d
1
Done l 29
Touch the fields to enter the date and time. then touch Done. a
3. Touch , then touch Yes in the Confirmation Screen to enter standby mode.
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Complete the Installation

After setting up theinstrument, install the remaining system components according to the
layout you selected (standalone or colocated), then perform the RNase P verification
experiment.

Perform the Asexplainedin“Select an Installation Layout” on page 33, the system supports two
Appropriate basicinstallation layouts: colocated and standal one. Perform the installation according to
Installation thelayout you selected.

If you want to install the... Go to...
instrument and the computer to the same location, connected by the Chapter 3, “Install
yellow StepOne system cable. the Colocated

Layout,” on page 49.

Computer Port

-

Chapter 4, “Install
the Standalone
Layout,” on page 75.

IMPORTANT! Do not install the instrument to an Ethernet network until you complete
theinstallation by performing an RNase P experiment that passes. See Chapter 5,
“Connect the System to a Network,” on page 101 to connect the instrument to a network
after the installation.

Notes
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n Install the Colocated Layout

This chapter covers:

m About the Colocated Installation .. ............ i 50
B SetUpthe COmMPULES. . . ..o e e e 52
Install the Computer . ... ... 53
Install the StepOne™ Software . ... e 56
B Check for StepOne™ SoftwareUpdates . ... n. 60
B Connect the System Components. . ... ...ttt 61
B Peformthe RNase PEXperiment. . ... 65
SetUpthe EXperiment . ...t e e e 67
Runthe EXperiment . ... ... et et e 68
Analyzethe EXPeriment . .. ... 70
B Afterthelnstallation. . ... 74

Note: For more information about any of the topics discussed in this guide, access the
Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software
by pressing F1, or clicking @ in the toolbar, or selecting Help » StepOne Software
Help.

Notes
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About the Colocated Installation

This chapter explains how to install the Applied Biosystems StepOne™ or StepOnePlus™
Real-Time PCR System for colocated operation.

When to Perform Inthislayout, the yellow StepOne system cable connects the instrument to the colocated
a Colocated computer. Install the system in the colocated layout when both the computer and the
Installation instrument will be placed together in the same location. See “ Colocated Layout” on
page 33 for a complete description of the layout.

Computer Port

_

ene

Note: If you do not want to connect the computer to the instrument, perform the
standalone installation as described in Chapter 4, “Install the Standalone Layout.”

Notes
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Colocated Chapter 2, Set Up the Instrument
Installation -
Workflow Set Up the Computer

1. Install the computer.
2. Install the StepOne™ software.

IMPORTANT! Perform step 2 only if you did not
order a computer from us.

v
Check for Software Updates

v

Connect the System
1. Connect the instrument to the computer.
2. Confirm the connection.

v

Perform the RNase P Experiment

1. Set up the experiment.

2. Run the experiment.
3. Analyze the experiment.

v
Chapter 5, Connect the System
to a Network

Notes
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Set Up the Computer

Notes

52

Materials
Required

After you install the StepOne™ or StepOnePlus™ instrument, set up the colocated
computer.

IMPORTANT! If you ordered acomputer from us, you need only to unpack the computer
as explained on page 53. Computers shipped by us are ready for use with the instrument
and already contain the StepOne™ software.

« CD, Applied Biosystems StepOne™ Real-Time PCR System Software
» Computer

IMPORTANT! If you did not order a computer from us, provide a computer that
satisfies the requirements listed on “Minimum Computer Requirements’ on

page 30.

o Screwdrivers, flathead and Phillips
» StepOne system cable, yellow (from the system packing kit)
* (Optional) Protective hardware to install to the computer

We recommend that you install one or more of the following electrical devicesto the
computer to prevent loss of data and to protect the computer from damage resulting
from electrical hazards:

» Power line regulator

» Uninterruptible power supply (UPS)
» Surge protector

» Backup storage device

For more information, see “ Select Protective Hardware and Software” on page 31.
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Install the Computer

After obtaining the required materials, install the computer.

Confirm the Site  Confirm that the installation site meets the physical and environmental requirements for
Requirements the computer. See the documentation for your computer for the site requirements.

Place the ACAUTION PHYSICAL INJURY HAZARD. Improper lifting can cause painful

Computer and sometimes permanent back injury. Use proper lifting techniques when lifting or moving
the computer. We recommend saf ety training for proper lifting techniques. Do not attempt to
lift or move the computer or the monitor without the assistance of others. Depending on the
weight of the computer and the monitor, this may require two or more people.

1. If you have not done so aready, unpack the monitor, computer, keyboard, and
mouse, and assembl e the computer components as described in the computer
installation guide.

Guidelinesfor lifting and moving the computer:
» Make sure that you have a secure grip on the computer when lifting.

» Make surethat the pathway from the beginning of thelift to the final locationis
clear of obstructions.

» Do not lift an object and twist your torso at the same time.

» Keep your spinein aneutral position while lifting with your legs.

» Coordinate lift and movement with all participants before lifting and carrying
the compulter.

 Instead of lifting the computer/monitor from the packing box, tilt the box on its
side, then slide the contents out of the box.

2. Make the following connections:

Connect Do Not Connect

Power Mouse Keyboard Monitor Ethernet

© ©0 600 0OV

Notes
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Set Up the Computer

3.

6.

If you ordered alaptop computer from us, install the PCMCIA Network Card as
described in the documentation accompanying the card.

After installing the PCMCIA Network Card, wait several minutes to alow the
computer to enable the device. The computer may require time to register the
network card with the operating system beforeit is available for use.

Note: If you are installing your system in a colocated setup, do not connect the
StepOne system cable to the Ethernet port of the PCMCIA card. If you have aready
installed the instrument connection through the card, unplug and connect the
StepOne system cable to the appropriate port.

If you ordered atower computer from us, set the voltage appropriately for your
region as described in the computer installation guide.

Get the yellow StepOne system cable from the system packing kit (see “ Check the
Shipped Materials” on page 41), then connect the:

* Yellow Ethernet port (Ld,) of the instrument, to the
« Ethernet port (z%) of the computer

IMPORTANT! Do not connect the StepOne system cable to the blue LAN Port (Zx);
this port is reserved for a network connection.

Computer Port

—

®

(Optional) Install electrical protective devices to the computer.

Note: For more information, see “ Select Protective Hardware and Software” on
page 31.
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Power On the 1. Power on the computer and monitor.

Computer _
2. Log onto the operating system:

* If you are using a computer that you provided, log on to the operating system as
amember of the Administrators user group.

 |f you are using acomputer from us, enter Administrator in the User field, then
click Login. Leave the Password field blank.

IMPORTANT! If you are installing a computer that you provided, you must log onto
the Windows® operating system using a user account that belongs to the
Administrators user group.

3. Inthe Getting Started with Windows® X P window, deselect Show this screen at
startup, then click Exit.

4. Determine the next step:

 If you areinstalling a computer that you provided, go to “Install the StepOne™
Software” on page 56.

* If you areinstalling a computer from us, go to “ Check for StepOne™ Software
Updates’ on page 60.

Notes
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Install the StepOne™ Software

After setting up the computer, define the display properties, computer name, and the date
and time settings, then install the StepOne™ software.

IMPORTANT! If you ordered acomputer from us, skip “Install the StepOne™ Software’
and go to “Check for StepOne™ Software Updates’ on page 60. Computers that are
supplied by us already contain the StepOne™ software, and are ready for use with the
instrument.

Prepare the 1. Change the screen saver and power options settings:
Operating

System a. Right-click the desktop, then select Properties.

b. Inthe Display Properties dialog box, select the Screen Saver tab.
c. Inthe Screen saver group box, select (None) in the dropdown menu.
d. Click Power.

e. Inthe Power Options Properties dialog box, select Home\Office Desk from the
Power schemes dropdown list.
f. Set the Plugged in power scheme settings:
* Monitor — Select After 20 mins from the Plugged in dropdown menu.
» Hard Disks— Select Never from the Plugged in dropdown menu.
» System standby — Select Never from the Plugged in dropdown menu.

g. Click OK to save the settings.

Display Properties @@ Power Options Properties @@
1 b T TrEmEs | oesamp Soreen Saver | Appearance | Settings Power Schemes | Alams | Power Meter | Advanced | Hibemate
2 Select the power scheme with the most appropriate settings for
\ ') thiz computer. Mote that changing the settings below will modify

the selected scheme.

Power schemes

Settings for Home/Office Desk power scheme

Scieen saver ‘when computer is; ﬂ% Plugged in E:t?gl‘:% oh

Turm off monitar: EAﬂer 20 ming v || After § ming N

1c —

[Mone] v |

Tumoff hard disks: [ Never v [Ateritmine | 1f

Monitor power

To adjust monitor power settings and save energy, System standby: MNewer || dfter 5 ming w
m click Power ek j |Aleromine @

1 d Power...

[ aK H Cancel H Apply ] [ [n]:8 ][ Cancel H Apply l

1g

Notes
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2. Change the screen resolution:
a. Inthe Display Properties dialog box, select the Settings tab.
b. Inthe Screen Area group box, use the slider to select 1280 by 1024 pixels.
c. Inthe Colors group box, select Highest (32 bit) in the dropdown menu.

d. Click OK twice, then click Yesto accept the new resolution.

Themes | Desktop | Screen Saver Appearancel Settings i 23

Drag the monitor icons to match the physical arangement of your monitars.

Display:
| 1. [Multiple Maritors] on Dell CB40 ~
Screen resolution‘ Colar quality 2b
Less ——{}— Moe || pighest (32 i) = 2c
1280 by 1024 pisels I/ .
[ |dentify H Troubleshoot ] [ Advanced ]
[ Ok ] [ Cancel ] [ Apply ]
)
‘ 2d

3. Define the date and time settings:
a. Right-click the time readout in the toolbar, then select Adjust Date/Time.
b. IntheDate & Time tab, define the date and time settings.
c. Select the Time Zone tab.

d. Select atime zone from the dropdown menu, then select Automatically adjust
clock for daylight saving changesif necessary.

e. Click OK.

Note: Computers on anetwork synchronize their date/time settings with the server.

Date and Time Properties @E| Date and Time Properties

3c
3d

Date &Time | Time Zans | Date & Time | Time Zone—

Date Tirne:

October $ . t 1

1 2 3 4 5 & 7 i N
3p —L & 9 10 11 12 13 14

15 16 17 18 19 20 21 : :

2z 23 24 5 27 2E
29 30 31

2:23:49PM |5

e | &d

Current time zone Pacific Daylight Time Automatically adjust clock for daylight saving changes

o J
‘ 3e
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4. Change the computer name:
a. Inthe desktop, right-click My Computer, then select Properties.
b. Inthe System Properties dialog box, select the Computer Name tab.
c. Click Change.

d. Inthe Computer Name field, enter the computer name.

I (o7:\0)J[e]'] Do not give the computer the same name as the instrument.

A shared name could lead to network conflictsif you install both devicesto an
Ethernet network.

e. If necessary, define the Domain or Workgroup settingsif you are going to
connect the computer to a network.

f. Click OK twice.
g. Inthe Network Identification dialog box, click OK.
Note: The computer name identifies the computer on the network and must be

different than that of the instrument. After you install the system, you can change
the computer name without disrupting the function of the StepOne™ software.

System Festore I _Automatic Updates Remate *ou can change the name and the membership of this
4b S | S —— Camputer Name Hediiai Advanced computer. Changes may affect access to network resources.
'-1 Windows uzes the fallowing infarmation to identify your computer o .
57 onthe network. (SRR
= |EXAMPLE . 4d
Camputer description: |Standard XP Image | ' %
R o ; Full computer name:
Far exam?l\e: Kitchen Computer' ar "Mamy's ESAMPLE
Computer”.
Full computer name:; EXAMPLE -
More,
Domair: EXAMPLE et -
Member of
To use the Network |dentification “Wizard to join & ) Domair:
domain and create a local user account, click Metwark fepctkl .
ID
(& Workgroup: | 4e
To rename this computer or join a domain, click Change. E .
EePLE
4c
-
[
e 4
CoJ
|
49 ‘

5. Inthe Systems Settings Change dialog box, click Yes to restart the computer.

6. Log onto the operating system as a member of the Administrators user group.

Notes
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Install the IMPORTANT! You must be logged into the Windows® operating system as an
Software administrator to install the StepOne™ software.

Note: If you encounter errors during the installation of the StepOne™ software, reinstall
the software as described in “Uninstall the StepOne™ Software” on page 160.

1. Insert the Applied Biosystems StepOne™ Real-Time PCR System Software CD into
the CD drive of the computer and wait for the installer to start.

If the installer does not start automatically, double-click (My Computer),
navigate to the CD drive, then double-click Setup.exe.

2. Inthe Welcome page of the InstallShield Wizard, click Next.
3. Inthe License Agreement page, click Yesto accept the agreement.

4. Inthe Choose Destination Location page, click Next to accept the default location.

Note: We recommend installing the StepOne™ software to the D drive; however,
you can install the software to another location.

5. Inthe Default Instrument Type page, select the type of instrument that you are
installing (StepOnePlus™ Instrument or StepOne™ I nstrument), then click Next.

6. Inthe Start Copying Files page, confirm that the installation location displayed in
the Current Settings field is correct, then click Next to begin installing the
StepOne™ software.

7. When the StepOne™ software completes the installation, click Finish.

Notes
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Check for StepOne™ Software Updates

Updates and/or patches may be available for the StepOne software. Applied Biosystems
recommends that you check for software updates before you proceed with the
installation.

Note: To periodically check for software updates after the StepOne or StepOnePlus
systemisinstalled (as part of routine maintenance), see “ Update the StepOne™ Software
or the Operating System” on page 154.

To check for software updates:

1. Goto: http://www.lifetechnologies.com/support and click the I nstrument
Software, Patches & Updateslink.

2. Inthe Instrument Software, Patches & Updates page, click thelink for the
appropriate software.

3. Under Software Download, view the available downloads.

4. |f there are updates and/or patches for StepOne software v2.1 or later, select the
appropriate option, then follow the prompts to begin the download.

You may be asked for your instrument serial number. The serial number is on the
back panel of your instrument, or can be obtained from the instrument touchscreen.

Notes
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Connect the System Components

After preparing the computer, connect the instrument to the computer, then confirm that
the StepOne™ software can access the instrument by retrieving the maintenance data.

Establish the 1. If necessary, power on the instrument.
Connection

o

!
gt
Wﬁ%ﬁmﬁmmmm,
5

2. Power on the computer and monitor.

3. LoginasAdministrator, or asamember of the Administrators user group.

IMPORTANT! If you install the system using a computer that you provide, you must
log onto the Windows® operating system using a user account that belongs to the
Administrators user group.

4. Inthe desktop, double-click & (StepOne software) or select
Sart » All Programs » Applied Biosystems » SepOne Software »
<software name>

where < software name> is the current version of the StepOne software.
While the StepOne™ software loads:
» The software establishes communication with the instrument.

» The Windows XP operating system automatically detects the connection and
displaysaLoca Area Connection aert in the taskbar.

jg Local Area Connection is now connected |+
Speed: 10.0 Mbps

Note: You can disable the network connection messages displayed when the
StepOne™ software and instrument communicate. See “(Optional) Disable the
Local Area Connection Messages’ on page 63 for more information.

Notes
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Notes

62

5.

In the Login dialog box, create a user name:

a. Inthe User Name field, enter a user name.

Note: You cannot use the following charactersin the User Name field: space,
forward dash (/), backdlash (\), greater than sign (>), lessthan sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (]), colon (:), or
semicolon (;).

b. Click OK.

We recommend that you log in with auser name. If you log in with auser name, you
can set preferencesin the software. The next time you log in to the software with the
same user name, the software uses the preferences you set as the defaults.

IMPORTANT! If you log in to the software as a Guest, you cannot set preferences.

If you are prompted to update the instrument firmware, click Upgrade Firmware Now.

When the StepOne™ software prompts you to perform the RNase P experiment,
click Open Instrument Maintenance M anager.

RNase P Run is Not Valid

'E Applied Biosystems recommends performing an RNase P run before you run any experiments on the instrument,
L] Open the instrument maintenance manager and perform an RMase P run OR select "Ignore & Continue Startup.”

| Open Instrument Maintenance Manager | | Ignore & Continue Skartup |

Wait while the StepOne™ software downloads the maintenance data from the
instrument. If successful, the StepOne™ software automatically opens the RNase P
Run wizard in the Instrument Maintenance Manager.

If the StepOne™ software displays the “Instrument Connection Failed” message:

a. Confirm that the computer and instrument are connected by the yellow
StepOne system cable as explained in step 5 on page 54.

b. Power off the instrument, then after 30 sec power on the instrument.
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c. When the instrument displays the main screen, click Retry.

If the problem persists, contact Support as explained in “How to Obtain
Support” on page 14.

Instrument Connection Failed

] Cannot connect ko the instrument.
LY

If your computer is connected directly to the instrument (colocated), check the instrument power and the instrument-computer connection, then click "Retry.”

If your computer is not connected to the inskrument, click "Continue without Connection.”
To start up the software next time without connecting, go to Tools ® Preferences, then change the selections on the Startup tab.

| Retry I | Continue without Connection |

(Optional) Disable During normal operation, the Windows® operating system displays Local Area
the Local Area  Connection messages when the StepOne™ software and instrument communicate. You
Connection can disable these messages by changing the network connection settings for the Ethernet
Messages network interface adapter as explained below.

Alert displayed when instrument communication...

begins ends
,jij Local Area Connection is now connected | jg Local Area Connection b
Speed: 10,0 Mbps A network cable is unplugged.

To disable the network connection alerts for the instrument connection:

1. Inthe desktop, select Start » Control Panel, then double-click
@ Network Connections.

2. Right-click Eﬂ, L ocal Area Connection, then select Properties.
3. Desdlect Show icon in notification area when connected.
4. Deselect Notify me when this connection haslimited or no connectivity.
5. Click OK.
Notes
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Notes

Connect the System Components

- Local Area Connection 4 Properties

General | Authentication Advancea |

Connect using
I BB TAPWin32 Adapter V8 ‘

Thiz connection uses the following items:

ECIiant for Microsoft Metwaorks

.Q File and Printer Sharing for Microsolt Nebworks
42105 Packel Scheduler

S Intemnet Pratocal [TCPAP)

[ Install ] [ Uninstal ] [ Properties
[rescription
Allows your computer to access resources on a Microsoft
network,

[[1 Show icon in natification area when connected
[ Motify me when this connection has limited or no connectivity

6. Close the Network Connections window.

64
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Perform the RNase P Experiment

After you establish system communication, confirm the function of the system by
running a TagMan® RNase P Fast Instrument Verification Plate.

Materials » TagMan® RNase P Fast Instrument Verification Plate
Required » Powder-free gloves

o Safety glasses

» Centrifuge with reaction plate adapter

When to Perform  We recommend performing an RNase P experiment:
trI]Ee RNase F; « After installing the system.
Xperimen » After moving the instrument to another location.

» Asneeded to confirm the function of the instrument, depending on your laboratory
and regulatory requirements.

Purpose of the The TagMan® RNase P Fast Instrument Verification Plate experiment verifiesthe
Experiment performance of the instrument. The RNase P plate is prel oaded with the reagents necessary
for the detection and quantitation of genomic copies of the human RNase P gene (asingle-
copy gene encoding the RNase moiety of the RNase P enzyme).

Each well contains:

+ 1X TagMan® Fast Universal PCR Master Mix, No AmpErase® UNG

* RNase P primers

+ FAM™ dye-labeled probe

» Known concentration of human genomic DNA template
Thefigure below illustrates the arrangement of the standard and unknown popul ations on
the RNase P plate. The RNase P plate contains five replicate groups of standards (1250,

2500, 5000, 10,000, and 20,000 copies), two unknown populations (5000 and 10,000
copies), and negative control wells (NC).

1.2, 3. 4.5,.6_.7.8_9_ 10,1112

A
N o 5K-copy Unknown
/ Population 1
C
5K-copy f’ é 5K-copy
Unknown g g E Unknown D NC STD 1250 STD 2500
Population 1 'u_> l;, Population 1
E STD 5000 STD 10000 STD 20000
F
10K-copy | B % | § 10K-copy g 10K-copy Unknown
- nknown =
P;J:l:(ll:t)i‘gEZ E E g ngula‘t)ion 2 Populatlon 2
H
N J
TagMan® 48-well RNase P Plate for TagMan® 96-well RNase P Plate for
the StepOne™ System the StepOnePlus™ System
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After the run, the StepOne™ software:

1. Generates a standard curve from the averaged threshold cycle (C;) values of the
replicate groups of standards.

2. Cdculates the concentration of the two unknown populations using the standard
curve.

3. Calculates the following to assess the instrument performance:

[(CopyUnk,) =3(6¢qpyunk2)] > [(CopyUnky) +3(0¢qpyunk)]

where:
» CopyUnk, = Average copy number of unknown #1 (5,000-copy population)
* Ocopyunki = Standard deviation of unknown #1 (5,000-copy population)
» CopyUnk, = Average copy number of unknown #2 (10,000-copy popul ation)
* Ocopyunke = Standard deviation of unknown #2 (10,000-copy popul ation)

Installation Specification

The instrument passes the installation specification if the inequality holds and the
instrument successfully distinguishes between 5,000 and 10,000 copies with greater than
99.7% confidence.

To meet the installation specification, you can omit alimited number of outlier wells
from the 5,000- and 10,000-copy unknown populations. The number of wells that you
can remove depends on the instrument that you are installing.

Maximum number of outlier wells that can be
removed from each...

Instrument Negative Total
Unknown Population Standard Controls
(STD) (NC)
StepOnePlus™ System 6 0 0 12
StepOne™ System 2 0 0 4
Notes
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Set Up the Experiment

Prepare the TagMan® RNase P Fast Instrument Verification Plate for the run.

Prepare the IMPORTANT! Do not use an RNase P plate for another Thermo Fisher Scientific
RNase P Plate instrument to verify the performance of the StepOne™ system. RNase P plates for other
instruments contain the TAMRA™ dye, which is not supported by the StepOne™ system.

‘e IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

1. Get the TagMan® RNase P Fast Instrument Verification Plate from the freezer, then
alow the reaction plate to warm to room temperature (for approximately 5 min).

2. Remove the RNase P plate from its packaging.

3. Vortex the reaction plate for 5 sec.

4. Centrifuge the reaction plate for 2 min at less than1500 rpm.

IMPORTANT! The reaction plate must be well mixed and centrifuged.

5. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at agreater rpm and for alonger time.

IMPORTANT! Do not alow the bottom of the RNase P plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
' ‘ Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. & Not centrifuged for enough time
Notes
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Run the Experiment

After preparing the TagMan® RNase P Fast Instrument Verification Plate, |oad the plate
into the instrument and start the run.

Load the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Instrument temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reach room temperature.

J IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.

A CAUTION

2. Placethe RNase P plate in the sample block(s) so that the A1 position is at the back-
left corner of the sample block(s).

StepOnePlus™ System StepOne™ System

[\ cAuTION HOT A\ cauTion HoT

Notes
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Start the Run 1. If the StepOne™ software automatically opened the RNase P Run dialog box, go to
step 2. Otherwise, display the wizard as follows:

a. Select Instrument » Instrument Maintenance M anager.

b. Inthe Instrument Maintenance Manager, select RNase P in the navigation
column.

c. Click Sart RNase P Run.

2. Inthe Setup screen of the RNase P Run wizard, select The RNase P plateisloaded
into theinstrument.

3. Click Next.

4. Inthe Run screen of the RNase P Run wizard, click Sart Run [§.

Note: Before starting the run, the instrument may take up to 15 min to heat the
heated cover to the correct temperature.

1a — L= Cd# nstrument Analysis Tools Help

New Experiment - 5 open. [ £ Close 3\_“ Send Experiment to Instrument LE. Download Experiment from Instrument.. 48 a2

Perform an RNase P run to verify the performance of your StepOne™ or StepOnePlus™ system.
To perform a new RNase P run, click "Start RNase P Run." To open an existing RNase P run, browse and select the file to open, then click "Cpen.”

RNase P Run
irmr— ; g R g
TR s p | StatRMasePRun | OR  Open Existing RNase P Run | rare v2 Olsxperimsntsiab-calib-massp-48 eds | | Browss | | open

% RNase P Run

RNase P

1c

RNase P Setup Setup Help @

ﬂ Instructions: Locate the required materials, prepare the RNase P plate, select a location for the RNase P run file, load the plate into the instrument, then click "Next”

1. Locate required materials:
« TagMan® RNase P Fast Instrument Verification Plate
« Powder-free gloves
- Safety goagles
« Centrifuge with plate adapter

2. Prepare the RNase P plate.

| View Instructions

3. Load the RNase P plate into the instrument:
a. Open the instrument drawer.
b. Place the RMase P plate in the sample block with the A1 position atthe back-left corner of the sample block.
©. Close the instrument drawer carefully.

4. Select a location for the RNase P run file:

RMase P RunFile : | 2.0\experimentsirmasep-run-steponeplus.eds || Browse ]

2 — | The RMase P plate is loaded into the instrument.
3
Notes
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Analyze the Experiment

Review the datato confirm the results of the experiment.

Confirm the Note: After the StepOne™ software completes the RNase P run, it automatically
Results of the analyzesthe run and displays the resultsin the Analysis screen.
Analysis
1. Inthe Analysis screen of the RNase P Run wizard, confirm the status of the run:
» Passed — The instrument passed the RNase P run. Go to step 5 on page 72.
» Failed — Theinstrument failed the RNase P run. Go to step 2 to screen the
experiment for outliers.

If the run fails, the automated analysis may have included outliers that caused the
initial analysisto fail. Experimental error may cause some wells to be amplified
insufficiently or not at all. These wells typically produce C; valuesthat differ
significantly from the average for the associated replicate wells. If included in the
calculations, these outlying data (outliers) can result in erroneous measurements.

2. Inthe Amplification Plot, select Ct vs. Well from the Plot Type dropdown menu.

3. Confirm the uniformity of each replicate population on the reaction plate (controls,
standards, and unknowns) by comparing the groupings of C; values:

a. Inthe plate layout, select the wells containing the 10,000-copy unknown
population:
+ StepOne™ System —Wells from columns 1, 2, 6, 7, and 8 inrows D, E, and F
StepOnePlus™ System —Wellsrows F, G, and H

1. 2. 3. 4.5.,6,.7_.8_9_10.11.12

5K-copy Unknown
Population 1

5K-copy
Unknown
Population 1

5K-copy
Unknown
Population 1

NC STD 1250 STD 2500
STD 5000 STD 10000 STD 20000

NC
STD 2.5K
STD 10K

10K-copy Unknown
Population 2

10K-copy
Unknown
Population 2|

10K-copy
Unknown
Population 2

STD 1.25K
STD 5K
STD 20K

T OO, m _mMm_ O _O_ W_ >

N J

TagMan® 48-well RNase P Plate for TagMan® 96-well RNase P Plate for
the StepOne™ System the StepOnePlus™ System

b. Inthe plot, confirm that the C.s of the replicate population are equivalent.
Note: The numbers on the X-axis of the plot correspond to the wells of the

reaction plate. Beginning with well A1, the wells are numbered from left-to-
right, and top-to-bottom.

Notes
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c. If anoutlier is present in the population, select the corresponding well in the
plate layout, then click Omit to remove the well from the analysis.

Maximum number of outlier wells that can be
removed from each...
Instrument Total
Unknown Standard Negative
Population (STD) Control (NC)
StepOnePlus™ System 6 0 0 12
StepOne™ System 2 0 0 4

IMPORTANT! If too many outliers are present, order another RNase P plate and
repeat the experiment.

d. Repeat steps 3athrough 3c for each replicate population (unknowns, standards,
and negative controls) on the reaction plate.

4. Click Reanalyze to analyze the run without the outliers.

If the status of the RNase P Run is“Failed” after performing steps 2 through 4, repeat
the RNase P experiment using a different RNase P plate. If the problem persists,
contact Support as explained in “How to Obtain Support” on page 14.

RNase P Analysis Analysis Help @
) istructions:  [2eVIEWhe resuits from the Rase P run. Ifth fun failed, omit outiers, then click"Reanalyze.” Repeat unti ths fun passes. Click Finish to save and apply
1 " the results.
Status: Passed |_Urrl” Reanalyze |
<| View Plate Layout ‘ ‘
i Amplification Plot| Standard Curve 7 ( 1
E;, WL = i Select Wells With: - Select flem- @ @
Plot Type: CTvs v\‘(gu ~| Graph Type: Plot Color: jwell v ‘ | 57 show n wells v | ] View Legend | |
2 ‘ By g B
o 2 i [~
AL aRE! ™2 3 4 5 6 7 & 8 10 1 12|
Amplification Plot @t. [r @ @ e @r @r @r @er e @dr @e
I AN<dE3 4.76.. 457. 476./4.8E3 501. 487. 5.06. 505. 476. 479. 4.81.
00 | |7 [ | SN | [ | [ | | e | | N | S
37.5- M- @M= [@- [@- [@: 0 @- @r | @d- @z @z 0=
3504 B | 471. 484 48E3 47E3 4.72. 4.69. 520. 4.77. 5.08. 488. 517, 5.17.
i 3251
Outlier 284 ® [~ M~ @+ @ @ @ M= M= @ 0= 0= 0
2751 C|472. 466. 483, 465. 457. 4.85. 4.73. 5.03. 4.83. 497. 506, 4.88.
22: : _GR'DR' Rl «BHr Br Br Br Br Br B Br
& - | D|crurCrurCcrUrcr Ui 125 125 125 1.25 |25E3 25E3 25E3 25E3
T B e e S E S e e e e e N N LI b b b bl B e B Bl B e e e e
1751 7ER,ER R R R R Elr R = He He Hr
1507 E|SE3 5E3 5E3 |5E3 |(1E4 |1E4 1E4 |1E4 |2E4 |2E4 2E4 2E4
T e e e e e o o st S St S N It il il il il i Il ol ol Bl Dl D
10.0 | e @me@e @ @ @ @ @r 4 @M @e @
751 Fl935. 852, 944 /9563 9.8E3 9.79. 9.37.. 0.56.. ma 9934 1.02.4 1.02 4
504 -
251 0 [0 G5 O I [ (e N I 0 [ 1 [ O S
i G |933. 945, 920, 987 9.63. 9.63.] 9.61./ 1.03. 1.05. 9.56./9.8E3/ 1.08
EEEEEEEEEEEEEEEEEEEENIR] 4 W W W W W e W W W W W
Wl Number (0 B30 B0 B B0 o B o GO 0 o B O B G
Legend Hlg72. 9.99. 9.20. 9.34. 9.43.. 1.03.] 8.73. 1.04. 1.04. 9.91., 1.02.. 9.78..
I o ¢
wells: [ 72 Unknown [E]] 20 Standard [] 4 Negative Contral 0 Empty
| Cancel ‘ Previous || H Finish ‘
Notes
. . ™ ™ H
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5¢c

Notes

72

Perform the RNase P Experiment

5. Review the standard curve:

a. Select the Sandard Curvetab.

b. Click the upper-right corner of the Plate Layout to select all wells.

c. Confirm that the R2 value is greater than or equal to 0.990.

If the R2 valueisless than 0.990, repeat the RNase P experiment using a different
RNase P plate. If the problem persists, contact Support as explained in “How to
Obtain Support” on page 14.

6. Click Finish, click Yeswhen prompted to save the experiment.

RNase P Analysis

Analysis Help @

Status: Passed

Plot

Target Rhase P

~ | PiotCalor Detautt

]

G Instructions: REview the results from the RNase P run. Ifthe run failed, omit outliers, then click"Reanalyze.” Repeat untilthe run passes. Click Finish to save and apply
" the results

< | View Plate Layout

Amplification Plot | Standard Curve

>

| Omit H Reanalyze

SelectWells With: - Selecttem- | |

30.00 1
20.75 1
20.50 1
28.25
20.00 1
28.75 1
28.50 1
28251
28.00 1

© o775
27.50 1
27.251
27.00 1
28.75 1
28.50 1
28.25 1
26.00 1
25.75 1

Standard Curve

am e

100

Quantity (Copies)

10000

‘ Target; RMase P Slope; -3.207 Y-nter; 40.077

RZ; 0.897 ) Efft: 101.047 ‘

| ShumeEII:V | VwewLegend | | |
|

'T1 2 3 4 &

@
-
@
©

0 11 12

LENvE v v EN o BN o B o B o B o B v B U B U
A |4.3E3 4.76./ 4.57.. 4.76.  4.8E3| 5.01.. 487 5.06. 5.05. 476, 4.79. 4.81..

Mr e e @ @r Er e - @e e Ee @e
B | 471. 464, 4.8E3 47E3| 472, 469, 5.29.. 4.77.. 508, 488517 517..

R h L R. R Y
Hlg72. 809,920 034/0943 103 873. 1.04. 104 99
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Unload the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Instrument temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reach room temperature.

% IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.

2. Remove the RNase P plate from the sample block(s).

3. Closetheinstrument drawer carefully.

A CAUTION

4. Dispose of the RNase P plate.

IMPORTANT! Do not power off the instrument following a run. The instrument
automatically enters a hibernation mode when not in use. Power off the instrument
only when it will not be used for an extended period.

Notes
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After the Installation

After the Installation

Install Additional
Software

Network the
System

Notes

74

After verifying the performance of the system by completing the RNase P experiment,
you can install additional software to the computer and/or connect the instrument to a
network.

We recommend installing the following types of software to improve the function and
security of the system computer:

* Antivirus software

» Archival or file compression software

» Security software (firewall and encryption utilities)
» Performance optimizing software

Note: For more information, see“ Select Protective Hardware and Software” on page 31.

To confirm that third-party software does not interfere with the StepOne™ software:

1. Install the software to the computer that contains the StepOne™ software.

2. Perform several test experiments using “dummy” plates (plates that do not contain
reagents).

Note: The goal of the test experimentsis to run plates under conditions that match
normal instrument operation. Therefore, the characteristics of the test experiments
(plate layout and run method) must closely resemble your actual experiments.

3. Confirm that the system performs each test experiment without producing errors.

If the system performs the tests successfully, perform experiments normally. If the
system encounters errors during the test runs, the software may not be compatible
with the StepOne™ software.

You can expand the functionality of the colocated instrument by connecting it to an
Ethernet network. When the colocated instrument is part of a network, computers on the
network that are running the StepOne™ software can:

» Monitor the status of arun in progress
» Send and download experiments to and from the instrument

IMPORTANT! Computerslinked to acolocated instrument over a network cannot control
the instrument.

To connect the instrument to a network, go to Chapter 5, “ Connect the System
to aNetwork,” on page 101.
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This chapter covers:

B About the Standalone Installation. . . ... 76
B SetUpthe COmMPULES. . . ..o e e e 78
Install the Computer . ... ... 79
Install the StepOne™ Software . ... e 81
B Check for StepOne™ SoftwareUpdates . ... n. 85
B Preparethe StepOne™ Software for StandaloneUse. . ..................... 86
B Peformthe RNase PEXperiment. . ... 88
SetUpthe EXperiment . ...t e e e 20
Runthe EXperiment . ... ... et et e 91
B AnadyzetheRNase PExperiment. . ... 93
Unload thelnstrument . ........... .. e 93
Transfer the EXperiment . .. ... e e e 94
Analyzethe EXperiment . . ... e 96
B Afterthelnstalation. .. ... 99

Note: For more information about any of the topics discussed in this guide, access the
Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software
by pressing F1, or clicking @ in the toolbar, or selecting Help » SepOne Software
Help.

Notes
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About the Standalone Installation

This chapter explains how to install the system for standalone operation.

When to Perform Inthislayout, the instrument is not connected to the computer running the StepOne™
a Standalone software. Instead, aUSB drive ({') is used to transfer data between the system
Installation components. Install the system in the standal one layout when the computer and the
instrument must be placed in separate locations. See“ Standalone Layout” on page 34 for
compl ete descriptions of the layouts.

@ .
Henlo (=

Note: If you want to connect the computer to the instrument, perform the colocated
installation as described in Chapter 3, “Install the Colocated Layout.”

Notes
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Standalone Chapter 2, Set Up the Instrument
Installation A 4
Workflow

Set Up the Computer
1. Install the computer.
2. Install the StepOne™ software.

Note: Perform step 2 only if you did not order a
computer from us.

v
Check for Software Updates

v
Prepare the Software for Standalone Use

v

Perform the RNase P Experiment

1. Set up the experiment.
2. Run the experiment.

v

Analyze the RNase P Experiment

1. Transfer the experiment data.

2. Analyze the experiment.

v
Chapter 5, Connect the System
to a Network

Notes
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Set Up the Computer

Set Up the Computer

Notes

78

Materials
Required

After you install the StepOne™ or StepOnePlus™ instrument, set up the standalone
computer.

IMPORTANT! If you ordered acomputer from us, you need only to unpack the computer
as explained on page 79. Computers shipped by us are ready for use with the instrument
and already contain the StepOne™ software.

« CD, Applied Biosystems StepOne™ Real-Time PCR System Software
» Computer

IMPORTANT! If you did not order a computer from us, provide a computer that
satisfies the requirements listed in * Minimum Computer Requirements’ on page 30.

o Screwdrivers, flathead and Phillips
* (Optional) Protective hardware to install to the computer
We recommend that you install one or more of the following electrical devicesto the

computer to prevent loss of data and to protect the computer from damage resulting
from electrical hazards:

» Power line regulator

» Uninterruptible power supply (UPS)
* Surge protector

» Backup storage device

For more information, see “ Select Protective Hardware and Software” on page 31.
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Install the Computer

After obtaining the required materials, install the computer.

Confirm the Site  Confirm that the installation site meets the physical and environmental requirements for
Requirements the computer. See the documentation for your computer for the site requirements.

Place the ACAUTION PHYSICAL INJURY HAZARD. Improper lifting can cause painful

Computer and sometimes permanent back injury. Use proper lifting technique when lifting or
moving the computer. We recommend safety training for proper lifting techniques. Do
not attempt to lift or move the computer or the monitor without the assistance of others.
Depending on the weight of the computer, this may require two or more people.

1. If you have not done so aready, unpack the monitor, computer, keyboard, and
mouse, and assembl e the computer components as described in the computer
installation guide.

Guidelines for lifting and moving the computer:
» Make sure that you have a secure grip on the computer when lifting.

» Make sure that the pathway from the beginning of thelift to thefinal locationis
clear of obstructions.

» Do not lift an object and twist your torso at the same time.

» Keep your spinein aneutral position while lifting with your legs.

» Coordinate lift and movement with all participants before lifting and carrying
the computer.

* Instead of lifting the computer/monitor from the packing box, tilt the box onits
side, then dslide the contents out of the box.

2. Make the following connections:

Connect Do Not Connect

Power Mouse Keyboard Monitor Ethernet

O ©® 60 O-®

3. If you ordered alaptop computer from us, install the PCMCIA Network Card as
described in the documentation accompanying the card.

After installing the PCM CIA Network Card, wait several minutes to allow the
computer to enable the device. The computer may require timeto initialize the drivers
and register the network card with the operating system before it is available for use.

Notes
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4.

Power On the 1.

Computer

Chapter 4 Install the Standalone Layout

If you ordered atower computer from us, set the voltage appropriately for your
region as described in the computer installation guide.

Eﬁi
=

(Optional) Install electrical protective devices to the computer.

Note: For more information, see “ Select Protective Hardware and Software” on
page 31.

Power on the computer and monitor.

2. Log onto the operating system:

Notes

80

 |f you are using a computer that you provided, log on to the operating system as
amember of the Administrators user group.

* If you are using acomputer from us, enter Administrator inthe User field, then
click Login. Leave the Password field blank.

IMPORTANT! If you areinstalling a computer that you provided, log onto the
Windows® operating system using a user account that belongs to the Administrators
user group.

In the Getting Started with Windows® X P window, deselect Show this screen at
startup, then click Exit.

Determine the next step:

 If you areinstalling a computer that you provided, go to “Install the StepOne™
Software” on page 81.

* If you areinstalling acomputer from us, go to “Check for StepOne™ Software
Updates’ on page 85.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
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Install the StepOne™ Software

After setting up the computer, define the display properties, computer name, and the date
and time settings, then install the StepOne™ software.

IMPORTANT! If you ordered a computer from us, skip “Install the StepOne™ Software”
and go to “Check for StepOne™ Software Updates’ on page 85. Computers that are
supplied by us already contain the StepOne™ software, and are ready for use with the
instrument.

Prepare the 1. Change the screen saver and power options settings:
Operating

System a. Right-click the desktop, then select Properties.

b. Inthe Display Properties dialog box, select the Screen Saver tab.
c. Inthe Screen saver group box, select (None) in the dropdown menu.
d. Click Power.

e. Inthe Power Options Properties dialog box, select Home\Office Desk from the
Power schemes dropdown list.
f. Definethe Plugged in power scheme settings:
* Monitor — Select After 20 mins from the Plugged in dropdown menu.
» Hard Disks— Select Never from the Plugged in dropdown menu.
» System standby — Select Never from the Plugged in dropdown menu.

g. Click OK to save the settings.

Display Properties @@ Power Options Properties @@

1b T TrEmEs | oesamp Soreen Saver | Appearance | Settings Power Schemes | Alams | Power Meter | Advanced | Hibemate

e Select the power scheme with the most appropriate settings for
:.\ thiz computer. Mote that changing the settings below will modify
the selected scheme.

Power schemes

Settings for Home/Office Desk power scheme

Scieen saver When computer is: %i Plugged in E:t?;::% an

Turm off monitar: fAﬂer Mmins v | | Aler 5 mins N

1c —

[Mone] v

Tum off hard disks: | Never | [aertomine v 1f

Monitor power

To adjust monitor power settings and save energy, System standby: MNewer w || Aiter 5 mins v‘:
& click Power @ |Aleromine @S

1 d Power...

[ aK H Cancel H Apply ] [ [n]:8 ][ Cancel H Apply l

1g

Notes
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2. Change the screen resolution:
a. Inthe Display Properties dialog box, select the Settings tab.
b. Inthe Screen Area group box, use the slider to select 1280 by 1024 pixels.
c. Inthe Colors group box, select Highest (32 bit) in the dropdown menu.

d. Click OK twice, then click Yesto accept the new resolution.

Themes | Desktop | Screen Saver Appearancel Setlings 'i | 2a

Drag the monitor icons to match the physical arangement of your monitars.

Display:
| 1. [Multiple Maritors] on Dell CB40 ~
Screen resolution‘ Colar quality 2b
Less ——{}— Moe || pighest (32 i) = 2c
1280 by 1024 pisels I/ .
[ |dentify H Troubleshoot ] [ Advanced ]
[ Ok ] [ Cancel ] [ Apply ]
)
‘ 2d

3. Define the date and time settings:
a. Right-click the time readout in the toolbar, then select Adjust Date/Time.
b. IntheDate & Time tab, define the date and time settings.
c. Select the Time Zone tab.

d. Select atime zone from the dropdown menu, then select Automatically adjust
clock for daylight saving changesif necessary.

e. Click OK.

Note: Computers on anetwork synchronize their date/time settings with the server.

Date and Time Properties @E| Date and Time Properties
Date & Time | Time Zone Diate & Time | Time Zone — 3c
Date Time e

3d

October $ . t 1

1 2 3 4 5 & 7 i A
3p —L & 9 10 11 12 13 14

15 16 17 18 19 20 21 : :

2z 23 24 5 27 2E
29 30 31

2:23:49PM |5

e | &d

Current time zone Pacific Daylight Time Automatically adjust clock for daylight saving changes

o J
‘ 3e
Notes
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4. Change the computer name:
a. Inthe desktop, right-click My Computer, then select Properties.
b. Inthe System Properties dialog box, select the Computer Name tab.
c. Click Change.

d. Inthe Computer Name field, enter the computer name.

I (o7:\0)J[e]'] Do not give the computer the same name as the instrument.

A shared name could lead to network conflictsif you install both devicesto an
Ethernet network.

e. If necessary, define the Domain or Workgroup settingsif you are going to
connect the computer to a network.

f. Click OK twice.
g. Inthe Network Identification dialog box, click OK.
Note: The computer name identifies the computer on the network and must be

different than that of the instrument. After you install the system, you can change
the computer name without disrupting the function of the StepOne™ software.

System Festore I _Automatic Updates Remate *ou can change the name and the membership of this
4b _ o Computer Name Eiardiiaia) eivanadd computer. Changes may affect access ko network resources.
'-1 Windows uzes the fallowing infarmation to identify your computer o .
- on the netrork, : Bl Ro :
o EXAMPLE 1 4d
Camputer description: |Standard XP Image ' %
= T o Full computer name:
Far exam?l\e: Kitchen Computer' ar "Mamy's ESAMPLE
Computer”.
Full computer name: EXAMPLE
>
Domair: EXAMPLE et
Member of
To use the Network |dentification “Wizard to join & ) Domair:
domain and create a local user account, click Metwark fepctkl :
ID .
(& Workgroup: T 4e
To rename this computer or join a domain, click Change. sl
:U‘a"‘:ge EXAMPLE
4c
-
[
e 4
)
|
49 ‘

5. Inthe Systems Settings Change dialog box, click Yesto restart the computer.

6. Log onto the operating system as a member of the Administrators user group.

Notes
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Install the IMPORTANT! You must be logged into the Windows® operating system as an
Software administrator to install the StepOne™ software.

Note: If you encounter errors during the installation of the StepOne™ software, uninstall
the software as explained in “Uninstall the StepOne™ Software” on page 160.

1. Insert the Applied Biosystems StepOne™ Real-Time PCR System Software CD into
the CD drive of the computer and wait for the installer to start.

If the installer does not automatically start, double-click (My Computer),
navigate to the CD drive, then double-click Setup.exe.

2. Inthe Welcome page of the InstallShield Wizard, click Next.
3. IntheLicense Agreement page, click Yesto accept the agreement.

4. Inthe Choose Destination Location page, click Next to accept the default location.

Note: We recommend installing the StepOne™ software to the D drive; however,
you can install the software to another location.

5. Inthe Default Instrument Type page, select the type of instrument that you are
installing (StepOnePlus™ Instrument or StepOne™ I nstrument), then click Next.

6. Inthe Start Copying Files page, confirm that the installation location displayed in
the Current Settings field is correct, then click Next to begin installing the
StepOne™ software.

7. When the StepOne™ software completes the installation, click Finish.

Notes
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Check for StepOne™ Software Updates

Updates and/or patches may be available for the StepOne software. We recommend that
you check for software updates before you proceed with the installation.

Note: To periodically check for software updates after the StepOne or StepOnePlus
systemisinstalled (as part of routine maintenance), see “ Update the StepOne™ Software
or the Operating System” on page 154.

To check for software updates:

1. Goto: http://iwww.lifetechnologies.com/support and click the I nstrument
Software, Patches & Updateslink.

2. Inthe Instrument Software, Patches & Updates page, click the link for the
appropriate software.

3. Under Software Download, view the available downloads.

4. |f there are updates and/or patches for StepOne software v2.1 or later, select the
appropriate option, then follow the prompts to begin the download.

You may be asked for your instrument serial number. The serial humber is on the
back panel of your instrument, or can be obtained from the instrument touchscreen.

Notes
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Prepare the StepOne™ Software for Standalone Use

Start the
Software

Notes
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After installing the StepOne™ software, set the software preferences so that the software
does not attempt to connect to the instrument at startup or confirm the status of the RNase
P experiment.

1. Inthe desktop, double-click ’{ (StepOne software) or select

Sart » All Programs » Applied Biosystems » SepOne Software »
<software name>

where <software name> is the current version of the StepOne software.

. Inthe Login dialog box, create a user name.

a. Inthe User Name field, enter a user name.

Note: You cannot use the following charactersin the User Name field: space,
forward dash (/), backdlash (\), greater than sign (>), lessthan sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (]), colon (:), or
semicolon (;).

b. Click OK.

We recommend that you log in with auser name. If you log in with auser name, you
can set preferencesin the software. The next time you log in to the software with the
same user name, the software uses the preferences you set as the defaults.

IMPORTANT! If you log in to the software as a Guest, you cannot set preferences.
You will not be able to perform the stepsin “ Set the Preferences’ on page 87.
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3. When the Instrument Connection Failed dialog box appears, click Continue
without connection.

Instrument Connection Failed

1 Cannot connect to the instrument.
LAY

If your computer is connected directly to the instrument (colocated), check the instrument power and the instrument-computer connection, then click "Retry."

I your computer is not connected to the instrument, dlick "Continue without Connection.”
To stark up the software next time without connecting, go to Tools » Preferences, then change the selections on the Starkup tab,

| Retry | | Continue without Connection |

Set the 1. Inthe Main Screen, select Tools » Preferences.
Preferences _
2. Inthe Preferences dialog box, select the Sartup tab.
3. Desdlect Connect to default instrument.
4

. Click OK.

% StepOne™ Software

1 i

meiyss— 100ls  Help

MNew Experiment - 25 open. [ =) [, send Experiment to Instrument JJ Download Experiment from Instrument... 48 I 9

Analyze

Design Wizard QuickStart Analyze Experiment

n Selectthe tasks to parform at software startup.
If your computer is not connected to the instrument, desslect"Connect to default
instrument.”

-] Connect to default instrument

‘ 0K || Csnce\_

( ) Disconnected

Notes
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Perform the RNase P Experiment

Materials
Required

When to Perform
the RNase P
Experiment

Purpose of the
Experiment

Notes
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After you install the instrument, confirm the function of the system by running a
TagMan® RNase P Fast Instrument Verification Plate.

« TagMan® RNase P Fast Instrument Verification Plate
» Powder-free gloves

o Safety glasses

» Centrifuge with plate adapter

We recommend performing an RNase P experiment:
» After installing the system.
» After moving the instrument to another location.

» Asneeded to confirm the function of the instrument, depending on your laboratory
and regulatory requirements.

The TagMan® RNase P Fast Instrument Verification Plate experiment verifies the
performance of the instrument. The RNase P plate is preloaded with the reagents necessary
for the detection and quantitation of genomic copies of the human RNase P gene (asingle-
copy gene encoding the RNase moiety of the RNase P enzyme).

Each well contains:

+ 1X TagMan® Fast Universal PCR Master Mix, No AmpErase® UNG

* RNaseP primers

+ FAM™ dye-labeled probe

» Known concentration of human genomic DNA template
Thefigure below illustrates the arrangement of the standard and unknown popul ations on
the RNase P plate. The RNase P plate contains five replicate groups of standards (1250,

2500, 5000, 10,000, and 20,000 copies), two unknown populations (5000 and 10,000
copies), and negative control wells.

1.2, 3. 4.5,.6_.7.8_9_ 10,1112

A
N o 5K-copy Unknown
/ Population 1
C
5K-copy f’ é 5K-copy
Unknown g g E Unknown D NC STD 1250 STD 2500
Population 1 'u_> '<7> Population 1
£l STD 5000 STD 10000 STD 20000
F
10K-copy | B % | 8 10K-copy g 10K-copy Unknown
- Unknown a
P::u:(ll:t)iggz E E g Popula‘t:.ion 2 POPUIahon 2
H
\ J
TagMan® 48-well RNase P Plate for TagMan® 96-well RNase P Plate for
the StepOne™ System the StepOnePlus™ System
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After the run, the StepOne™ software:

1. Generates a standard curve from the averaged threshold cycle (C;) values of the
replicate groups of standards.

2. Cadlculates the concentration of the two unknown populations using the standard
curve.

3. Calculates the following to assess the instrument performance:

[(CopyUnk,) =3(6¢qpyunk2)] > [(CopyUnky) +3(0¢qpyunk)]

where:
» CopyUnk; = Average copy number of unknown #1 (5,000-copy population)
* Ocopyunki = Standard deviation of unknown #1 (5,000-copy population)
» CopyUnk, = Average copy number of unknown #2 (10,000-copy population)
* Ocopyunke = Standard deviation of unknown #2 (10,000-copy popul ation)

Installation Specification

Theinstrument passes the RNase P experiment if the inequality holds and the instrument
successfully distinguishes between 5,000 and 10,000 copies with greater than 99.7%
confidence.

To meet the installation specification, you can omit alimited number of outlier wells
from the 5,000- and 10,000-copy unknown populations. The number of wells that you
can remove depends on the instrument that you are installing.

Maximum number of outlier wells that can be
removed from each...

Instrument . Total
Negative
Unknown Population Standard Controls
(NC)
StepOnePlus™ System 6 0 0 12
StepOne™ System 2 0 0 4
Notes
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Set Up the Experiment

Prepare the
RNase P Plate

Notes
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Prepare the TagMan® RNase P Fast Instrument Verification Plate for the run.

IMPORTANT! Do not use an RNase P plate for another Thermo Fisher Scientific
instrument to verify the performance of the StepOne™ system. RNase P plates for other
instruments contain the TAMRA™ dye, which is not supported by the StepOne™ system.

IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

1.

Get the TagMan® RNase P Fast Instrument Verification Plate from the freezer, then
alow the reaction plate to warm to room temperature (for approximately 5 min).

2. Remove the RNase P plate from its packaging.

Vortex the RNase P plate for 5 sec.

Centrifuge the RNase P plate for 2 min at less than1500 rpm.

IMPORTANT! The RNase P plate must be well mixed and centrifuged.

Confirm that the liquid is at the bottom of each well of the RNase P plate. If not,
centrifuge the plate again at a greater rpm and for alonger time.

IMPORTANT! Do not alow the bottom of the RNase P plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the RNase P plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
' ‘ Liquid is at the ¢ Not centrifuged with enough force, or
; r bottom of the well. o Not centrifuged for enough time
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Run the Experiment

After preparing the TagMan® RNase P Fast Instrument Verification Plate, |oad the plate
into the instrument and start the run.

Load the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Instrument temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reaches room temperature.

J IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.

A CAUTION

2. Placethe RNase P plate in the sample block(s) so that the A1 positionis at the back-
left corner of the sample block(s).

StepOnePlus™ System StepOne™ System

[\ cAuTION HOT A\ cauTion HoT

Notes
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Start the Run 1. Touch the instrument touchscreen to awaken it, then touch
2. Inthe Main Menu, touch Tools M enu, then touch RNase P Wizard.

3. Inthe Welcome screen, touch Continue, then touch == four times to bypass the
instructions screens.

To begin, you must first run an
RNaseP verification plate on your
new instrument

4. Inthe Start Run screen, touch Start to begin the run.

Note: Before starting the run, the instrument may take up to 15 min to heat the
heated cover to the correct temperature.

RNase P verification is in progress...
You may press Abort to stop.

Time remaining: 00:38:36

Notes
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Analyze the RNase P Experiment

After setting up the computer and the instrument completes the run, analyze the RNase P
experiment.

Materials » Powder-free gloves
ReqUired . Safety g|a$es
e USB Drive (from the system packing kit)

Unload the Instrument

Unload the RNase P plate from the instrument.

Remove the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

RNase P Plate temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reaches room temperature.

‘g IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.

2. Removethe RNase P plate from the sample block(s).

3. Closetheinstrument drawer carefully.

A CAUTION

4. Dispose of the RNase P plate.

IMPORTANT! Do not power off the instrument following a run. The instrument
automatically enters a hibernation mode when not in use. Power off the instrument
only when it will not be used for an extended period.

Notes
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Transfer the Experiment

After unloading the instrument, transfer the experiment data to the computer for analysis.

Transfer the Data 1. Connect aUSB driveto the USB port.
to the USB Drive

2. Inthe RNase P Wizard, touch

If the instrument cannot find the USB drive, touch OK , wait for 30 sec, then touch
Collect Results again.

Transfer the BRNase P file to
your USB stick or pull the file
from the instrument using the
PC-based software.

Analyze the data to see if the
instrument passed.

3. When prompted that the data has been transferred successfully, touch OK, then
touch wep.

Transfer the BRNase P file to
your USB stick or pull the file

4. Remove the USB drive from the instrument.

Notes
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—h
.

Transfer the Data
to the Computer

Connect the USB drive to one of the USB ports on the computer.

In the StepOne™ software, select Instrument » I nstrument Maintenance
Manager.

3. IntheInstrument Maintenance Manager, click RNase P.

4. Select the RNase P Run:
a. Inthe RNase P Run screen, click Browse.
b. Inthe Open dialog box, navigate to the USB drive.
c. Inthefile namefield, select the experiment.

d. Click Open.

The StepOne™ software automatically analyzes the run and displays the resultsin
the RNase P Run screen.

© StepOne™ Software

File Edit Instrument Analysis Tools Help

[E] New Experiment - 5 Open.. [ B Close Q\_“ Send Experiment to Instrument... L_'{/. Download Experiment from Instrument... 40 & PrintReport

Perform an RNase P run to verify the performance of your StepOne™ or StepOnePlus™ system

ase b To perform a new RMNase P run, click "Stat RNase P Run." To open an existing RNase P run, hrowse and selectthe file to open, then click"Open."

RNase P Run

| StartRuasePRun | OR  Open Existing RMase P Run | rare v2.0lexperimentsiab-calib-masep-48.2ds | | Browse | | open
|

RNase P Run Data

£ Open @

— Lookin: |3 examples v BEEE

] AQ RNase P Install_96_wells
1] asc_vis2_080411

My Recent #] at_Faq

Documents | |+ gt_tsre3_090106

[#]mets

|#] plusminus_vTs9

|#] RnaseP_DDCt

O

@,.

S
@
i )
=
8
-

@

|#] rsc-from-rnasep
|+ rsc_w_dissoc_peaks
2] stdeurve_w_diss_reuslts

3 —m Status:
Last Run:

=

=

o,
=1

a S
i
SL/
a

=

@

=

=
E’,@
ER-x
-] !
5

L]

Filename: | RNasesPRun.eds | w
My Network

Places Files of type: |ExperimentDocumantSinglemas(*.ads) v| | cijncel J

(ad)

& Home | Instrument Maintenance x

Lacal Instrument : connected

Notes
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Analyze the Experiment

Review the datato confirm the results of the experiment.

Confirm the 1. Inthe Analysis screen of the RNase P Run wizard, confirm the status of the run:

Results of the « Passed — The instrument passed the RNase P run. Go to step 5 on page 98.

Analysis » Failed — Theinstrument failed the RNase P run. Go to step 2 to screen the
experiment for outliers.

If the run fails, the automated analysis may have included outliers that caused the
initial analysisto fail. Experimental error may cause some wellsto be amplified
insufficiently or not at all. These wells typically produce C; valuesthat differ
significantly from the average for the associated replicate wells. If included in the
calculations, these outlying data (outliers) can result in erroneous measurements.

2. Inthe Amplification Plot, select Ct vs. Well from the Plot Type dropdown menu.

3. Confirm the uniformity of each replicate population on the RNase P plate (controls,
standards, and unknowns) by comparing the groupings of C; values:

a. Inthe plate layout, select the wells containing the 10,000-copy unknown
population:
+ StepOne™ System —Wellsfrom columns 1, 2, 6, 7, and 8 inrows D, E, and F
StepOnePlus™ System —WellsrowsF, G and H

1.2, 3. 4.5.,6,.7.8_9_ 101112

5K-copy Unknown
Population 1

/ )

5K-copy
Unknown
Population 1

5K-copy
Unknown
Population 1

NC STD 1250 STD 2500
STD 5000 STD 10000 STD 20000

NC
STD 2.5K
STD 10K

10K-copy Unknown
Population 2

10K-copy
Unknown
Population 2|

10K-copy
Unknown
Population 2

STD 1.25K
STD 5K
STD 20K

T O, T _m_O_O_ T_ >

G J

TagMan® 48-well RNase P Plate for TagMan® 96-well RNase P Plate for
the StepOne™ System the StepOnePlus™ System

b. Inthe plot, confirm that the Cs of the replicate population are equivalent.
Note: The numbers on the X-axis of the plot correspond to the wells of the

reaction plate. Beginning with well A1, the wells are numbered from left-to-
right, and top-to-bottom.

Notes
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c. If anoutlier is present in the population, select the corresponding well in the
plate layout, then click Omit to remove the well from the analysis.

Maximum number of outlier wells that can be
removed from each...
Instrument Total
Unknown Standard Negative
Population (STD) Control (NC)
StepOnePlus™ System 6 0 0 12
StepOne™ System 2 0 0 4

IMPORTANT! If too many outliers are present, order another RNase P plate and
repeat the experiment.

d. Repeat steps 3athrough 3c for each replicate population (unknowns, standards,
and negative controls) on the reaction plate.

4. Click Reanalyze to analyze the run without the outliers.

If the status of the RNase P Run is“Failed” after performing steps 2 through 4, repeat
the RNase P experiment using a different RNase P plate. If the problem persists,
contact Support as explained in “How to Obtain Support” on page 14.

RNaseP To perform a new RNase P Run, click "Start RMase P Run." To open an existing RMNase P run, browse and select the file to open, then click "Open.”
Calibrate RNaseP
| StatRNassPRun | OR OpenExisting RNase P Run | serDsskiopliDsy DatalRNassP Exampls sds | | Browss | | Open
RNaseP Data - RNaseP datafor C:\Documents and Settings\idevuser\Desktop\RNaseP Example.eds
Status . Passed \_ﬂr‘rﬂ |£a||yze | save Status
3 <| View Plate Layout
Amplification Plat| Standard Curve > J=\ =]
Plot Seflings Select Wells With: - Ssisct ltem - ¥ T
P\ntType:lCTvsiWell | Graph Type: | | Color Plat By: [wel v ‘ | = showinwels ¥ | [ view Legand ‘ = |
2 |
» P g By B =
/O/O.LL'*SZJASBTSEWHH\
Amplification Plot a‘ R [ [@e M- @ [@er @e T @ @e @@=
ATE3E3 476. 457. 4.76. 48E3 5.01. 487. 5.06. 505. 476. 479. 481
L e e S S e e e e e I B e g de Gl de g de s dede adeas
o2 | (M« @r @c @r @¢ e e 0x 0 e e e
. ::: B| 471, 484, 48E34TE3 472. 469. 529. 477. 508. 488. 517.| 57,
Outlier 2 G | [ T
iz M- @M= [e @ @ @r 0= T @ 0@e 0e @
25'0 C|472. 466. 483. 4.65. 457. 485, 473 503. 4.83. 497. 506. 4.88
53 8¢ B+ 8- B¢
3 3 2.5E3 2.5E3|2.5E3
BT R - (N e maa: S St S S B S s e s SR N BN 4k bk db dar g s E oGS
::: Hr Br | BHr
§ 2E4 2E4 |2E4
L T e I A e e s s S N N - -d - A Sl Gl Gl e e e A dE HE S
: T
|39/ 102 102,
D'uu510152)25Ju}sau!;sHNstssauasmrsmusnsa Nl
el bumazr 1'956./98E3 1.08
Options Me M= \ \ M= \ .mg‘ R‘ EP-
Target: FAM |+ [Thwshold: [7] Auto [0+ | [7] Auto Baseine 721 999/ 929/ 9.34. 943, 1.03. 873, 1.04.] 1.04.] 991.] 1,02, 978.
: []Threshold —
Shon: []Thees! I Wells: [ 72 Unknown [5] 20 Standard [] 4 Negative Contral 0 Empty
& Home | Instrument Maintenance x
Notes
. . ™ ™ H
Applied Biosystems StepOne ™ and StepOnePlus ™ Real-Time PCR Systems 97

Installation, Networking, and Maintenance Guide




n Chapter 4 Install the Standalone Layout

Analyze the RNase P Experiment

5. Review the standard curve:
a. Select the Sandard Curvetab.
b. Click the upper-right corner of the Plate Layout to select all wells.

c. Confirm that the R2 value is greater than or equal to 0.990.

If the R2 valueisless than 0.990, repeat the RNase P experiment using a different
RNase P plate. If the problem persists, contact Support as explained in “How to
Obtain Support” on page 14.

i StepOne™ Software

File Edit Instrument Analysis Tools Help

[&] New Experiment - =3 Open... =] .j Close Q\_“ Send Experiment to Instrument.. L_'{/. Download Experiment from Instrument... .Q & PrintReport.
RNaseP To perform a new RNase P Run, click "Start RNase P Run.” To open an existing RNase P run, browse and select the file to open, then click"Cpen.”
Calibrate RNaseP
| Start RMasePRun | OR  Open Existing RNase P Run | senDsskiopliDsy DatalRMassP Example eds | | Browss | | open
RNaseP Data - RNaseP datafor C:\Documents and Settings\idevuseriDesktop\RNaseP Example.eds
Status: Passed | omit | | Analyze | | Save Status
5a
= 3
< | View Plate Layout
Amplification Flot | Standard Curve > 6 =
PR Select Wells With: |- Select tam - v | Ite |
{aiaet |RNaseP v‘ Plat Color |DEFE“”t v‘ ‘ how in Wells ¥ | VlewLEgEnd | | H | E |
5b
w = E ||/
= L | 11 7 3 4 5 6 i 8 8 10 11 12
Standard Curve v v EN o B v o B v B o B v B v kR U T
2000 A |43E3 476, 457 4.76. 48E3| 5.01. 487 5.06. 505. 4.76. 4.79. 481.,
20754
CEE il (03U G0 G0 E300 B3 0 G0 G830 B0 BN U BN U G
Status: Failed B | 471. 464./48E3 47E3 472 469, 5.29.. 4.77.| 5.08.. 488.. 517/ 517.
LastRun:  4/4/06 3:12FM Ll B U S S A S S R N (W W W W W W W W W W W W
G- (0 0 B G0 B30 B8 0 G 0 I 0 O B U B U B U
2791 u C|472. 466, 483. 465 457. 485, 473, 503.| 483 497.. 5.06.] 488.
28501 ARk A A A A A A A A A A A
2825 { i Orde de @eBBr BB Br BB Br
el D |erun Crui Cr Uil Crur 1.25. 125, 1.25.] 1.25.| 25E3| 2.5E3| 2,563 2.5E3
- L B . T N W WV WV WeW
27501 BB He Br BB BeHe Br Br Be He
27,25 { E\|5E3 |53 [5E3 |5E3 [1E4 |1E4 [1E4 |1E4 |2E4 |2E4 |2E4 |2E4
27.00
@~ @~ O~ Or O~ Or Oe O+ Or O« O O
28,50 1 F|9.35. 952, 944. /9563 9.8E3 9.79.. 9.37.. 9.56.] 1.02.] 9.93. 1.02. 1.02
28251
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L L 0 B o o o o B3 o B0 B O o B o B
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Target: RNase P Slope:-3287  Yinter: 40 nnEL%”m 0 ‘ Wells: [ 72 Unknown [5] 20 Standard [] 4 Negative Contral 0 Empty
|
5¢ i
S —————
& Home | Instrument Maintenance x
Local Instrument : cannected
6. Click Save Satus, then click Yes when prompted.
7. Touch the instrument touchscreen to awaken it, then touch Passin the RNase P
wizard.
Notes
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After the Installation

After verifying the performance of the system, you can install additional software to the
computer and/or connect the instrument to an Ethernet network.

Install Additional We recommend installing the following types of software to improve the function and
Software security of the system computer:

» Antivirus software

» Archival or file compression software

» Security software (firewall and encryption utilities)
» Performance optimizing software

Note: For moreinformation, see* Select Protective Hardware and Software” on page 31.

To confirm that third-party software does not interfere with the StepOne™ software:

1. Ingtall the software to the computer that contains the StepOne™ software.

2. Perform several test experiments using “dummy” plates (plates that do not contain
reagents).
Note: The goal of the test experimentsisto run plates under conditions that match

normal instrument operation. Therefore, the characteristics of the test experiments
(plate layout and run method) must closely resemble your actual experiments.

3. Confirm that the system performs each test experiment without producing errors.

If the system performs the tests successfully, perform experiments normally. If the
system encounters errors during the test runs, the software may not be compatible
with the StepOne™ software.

Network the If the standalone instrument is connected to a network, then computers on the network
System that are running the StepOne™ software can:

» Monitor the status of the run in progress

» Send and download experiments to and from the instrument instead of using the
USB drive

To connect the instrument to a network, go to Chapter 5, “ Connect the System
to aNetwork,” on page 101.

Notes
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Connect the System to a Network

This chapter covers:

L Y= V= T 102
B Connect thelnstrumenttoaNetwork. ........ ... . i, 106
B Set Up aComputer for Remote Monitoring. ............... ... ... ... 108
B Monitorthelnstrument. . .......... . i e 110

Note: For more information about any of the topics discussed in this guide, access the
Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software
by pressing F1, or clicking @ in the toolbar, or selecting Help » StepOne Software
Help.

IMPORTANT! This chapter does not provide adequate detail to integrate the

Applied Biosystems StepOne™ or StepOnePlus™ Real-Time PCR Instrument into all
possible network architectures. Because your network may contain advanced features
(such asafirewall or network domains), we recommend that you consult a network
administrator before connecting the Applied Biosystems StepOne™ or StepOnePlus™
Real-Time PCR System to your laboratory network.

Notes
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Overview

About Remote

Monitoring

Network Setup

Notes
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Workflow

After installing the Applied Biosystems StepOne™ or StepOnePlus™ Real-Time PCR
System, you can connect the instrument to alocal area network to enhance its
functionality.

This chapter describes how to:
» Set up the instrument for use on a network.

» Set up acomputer for remote monitoring.
» Test the network connection by engaging the remote monitoring feature.

Once the instrument is connected to a network, any computer on the network can use the
remote monitoring feature of the StepOne™ software to monitor the instrument. During a
run, the remote monitoring feature can provide run status, temperature, and amplification
data as the instrument collects them. See “Monitor the Instrument” on page 110 for more
information on remote monitoring.

IMPORTANT! The remote monitoring feature does not allow you to control of the
instrument. Contral of the instrument is limited to the colocated computer when the
system isin a colocated layout, or the instrument touchscreen when the systemisina
standalone layout.

Chapter 3, Chapter 4,
Install the Colocated Layout Install the Standalone Layout

v

Connect the instrument to a network
1. Define the LAN Port IP settings.

v

Set up the computer for remote monitoring

1. Connect the computer to the network.
2. Install the StepOne™ software.

v

Test the network connection

1. Enable remote monitoring.
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Overview

Example Network TheLAN and Computer Ports of the instrument allow you to add the system to a network
Layouts insevera ways. The following examples describe two basic network layouts of the
system.

Networked Standalone Layout

In this example, a standal one instrument is connected to a network by the instrument
LAN Port (=), which has been configured for dynamic host configuration protocol
(DHCP) or static |P operation. In this layout, any computer on the network can monitor
and exchange experiment data with the instrument; however, computers on the network
cannot control the instrument. Runs must be started from the instrument touchscreen.

Network
IR
A ==
@y
(&= Networked
Networked standalone
computer instrument

Networked Colocated Layout

In this example, a colocated instrument is connected to a networked colocated computer
by the Computer Port (&), and to a network by the LAN Port (=) that has been
configured for DHCP or static | P operation. In thislayout, computers on the network can
monitor and exchange experiment data with the instrument; however, the instrument is
controlled locally by the colocated computer.

IMPORTANT! Consult your IT department to network a colocated computer. To enable
the full functionality of the StepOne™ software, the colocated computer requires a
network connection.

Network
server
@
Networked Networked
Networked colocated colocated
<. computer instrument instrument
Computer Port
—¢
Notes
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Overview

Instrument Ports  Theinstrument supports two 10Base-T Ethernet connections: a Computer Port for
communication with the colocated computer, and aLocal Area Network (LAN) Port for
network communication.

Computer Port LAN Port

—_

Port Purpose Supports
The connection for the colocated computer, Static IP network service
Computer Port ; . .
which controls the instrument. only with subnet mask and

B Note: We do not support colocated layouts in default gateway settings
which the Computer Port does not directly
connect the instrument to the colocated

computer.

LAN Port The connection for a local area network. e Static IP network service
. . with subnet mask and
When the instrument is connected to a default gateway settings

network, computers on the network that run the

StepOne™ software can: or

¢ Dynamic host
configuration protocol
(DHCP) network service

¢ Managed data network

¢ Remote monitor the instrument as it
performs runs.

e Send experiments to, and download
experiments from the instrument.

service (NDNS/DNS) for
IMPORTANT! Computers connected to the local domains?
instrument through the LAN port cannot control |  |pya link-local (IPV4LL) in
the instrument. the RFC$

T Because managed data network service (MDNS) is limited to direct network connections, a
instrument set for mMDNS may not be visible to other nodes that are separated by a router, hub,
or another network device.

§ Also known as Automatic Private IP Addressing (APIPA) or Internet Protocol Automatic
Configuration (IPAC). When the instrument is set for DHCP, Automatic Private IP Addressing
(APIPA) is automatically enabled, and the instrument provides an IP address when no address is
supplied by the DHCP server.

Notes
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Overview

Networking + Consult a Network Administrator

Guidelines and — We recommend that you consult a network administrator before connecting the
Best Practices system to your laboratory network.

— To enable the full functionality of the StepOne™ software, the colocated
computer requires a network connection.

e Confirm theInstrument Connections

Confirm that the instrument is connected to the network by the blue LAN Port (=).
If the system isinstalled in a colocated layout, confirm that the instrument is
connected to the computer by the yellow Computer Port (L&,).

» Limit Remote Monitoring to One Computer

Avoid using more than one computer to simultaneously remote monitor the
instrument. Although the system supports remote monitoring from multiple
computers, each connection taxes the instrument microprocessor. Too many
connections can overburden the instrument and result in instrument errors.

Note: The effects of an overburdened instrument are evident in the Temperature Plot
during arun. Symptoms can include extended hold times or brief, unexpected
plateaus in the instrument Temperature Plot.

» Observe Restrictionsto mDNS and Auto Discovery

Theinstrument supports multicast domain name service (MDNS) but only when the
instrument and computer share a direct network connection and are within the same
subnet. Consequently, computers on the network that are separated from the
instrument by arouter, hub, or other network device may not be able to access the
instrument by its host name.

The instrument also does not support auto discovery for mDNS. However, the
instrument does support name resol ution but the instrument name must be unique
within the subnet.

Note: Confirm the uniqueness of the instrument name. The instrument does not test
the uniqueness of the instrument name when it is set.

e Add Instruments Using Lower Case Letters

When you add the instrument for remote monitoring (see “Enable Remote
Monitoring” on page 110), enter the instrument name using lower case letters only.

Notes
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Connect the Instrument to a Network
Connect the Instrument to a Network

After deciding how to connect the instrument to a network, set up the instrument
according to your network palicies.

Materials Ethernet cable with RJ45 connectors
Required

Collect Required « Network policy for obtaining IP addresses: DHCP or static IP.
Information

IMPORTANT! When the instrument is set for DHCP, Automatic Private |IP
Addressing (APIPA) is automatically enabled and the instrument will provide an IP
address when no addressis supplied by a DHCP server.

* If the network requires a static | P address, obtain the IP address, subnet mask, and
gateway address for the instrument.
How to Obtain the MAC Address of the Instrument

If your systems administrator requests the Media Access Control (MAC) address for the
instrument, obtain the MAC address as follows:

1. Touch the instrument touchscreen to awaken it, then touch

2. Inthe Main Menu, touch Settings M enu, then touch About the I nstrument.

The MAC address for the instrument appears in the rights side of the About
Instrument screen.

&2 Applied
A‘% Big?ystems

Applied Biosystems StepOne" Real-Time PCR System
Flrmware Verslon: 0,17.0.4 1 685 “3,18A MALC [D: FF:FEFF:FFFFFF 2

Copyright 2008 by Applera Corporation. All rights reserved,
Applied Blosyslems i5 4 rugistercd trademark and Applera ks
a trademark of Applera Corporation or its subsidiaries in the
LS andfor certaln other countries, All other trademarks are
theaols property of their respective owners.,

3. When finished, touch Done.

4. Inthe Settings Menu, touch to return to the Main Menu.

Notes
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Connect the Instrument to a Network

Define the LAN 1. Touch the instrument touchscreen to awaken it, then touch

Port IP Settings _ ) _
In the Main Menu, touch Settings M enu, touch Admin Menu, then touch

Set |P Address.

3. Enter the IP settings for the network connection.

Network

Service Action

DHCP Touch Assign IP address dynamically (using DHCP), touch Done, then
touch OK when prompted.

Static IP | 1. Touch Static.

2. Enter the IP address, subnet mask, and default gateway settings. For
each setting, touch the field, enter the address, then touch Done.

3. Touch Done to save the settings, then touch OK when prompted.

The following figure shows an example of static IP network settings for the
LAN port of the instrument.

| % IP Settings

| Assign IP addreas dynamically (using DHCP) v | e
1P Address: Im’d.lmuoum
‘Subnet Mask: Izaamzaa.m

Default Gateway: |1:|2.lss.umml

Doncl

Choose how the IP address Is assigned. For static [P
addresses. enter the required information from your
system administrator. When you are finished, touch Done.

4. Touch to return to the Main Menu.

5. Connect the Ethernet cable between the:
 BlueLAN Port (=) of the instrument, and the
» Ethernet port for your network

IMPORTANT! Do not connect the Ethernet cable to the yellow Computer Port
(L&.,); this port is reserved for the colocated computer connection.

LAN Port

Notes
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Set Up a Computer for Remote Monitoring

Materials
Required

Collect Required
Information

Connect the
Computer to the
Network

Notes

108

After connecting the instrument to the network, connect the computer to the network and
install the StepOne™ software for remote monitoring.

Ethernet cable with RJ45 connectors

Computer Requirement

If you are connecting a computer that you provided to a network, confirm that the
computer contains a network interface card (NIC) or afree network port.

» Network policy for obtaining | P addresses: DHCP or static IP

* If the network requires a static | P address, obtain the IP address, subnet mask, and
gateway address for the computer

IMPORTANT! We recommend that you arrange for a network administrator to connect
your computer to the network. The following procedure does not provide adequate detail
for al network architectures.

1. Usethe Ethernet cable to connect the computer to the nearest network port.

2. Power on the computer, then log in using an account that belongs to the
Administrators user group.

3. Inthe computer desktop, right-click My Network Places, then select Properties.
4. Right-click Local Area Connection, then select Properties.

5. Select m=Internet Protocol (TCP/IP), then click Properties.

RIX

-4 Local Area Connection 4 Properties
General | Authentication | Advanced

Connect using:

| 8 TEPWIN32 Adapter va

This connection uses the following items:

Chenl for Microsoft Nebworks

vl B File and Printer Sharing for Micrazsaft Netwarks
4= 005 Packet Scheduler

M % Internet Frotocol [TCFAF)

l Install... l [ Uninztall ] [ Properties ]

Description

Allows your computer to access resources on a Microsoft
network.

] Shows icon in notification area when connected
[] Matify me when this connection has limited or no connectivity
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6. Set the Internet Protocol (TCP/IP) Properties:

Network

Configuration Action

DHCP 1. Select Obtain an IP address automatically.

2. If the computer obtains DNS addresses:
e Automatically — Select Obtain DNS server address
automatically.
e Statically — Select Use the following DNS address, enter the
address of the preferred and alternate DNS servers if available.

Static IP Select Use the following IP address.
In the IP Address field, enter the static IP address.

If necessary, enter a subnet mask.

oD =

If necessary, enter a static gateway address in the Default
Gateway field.

7. 1f your network requires advanced TCP/IP settings (such as WINS settings):
a. Click Advanced in the Internet Protocol (TCP/IP) Properties dialog box.

b. Definethe IP Settings, DNS, and WINS tabs as instructed by your systems
administrator, then click OK.

8. Closeal dialog boxes by clicking OK.

9. Restart the computer.

Note: The computer is now visible to other computers on the network.

Install the 1. If you have not already done so, install the StepOne™ software to the networked
StepOne™ computer (see“Install the Software” pages 59 or 84).

Software
Note: The StepOne™ software is required to monitor the instrument over the

network.

2. (Optional) Install protective software to the computer (see “ Select Protective
Hardware and Software” on page 31).

Notes
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Chapter 5 Connect the System to a Network

Monitor the Instrument

After connecting the instrument and a computer to the network, test the network
connection by enabling remote monitoring.

About Remote When theinstrument is connected to the network, any computer on the network that is
Monitoring  running the StepOne™ software can:

Monitor the status of the instrument during and between runs

Send an experiment to the instrument (see page 112)

Download an experiment from the instrument (see page 112)

Enable or change email notification settings for the instrument (see page 113)

Guidelines for Remote Monitoring

To ensure optimal performance of the remote monitoring feature, observe the following:

Enable Remote 1.

Monitoring

Although the StepOne™ software can add multiple instruments for remote
monitoring, it can monitor only one instrument at atime.

We do not recommend that an instrument be monitored by more than one computer
simultaneously.

Unlessyou are sure that your instrument and computer exist on the same subnet, we
recommend that you use the | P address of the instrument to add it for remote
monitoring.

In the StepOne™ software, select Instrument » Remote Monitor.

2. Inthe Manage Instrument screen, click Add I nstrument.

Notes
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Add the instrument in the Add Instrument dial og box:

a. Inthe Profile Namefield, enter the name of your instrument (from step 1b on
page 45).

b. IntheInstrument Name, Host Name, or IP Address field, enter the host name
or |P Address of the instrument that you want to monitor.

c. Click Save & Exit.

The StepOne™ software displays an entry for the instrument in the left-most column
of the Manage Instruments screen.

Enable remote monitoring for the instrument:

a. Inthe Manage Instrument pane of the StepOne™ software, select the instrument
that you want to monitor.

b. Inthe entry for theinstrument, click | % .

Note: You can also monitor the instrument by selecting your instrument from the
dropdown menu, then clicking Monitor.
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The StepOne™ software displays the status, attributes, and plot data for the selected
instrument in real time. If a communications warning appears, troubleshoot the
problem as explained in “Network Connection Problems” on page 161.
You will lose the software connection to the colocated instrument if you:
» Changetheinstrument that is connected directly to your computer
» Usethe colocated instrument touchscreen to change the instrument name or
IP address

To reestablish the colocated connection, restart the StepOne™ software.

% StepOne™ Software v2.0

File Edit Instrument Analysis Tools Help

Hew Experiment = 5 open.. [ 3 close 0 send Experimantto Instrument... 5} Download Experiment from Instrument.. 48 a8

ey - ] e [

Manage Instruments &

Add Instrument

1strument, then click "

[ Run Status: Tdle Instrument Mame: Example Experiment [7] Enable Run Notifications
: Status: Connected | —
% (Default) Local Instrument Estimated Time Remaining: Cannok determine ; ;
Experiment Name: Block Type: 48-Well Block | Netification Settings |
: Serial Number: 100010001
4a # Example Experiment AR ke (ED

Type: Applied Biosystems StepOne™
Host Name: 192.168.0.40:1

Temperature Plot

4 fEEEEW

Temperature Plot
Current Temperatures

Sample: 25.0
Cover: 105.0
Block: 25.0

"
Add Instrument El

Temperature
a Enter a name for this instrument profile within the Remote Monitor. Then, enter the instrument name, host name, or IP address to connect to the instrument. Required 3
Ifyour netwark administrator provided you with a host name, enter the host name. If you do not have a host name, enterthe instrument name or IP address. a
. 1 Covey
Profile Mame [ Example Instrument ] | Coro
h Black

*Instrument Name, Host Mame, or IP Address ‘ 192.168.0.40:1 ;
‘LEQ

| save&Extt | | Save & Add Ancther | | Cancel =
S 10Minutkes

D Fired view []
]
4

0 i i
00:00:00 00:00:50 00:01:40 00:02:30 00:03:20 00:04:10 00:05:00 00:05:50 00:06:40 00:07:30 00:08:20 00:09:10 0010
Time

A Home | Instrument Maintenance % | ¥ Remote Monitor x

Local Instrument : connected

Notes
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Monitor the Instrument

Send an
Experiment to a
Monitored
Instrument

Download an
Experiment from
a Monitored
Instrument

Notes

112

1. Inthe entry for your instrument, click [ i |.

2. Click Browse, then navigate to and select the experiment that you want send to the
instrument, then click Open.

3. Sdlect your instrument from the Select Instrument dropdown menu.

4. Click Send Experiment, then click OK when prompted.

Send Experiment to Instrument @

a Select an experiment to send, select the instrument to receive the n
experiment, then click"Send Experiment”

1. Select Experiment: | Ine System\experiments\Example Experiment,eds ‘ ‘ Browse... |

2, select Instrument: f Example Instrument |

| Send Experiment Cancel |

—h
.

In the entry for your instrument, click |£J .
Select your instrument from the Instrument dropdown menu.

Select your experiment from the Experiment dropdown menu.

0D

Click Browse, then navigate to and select the folder to which you want to send the
experiment, then click Select.

5. Click Download Experiment, then click OK when prompted

Download Experiment from Instrument @

n Selectthe instrument with the experiment, select a location on this computer for the n
experiment, then click "Download Experiment”

1, Select Instrument; \q_- Example Instrument Vi Experiment; ‘!_— Example Experiment v}
2, Download File To: | Ci\Applied Biosystems\StepCne System|experiments | Browse... |
‘ Daownloacl Experiment | | Cancel ‘
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Enable or Change The notification settings allow you to configure the StepOne™ software to alert you by
Notification email when the instrument begins and completesarun, or if an error occurs during arun.
Settings  You can also set up the software to attach a completed run file to the Run Completed
email notification. The notifications settings feature is optional and does not affect
system performance.

IMPORTANT! The StepOne™ software will transmit email only while the instrument is
monitored. If the network connection isinterrupted, the StepOne™ software will stop
transmitting updates.

To modify the notification settings:

1. Contact your systems administrator or information technology department for the:
» Network address of a Simple Mail Transfer Protocol (SMTP) server.
* A user name and password for the server, if required for access.
» The Secure Sockets Layer (SSL) setting of the server (on or off).

2. While monitoring an instrument, select Enable Run Notificationsin the top-right
corner of the screen.

3. Click Change Natifications, change the Notification Settings as desired, then click
the close box.

4. Select Enable Notifications.

5. Select the events that generate notifications:

* Instrument Error — Causes the system to email recipients all errors
encountered by the instrument during each run.

* Run Sarted — Causes the system to email the recipients every time the
instrument starts arun.

* Run Completed — Causes the system to email the recipients every time the
instrument completes arun.

6. Click the Enter e-mail addresses for notifications field, then enter the email
address(es) that you want to receive email notifications.

7. Click the Outgoing Mail Server (SMTP) field, then enter the address of the SMTP
server.

8. Select whether or not to attach completed run files to the Run Completed email
notifications.

Note: Thisoption appliesonly to email notifications that are generated when the
instrument completes arun (that is, Run Completed is selected in step 5).

Notes
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9. Set the authentication settings as needed.
If the SMTP server requires authentication:

a. Click Yes.
b. Click the User Name field, then enter the user name to access the server.

c. Click the Password field, then enter the password for the user account.

10. Click Test Configuration. If the notification settings are set up correctly, sample
emails are sent to the addresses entered in step 6.

Hotification Settings

Enable Noatcatons: (8)ves (C) Mo

Salectthe events 1 géndrats natacaions: [ insvument Eor
5 [T run ctareg
[ run Comeleted

o7 &Ml $I2BEERE o R AL urinnliARrnye ompsey com, superdson@erompany com, bechnician@ycompany com
I —
For emaenyile jann_smith@empdomain enm smwongy@bigmailhost com
7 ptiesg Ml Server (SMITEY. sredp mycompany com
For eample: smio M ompany.com
8 - amatheompemannemmassage? (@)ves (nn
ga Sirver puquines an vyt eonnecaon? () ¥es (8 No
] ;
Berwr ioquines authodcaion? (@) Yes ) Ho
9b —  (Burver Aulhunbicationi) Usin Name Example User
gc (Raenvins Aulhonibraion) Pasiennd  sssessns

Testing cument paramatars. [ 1

Whin yOu press the Test ConAqurstion” BURR, | g e ratin |
£ampls start un, ear, and run comglts
avants wil DB 5478 Using Ma curTant parametare.

10

Notes
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Chapter 6

m Maintain the System

This chapter covers:

B Regular MaiNteNanCe . . ..ottt 116
Perform a Spatial Calibration. . .......... .. ... i 118
Perform aBackground Calibration. .. ............... ... ... ... ... ... 122
PerformaDyeCalibration .......... ... ... .. 128
Archiveand Back UpData. . . ... 142

B Infrequent MaintenanCe . . ... ittt e e 144
Decontaminate the SampleBlock(S). . ........ oo 145
Movethe Instrument. . . ... . o 148
Replacethe External FUSES. ... ... .. 150
Shipthelnstrumentfor Service ........ ... i 152
Update the StepOne™ Software or the Operating System. ................. 154

Note: For more information about any of the topics discussed in this guide, access the
Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software
by pressing F1, or clicking @ in the toolbar, or selecting Help » StepOne Software
Help.

Notes
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Regular Maintenance

Maintenance Perform routine maintenance of your Applied Biosystems StepOne™ or StepOnePlus™
Schedule Rea-Time PCR Instrument and computer to ensure proper operation. The following
table displays the recommended maintenance schedule.

Perform See
every... Task Page
Week Check the computer disk space. If necessary, archive or back up your 142

experiment files.

Power off the computer controlling the instrument, then after 30 sec —
power on the computer.

Clean the surface of the instrument with a lint-free cloth. —

Defragment the computer hard drive. —

Month Perform a background calibration.* 122
1.5 Years Perform a spatial calibration. 118
Perform a dye calibration. 128

I You can run a background calibration to check for contamination. Also, you must run a
background calibration and a dye calibration if any part of the instrument optics are replaced or
moved.

Connection The spatial, background, and dye calibrations must be performed while the systemisina
Required for colocated layout. To set up the system for maintenance, connect the yellow StepOne
Maintenance system cable between the:

* Yellow Ethernet port (L&,) of the instrument, and
« Ethernet port (Z5) of the computer running the StepOne™ software

IMPORTANT! Do not connect the StepOne system cable to the blue LAN Port (),
which isreserved for a network connection.

Ethernet

W

Computer Port

—

Maintenance When arequired maintenance task such as a calibration is overdue, the StepOne™
Notifications software and instrument display messages that prompt you to perform the necessary
procedure.

Notes
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How to View You can use the StepOne™ software to view a summary of maintenance data for your
Maintenance instrument. To view the maintenance information, select Instrument » Instrument
Information Maintenance Manager in the StepOne™ software. For each caibration (spatial,
background, and dye), the software lists the following information:

e Satus— Condition of the current calibration where:
- indicates that the calibration is up to date.

— Expired indicates that the calibration must be performed at the earliest possible
convenience.

— Not Run indicates that the calibration has not been run (RNase P only).
* Last Run —Date when current calibration was run.
» Expiry Date— Date when current calibration will expire.

Instrument Tools The Tools Menu of the instrument provides several features that test the temperature of
Menu Tests several instrument components against the product specification.

Test Description

Run Cycle Performance Test Verifies that the sample block(s) achieves the temperature
accuracy specification for the instrument.

Optics Verification Verifies that the instrument optics is operating to the
specifications of the instrument.

Statistics Displays the usage data for the instrument, including:

e Thermal cycles performed by the sample block(s).

e Degrees Celsius heated or cooled by the sample
block(s).

e Hours of operation for the instrument LED.
¢ RNase P verification run data.

Temperature Verification Service

We recommend that you perform an annual temperature verification of the instrument
depending on your usage and laboratory requirements. The temperature verification service
can be performed by us when the instrument is shipped for an annual service, or by the
service engineer at an additional cost. See “How to Obtain Support” on page 14 to contact
Support for pricing and further information.

Notes
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Perform a Spatial Calibration

Materials
Required

Purpose of the
Calibration

Prepare for the
Calibration

oF

Notes
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Perform a spatial calibration every 18 months, or as often as necessary, depending on
instrument use.

 Spectral calibration plate 1 from the spectral calibration kit for your instrument:
— StepOne™ Real-Time PCR System Spectral Calibration Kit (PN 4371433)
— StepOnePlus™ Real-Time PCR System Spectral Calibration Kit (PN 4371435)
o Safety glasses
» Powder-free gloves
» Centrifuge with reaction plate adapter
» StepOne system cable, yellow (from the system packing kit)

A spatial calibration maps the positions of the wells on the sample block(s) so that the
StepOne™ software can associate increases in fluorescence during a run with specific
wells of the reaction plate.

ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle calibration plates.

1. If you have not already done so, use the StepOne system cable to connect the:
* Yellow Ethernet port (L&,) of the instrument to the
« Ethernet port (&%) of the computer running the StepOne™ software

IMPORTANT! Do not connect the StepOne system cable to the blue LAN Port (=)

Computer Port

_.

2. Get calibration plate 1 from the spectral calibration kit in the freezer.

3. Allow calibration plate 1 to warm to room temperature (approximately 5 min).

IMPORTANT! Do not remove calibration plate 1 from its packaging until you are
ready to run it. The fluorescent dyesin the wells of both spectral calibration plates
are photosensitive. Prolonged exposure to light can diminish the fluorescence signal
strength of the dyes.
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4. Remove calibration plate 1 from its packaging.

5. Vortex caibration plate 1 for 5 sec.

6. Centrifuge calibration plate 1 for 2 min at less than1500 rpm.

IMPORTANT! The calibration plate must be well mixed and centrifuged.

7. Confirmthat the liquid is at the bottom of each well of calibration plate 1. If not,
centrifuge the calibration plate again at a greater rpm and for alonger time.

IMPORTANT! Do not alow the bottom of the calibration plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the plates can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
' ‘ Liquid is at the ¢ Not centrifuged with enough force, or
) | bottom of the well. & Not centrifuged for enough time

8. Load calibration plate 1 into the instrument:
a. Open the instrument drawer.

b. Placethe calibration plate in the sample block(s) so that the A1 position is at
the back-left corner.

c. Closetheinstrument drawer carefully.

Notes
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Perform the 1.

Calibration

5.

In the main screen of the StepOne™ software, select I nstrument » Instrument
Maintenance M anager.

In the navigation pane of the Instrument Maintenance Manager, click Spatial.
In the Instrument Maintenance Manager, click Start Calibration.

In the Setup screen of the Spatial Calibration dialog box, select The calibration
plateisloaded into the instrument, then click Next.

In the Run screen, click START RUN i, then wait for the instrument to complete
the spatial calibration.

Remove the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Calibration Plate temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reaches room temperature.

‘-f'/: IMPORTANT! Wear powder-free gloves when you handle calibration plate.

1.
2.

Notes
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Open the instrument drawer.

Remove calibration plate 1 from the sample block(s), place it inside its packaging
dleeve, and return it to the spectral calibration kit in the freezer.

Close the instrument drawer carefully.

A CAUTION
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Analyze the 1. IntheAnalysisscreen of the Spatial Calibration dialog box, confirm the status of the

Calibration Data cdibration:
» Passed — Theinstrument passed the calibration. Go to step 2.

» Failed — Theinstrument failed the calibration. Contact Support as described in
“How to Obtain Support” on page 14.

2. Click Finish.

3. When prompted to save the calibration, click Yes.

X

| Spatial Calibration Analysis Analysis Help @

1 ) G Instructions: Spatial Calibration Analysis
Status: [[PAs88AN  Click 'Finish"to exit the wizard and save the calibration results.
|| Spatial calibration passed
I  Analysis
=
Spatial Calibration
3/ Do you want to save this result?
3 s | [ mo | [ cancel]
2 )
Notes
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Perform a Background Calibration

Materials
Required

Calibration
Guidelines

Purpose of the
Calibration

Notes
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Perform a background calibration monthly, or as often as necessary, depending on
instrument use.

» Background plate from the spectral calibration kit for your instrument:
— StepOne™ Real-Time PCR System Spectral Calibration Kit (PN 4371433)
— StepOnePlus™ Real-Time PCR System Spectral Calibration Kit (PN 4371435)

Note: Alternatively, create a background plate as described in “How to Create a
Background Plate” on page 127.

» Powder-free gloves

o Safety glasses

» Centrifuge with reaction plate adapter

» StepOne system cable, yellow (from the system packing kit)

» Make sure the centrifuge you use is clean. Before centrifuging, wipe down the
bucket using atissue.

» Handlethe calibration plates with care to prevent contamination. To avoid
contaminating the reaction plate, do not place plates on alab bench. Always return
the calibration plate to its origina bag.

A background calibration measures the level of background fluorescence in the
instrument. During a background calibration run, the system:

» Performs continuous reads of a background plate containing PCR buffer for 10 min
at 60°C.

» Averages the spectra recorded during the run and extracts the resulting spectral
component to acalibration file.

The StepOne™ software uses the calibration file during subsequent runs to remove the
background fluorescence from the run data.

Background Fluorescence

Fluorescence data collected by the system includes a fluorescent spectral component
inherent to the system, commonly referred to as background fluorescence. This
background fluorescence is a composite signal found in all signal data that consists of
fluorescence from several sources, including:

» Background electronic signal
» Contaminants in the sample block(s)
» The plastic consumable (plates and caps)

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
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Prepare for the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Calibration temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reaches room temperature.

J IMPORTANT! Wear powder-free gloves when you handle the background plate.

1. If you have not already done so, use the StepOne system cable to connect the:
* Yellow Ethernet port (L,) of the instrument to the
« Ethernet port (=) of the computer running the StepOne™ software

IMPORTANT! Do not connect the StepOne system cable to the blue LAN Port (=x).

Ethernet

Computer Port

——

2. Get the background plate from the spectral calibration kit in the freezer.
3. Allow the background plate to warm to room temperature (at least 5 min).

4. Remove the background plate from its packaging.

IMPORTANT! Do not discard the packaging sleeve. The background plate can be
used up to three timesif it is stored in its original packaging sleeve.

5. Vortex the background plate for 5 sec.

6. Centrifuge the background plate for 2 min at less than1500 rpm.

IMPORTANT! The background plate must be well mixed and centrifuged.

Notes
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Perform the
Calibration

Notes
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7. Confirm that theliquid is at the bottom of each well of the background plate. If not,

centrifuge the background plate again at a greater rpm and for alonger time.

IMPORTANT! Do not alow the bottom of the background plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the background plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
' ‘ Liquid is at the ¢ Not centrifuged with enough force, or
) bottom of the well. o« Not centrifuged for enough time

8. Load the background plate into the instrument:

a. Open the instrument drawer.

b. Place the background plate in the sample block(s) so that the A1 position is at
the back-left corner.

c. Closetheinstrument drawer carefully.

. Inthe main screen of the StepOne™ software, select Instrument »

Instrument Maintenance M anager.

. In the navigation pane of the Instrument Maintenance Manager, click Background.
. Click Sart Calibration.

. Inthe Setup screen of the Background Calibration dialog box, select The

background plateisloaded into the instrument, then click Next.

. Inthe Run screen, click START RUN [, then wait for the instrument to complete

the background calibration.

Note: If the StepOne™ software displays messages during the run, troubleshoot the
errors as described in “Background Calibration Failure” on page 164.
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Remove the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Background Plate temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reaches room temperature.

% IMPORTANT! Wear powder-free gloves when you handle the background plate.

1. Open the instrument drawer.

2. Remove the background plate from the sample block(s), placeit inside its packaging
dleeve, and return it to the spectral calibration kit in the freezer.

Note: Do not discard the background plate. If you store the background plate in its
packaging sleeve at —20 to —25°C, you can reuse it three times after you openit.

3. Closetheinstrument drawer carefully.

A CAUTION

Notes
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Analyze the 1.

Calibration Data

In the Analysis screen of the Background Calibration dialog box, confirm the status
of the calibration:

» Passed — Theinstrument passed the calibration. Go to step 2.

» Failed — Theinstrument failed the calibration. Troubleshoot the error as
described in “Background Calibration Failure” on page 164.

2. Select all wells of the plate layout.
3. Inspect the raw datafor irregular spectral peaks.
If one or more wells produce raw spectra that diverge significantly from that of the
neighboring wells, the background plate or the sample block(s) could contain a
fluorescent contaminant. If you suspect contamination, troubleshoot the irregular
signal as explained in “Background Calibration Failure” on page 164.
4. If al spectra are acceptable, click Finish.
5. When prompted to save the background calibration, click Yes.
Analysis Analysis Help @
1 a Instructions: Review the raw spectra from the background calibration run. If the calibration passed, click "Finish" to save and apply the results
Status: — Click "Finish" to exit the wizard and save the calibration results
= Analysis Deta < | View Plate LayoutT well Table |
[ avss ¥ BE | &
2 Angn.0. 12 3 4 5 & 7 8 @ 10 11 12
A
3 30000.0
: Background Calibration
§ — \‘{/ Do you want to save this result?
5 () () (o)
E
F
G
0.0 l
oo 10 20 o a0 40 5.0
4 |
Finish
Notes
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How to Create a Whenever possible, use abackground plate included with the spectral calibration kit. The
Background Plate background plate contains a buffer that accurately models the reagents used for PCR, and
produces high-quality calibration data. However, if a background plate from a spectral
calibration kit is not available, you can create one as explained bel ow.

Materials Required

» Deionized water

* MicroAmp® Optical Adhesive Film or MicroAmp® 8-Cap Strip (Flat Caps only)
* MicroAmp® Optical Reaction Plate

» Pipettor, 200-uL and pipette tips

» Powder-free gloves

o Safety glasses

Create the Background Plate

IMPORTANT! Wear powder-free gloves while creating the background plate.

J 1. Remove areaction plate from its box and place it on a clean, dry surface.

2. Pipette 30 UL of deionized water to each well of the reaction plate.

3. Seal the reaction plate using an optical adhesive film or optical flat caps.

4. Usethereaction plate to perform the background calibration.

Notes
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Perform a Dye Calibration

Materials
Required

Purpose of the
Calibration

Notes
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Perform adye calibration at least every 18 months, or as often as necessary depending on
instrument use. Because the age and use of the instrument can affect spectral readings,
you may need to perform the calibration more frequently.

IMPORTANT! Perform abackground calibration before performing adye calibration (see
“Perform a Background Calibration” on page 122).

» Spectral Calibration Plates from the spectral calibration kit for your instrument:
— StepOne™ Real-Time PCR System Spectral Calibration Kit (PN 4371433)
— StepOnePlus™ Real-Time PCR System Spectral Calibration Kit (PN 4371435)
o Sofety glasses
» Powder-free gloves
» Centrifuge with reaction plate adapter
» StepOne system cable, yellow (from the system packing kit)

Custom Dye Plates

The StepOne™ and StepOnePlus™ instrument supports the use of custom dyes (dyes not
supplied by Thermo Fisher Scientific) that are excited with alight source at 470 nm and
fluoresce within the spectral range it supports (500 to 650 nm). See “How to Calibrate a
Custom Dye” on page 139 for more information.

During adye calibration run, the system:
» Collects spectral datafrom a series of dye standards.

» Storesthe spectral information for the dye standards in the spectrarun file, a
calibration file in the StepOne™ software directory.

The StepOne™ software uses spectral data during subsequent runs to characterize dyes
and distinguish the individual contribution of each dye in the collective fluorescence
collected by the instrument during a run. After each run, the StepOne™ software stores
run datain the form of araw spectral signal for each reading. It determines the
contribution of each fluorescent dye used in the sample by comparing the raw spectrato
the spectral file. After analysis, the StepOne™ software stores the spectral data with the
collected fluorescence data for each experiment.
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Supported Dyes StepOnePlus™ System Dyes

The StepOnePlus™ instrument uses the following dye set for calibration: FAM™ dye,
JOE™ dye, NED® dye, ROX™ dye, TAMRA® dye, VIC® dye, and SYBR® Green dye.
The following figure shows the emission spectrum for each dye, and the filter at which
each dyeisread.

Filters
Wavelength
(nm)

Emission
Spectra

Dyes ~520 nm ~550 nm ~580 nm ~610 nm
* FAM e JOE * NED ¢ ROX
* SYBR Green e VIC e TAMRA

StepOne™ System Dyes

The StepOne™ instrument uses the following dye set for calibration: FAM™ dye,
JOE™ dye, ROX™ dye, VIC® dye, and SYBR® Green dye. The following figure shows
the emission spectrum for each dye, and the filter at which each dyeisread.

Filters 1 2 3
Wavelength
(nm)
Emission
Spectra
Dyes ~520 nm ~550 nm ~610 nm
e FAM e JOE * ROX
* SYBR Green e VIC
Notes
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Custom Dyes

The system can be used to run assays designed with custom dyes (dyes not supplied by
Thermo Fisher Scientific). However, before using custom dyes with the instrument, you
must create and run a custom calibration plate. The purpose of the custom plateis similar
to that of a spectral calibration plate. The StepOne™ software uses the custom
calibration plate to create a spectral standard to distinguish the custom dyein the
fluorescence data collected during the run.

IMPORTANT! To use a custom dye on your system, it must be excited with light at
470 nm and fluoresce within the 500 to 650 nm spectral range measured by the
StepOne™ and StepOnePlus™ instrument.

IMPORTANT! We do not recommend the use of TAMRA™ dye as reporter or quencher
with the StepOne™ system. TAMRA™ dye may be used as a reporter or quencher with
the StepOnePlus™ system.
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About the The product of adye calibration is acollection of spectral profiles that represent the
Analysis fluorescence signature of each dye standard. Each profile consists of a set of spectra that
correspond to the fluorescence collected from the wells of the spectral calibration plate.
The StepOne™ software plots the resulting data for each spectral profile in agraph of
fluorescence versusfilter.

When the StepOne™ software extracts the calibration datafrom adye run, it evaluatesthe
fluorescence signal generated by each well in terms of the collective spectrafor the entire
calibration plate. Dye spectra are generally acceptable if they peak within the samefilter
as their group but diverge slightly at other wavelengths (see below).

The StepOne™ software can compensate for some differencesin a spectral profile by
replacing (auto-repairing) the spectra of unacceptable wells with the spectra of other
wells on the reaction plate. However, the software alows only afew replacements and
may reject the calibration if the spectra between neighboring wells vary significantly.

Note: Becausethewellsin acalibration plate contain dyes at identical concentrations,
the resulting signals for the wells containing each dye should be similar. Among wells
containing the same dye, variations in spectral position and peak position are caused by
minor differencesin the optical and excitation energy between the individual wells.

0 0

Acceptable Spectra Unacceptable Spectra
Spectra peak at the same wavelength Spectra peak at the different
and do not diverge significantly wavelengths
Notes
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Prepare for the IMPORTANT! Wear powder-free gloves when you handle the calibration plates.
Calibration

1. If you have not already done so, use the StepOne system cable to connect the:
_ * Yellow Ethernet port (L&,) of the instrument to the
« Ethernet port (=) of the computer running the StepOne™ software

IMPORTANT! Do not connect the StepOne system cable to the blue LAN Port ().

Ethernet
Computer Port %

—

2. Get calibration plate 1 from the spectral calibration kit in the freezer.

3. Allow calibration plate 1 to warm to room temperature (~5 min).

IMPORTANT! Do not remove calibration plate 1 from its packaging until you are
ready to run it. The fluorescent dye in the wells of each calibration plateis
photosensitive. Prolonged exposure to light can diminish the fluorescence signal
strength of the dyes.

4. Remove calibration plate 1 from its packaging.

5. Vortex cdlibration plate 1 for 5 sec.

6. Centrifuge calibration plate 1 for 2 min at less than1500 rpm.

IMPORTANT! The calibration plate must be well mixed and centrifuged.

Notes
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7. Confirm that the liquid is at the bottom of each well of the calibration plate. If not,
centrifuge the plate again at a greater rpm and for alonger time.

IMPORTANT! Do not alow the bottom of the calibration plates to become dirty.
Fluids and other contaminants that adhere to the bottom of the plates can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect

' ‘ Liquid is at the ¢ Not centrifuged with enough force, or

bottom of the well. o« Not centrifuged for enough time

8. Load calibration plate 1 into the instrument:
a. Open the instrument drawer.

b. Place calibration plate 1 in the sample block(s) so that the A1 position is at the
back-left corner.

c. Closetheinstrument drawer carefully.

Notes
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Perform the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Calibration temperature of the sample block(s) can exceed 100°C. If the instrument has been used
recently, keep your hands away until the sample block(s) reaches room temperature.

1. Inthe main menu of the StepOne™ software, select | nstrument »
Instrument Maintenance M anager.

In the Instrument Maintenance Manager, click Dyein the navigation pane.
In the Dye screen, select System Dye Calibration.

Click Sart Calibration.

In the Setup screen, select Plate 1 isloaded into the instrument.

Click Next.

N o o & 0 b

In the Run screen, click Start Run J .

EEX

i Instrument  Analysis  Tools  Help

Last Run 121317689 4

e || Plate 1 is loaded into the instrument.

[E] New Experiment - (5 Open.. [ 1 Close ’ﬂ Send Experiment to Instrument... L_ri Download Experiment from Instrument... &9 3

Dye Selectwhich dyes to calibrate (system dyes or custom dyes), then click "Start Calibration.”

calibrate Dye
(® System Dye Calibratior O Custom Dye Calibration | Start Calbration |

Dye Data - Data from the last successful dye calibration

| Dye Type Status Last Run Expiration Date Temperature(°C) |

Dye Calibration Setup Setup Help 9/

a Instructions: Locate the required materials, prepare plate 1, load plate 1 into the instrument, then click "Next"
- Systemn Dye -

Status: Expired 1. Locate required materials:

= Spectral calibration plates (plate 1 and plate 2) from the spectral calibration kit
- Powder-free gloves

- Safety gogales

= Centrifuge with plate adapter

Exp. Date: 6/30I71 4.

- Custom Dye -
Status: 0 Cumr

2. Prepare plate 1:
| wiew Instructions

3. Load plate 1 into the instrument:
a. Open the instrument drawer,
b. Place the plate in the sample block with the A1 position atthe back-left corner of the sample block.
. Close the instrument drawer carefully,

d. Select the checkbox to confirm plate 1 is loaded into the instrument:

* Home | Instrument Mai

EEEE————
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8. While the instrument is running calibration plate 1, prepare calibration plate 2 by
performing steps 4 through 7 on page 133.

9. When the wizard prompts you to do so, load and run calibration plate 2:
a. Open the instrument drawer.
b. Remove the cadibration plate 1 from the sample block(s) and discard it.

c. Place cdlibration plate 2 in the sample block(s) so that the A1 position is at the
back-left corner.

d. Close the instrument drawer carefully.

A CAUTION

e. Inthe Dye Calibration Setup wizard, select Plate 2 isloaded in the
instrument, click Continue Calibration.

Dye Calibration Setup @

a The run for plate 1 is complete. Run plate 2 to continue with the pure dye calibration

1. Load plate 2 into the instrument;
a. Open the instrument drawer.
b. Place plate 2 inthe sample block with the A1 position atthe back-left corner ofthe sample block.
c. Close the instrument drawer carefully.

2. Select the checkbox to confirm plate 2 is loaded into the instrument:
[ Plate 2 is loaded into the instrument

|| Exit Calibration |

10. When the instrument compl etes the calibration, unload calibration plate 2:
a. Open the instrument drawer.
b. Remove the calibration plate 2 from the sample block(s) and discard it.

c. Closetheinstrument drawer carefully.

Analyze the 1. After the calibration is complete, confirm the status of the calibration:
Calibration Data « Passed — The instrument passed the calibration. Go to step 2a.

» Failed — Theinstrument failed the calibration. Troubleshoot the error as
described in “Dye Calibration Failure” on page 166.

Notes
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2. For each dye present on the plate, confirm the grouping of the dye spectra:
a. Inthe plate layout, press Ctrl, then select the wells that contain the same dye.

b. Inspect the raw data. For each spectrum, confirm that the peak is:
» Within the detectable range for the instrument.
» Freeof irregular spectral peaks.

» Present in the correct channel for the dye (see “ StepOne™ System Dye
Spectra’ on page 137 or “ StepOnePlus™ System Dye Spectra’ on page 138).

If a spectrum does not comply with the criteria above, troubleshoot the problem as
described in “Dye Calibration Failure” on page 166.

Note: Among wells containing the same dye, variations in spectral position and
peak position are caused by minor differencesin the optical and excitation energy
between the individual wells.

3. If al spectraare acceptable, click Plate 2 from the View Details menu.

4. Inspect the raw data for the as described in step 2b.

5. If al spectra are acceptable, click Finish.

6. When prompted to save the dye calibration, click Yes.

Analysis Analysis Help @
a Instructions: Select a plate, then review the calibration results
1
Status: — Click "Finish" to exit the calibration and save the calibration resuits
Results
3 ‘ Analysis
=
View Details for: |Plate 2 v
2a —
Analysis Data < ut | wellTabls |
\ B View [ogend | |
1.0
ob/4 T 2 3 4 &5 6 7 8 8 10 11 12
E3lu. svBrOve | 8E Tam. SYBRDve | JBE TAM. SYBRDve | JBE
08 [,
8 NG Do youwant to save this resut? TAM...SYBRDy= . JBE TAM..SYBRDys . JBE TAM..SYBRDys .,
o
6 2 T Yes || Mo | |cancel
E o~ \ R - e .. JOE TAM..SYBRDye ... JBE TAM..SYBRDvye ... JBE TAM...SYBR
£
b
w
;g D EYBRDye .. JBE TAM..SYBRDye .. JBE TAM..SYBRDye .. JBE TAM
S
= 2 E [rAM...SYBRDye .. JBE TAM..SYBRDye .. JOE TAM...SYBRDvye ... JOE
F |J8E TAM...SYBRDye ... JOE TAM..SYBRDye ... J8E TAM...SYBRDye ...
0.2
G pye .| JBE TAM..SYBRDye . JBE TAM..SYBRDye .. JOE TAM..SYBR
00 H BYBRDye ... J8E TAM..SYBRDye ... J8E TA..SYBRDye ... JBE TAN..
L) 10 20 kL 40 a0
Filter
5 \
Notes
. . ™ ™ .
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How to Calibrate Materials Required

a Custom Dye » Centrifuge with reaction plate adaptor

» Custom dye(s)

o Deionized water

* MicroAmp® Optical Adhesive Film or MicroAmp® 8-Cap Strip (Flat Caps only)
» MicroAmp® Optical Reaction Plate of the size appropriate for your instrument

* Pipettors and pipette tips (200-puL and 1000-pL)

» Powder-free gloves

o Safety glasses

* Tubes (2-ml and 10-ml)

Prepare the Custom Spectral Calibration Plate

1. Createacdibration plate for the custom dye:
a. Prepare 1.5 mL of the custom dye at the desired concentration.
b. Pipette 30 yL of the diluted custom dye to all wells of areaction plate.

c. Sed the wells of the reaction plate using an adhesive film or optical flat caps.

d. Vortex the calibration plate for 5 sec.
e. Centrifuge calibration plate for 2 min at less than1500 rpm.

IMPORTANT! The calibration plate must be well mixed and centrifuged.

Notes
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f. Confirm that the liquid in each well of the calibration plate is at the bottom of
the well. If not, centrifuge the calibration plate again at a greater rpm and for a
longer time.

IMPORTANT! Do not allow the bottom of the calibration plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the plate can contaminate
the sample block(s) and cause an abnormally high background signal.

Correct Incorrect

' ‘ Liquid is at the ¢ Not centrifuged with enough force, or

bottom of the well. o Not centrifuged for enough time

2. Load the custom calibration plate into the instrument:
a. Open the instrument drawer.

b. Placethe custom calibration plate in the sample block(s) so that the A1 position
is at the back-left corner.

c. Closetheinstrument drawer carefully.

Run the Custom Spectral Calibration Plate

1. Inthe main screen of the StepOne™ software, select I nstrument »
Instrument Maintenance M anager.

2. Inthe Instrument Maintenance Manager:
a. Inthe navigation pane, click Dye.
b. Inthe Dye screen, select Custom Dye Calibration.
c. Click Start Calibration.

Notes
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3. Inthe Setup screen of the Dye Calibration dialog box, select a custom dye from the
list or create the custom dye as follows:

a. Click New Dye.
b. Inthe Dye Manager dialog box, click New.
c. Complete the New Dye dialog box, then click OK.

Field/Option Action

Name Enter a name for the custom dye.

Wavelength Enter the wavelength at which the dye fluoresces.

Type Select:
e Reporter if the dye works in conjunction with a quencher dye
to report an increase of PCR product.

¢ Quencher if the dye suppresses the fluorescence of a reporter
dye until amplification of PCR product.

¢ Both if the dye reports an increase of PCR product without the
aid of a quencher dye.

d. Click Close.

4. Inthe Setup screen of the Dye Calibration dialog box, enter atemperature setting for
the calibration.

Note: Set the temperature to match the temperature at which you intend to collect
data. For example, the temperature for all Thermo Fisher Scientific system dyesis
60°C because data collection for TagMan® reagents occurs during the 60°C
extension step of the PCR.

5. Select The custom dye plateisloaded in theinstrument, then click Next.

6. IntheRun screen, click Sart Run, then wait for the instrument to compl ete the dye
calibration.

Note: If the StepOne™ software displays messages during the run, troubleshoot the
errors as described in “Dye Calibration Failure” on page 166.

7. When the instrument displays the Main Menu, unload the custom calibration plate.

8. Analyze the custom spectral calibration plate as explained in “ Analyze the
Calibration Data’ on page 135.

Notes
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Archive and Back Up Data

Develop a strategy that addresses the following data management issues for the
instrument.

Check Disk If you perform real-time experiments on your system, or collect real-time data for
Space Regularly  genotyping experiments, check the available space on your hard drive weekly. When the
hard drive is within 20% of maximum capacity, transfer the older data to a backup
storage device.

Archive Older Conserve space on the computer hard drive by using adata compression utility to archive
Experiments unused or older experiments. Several commercially available compression utilities are
available, such asthe PKZIP and ARC archive formats common to the Microsoft®
Windows® operating system.

Back Up Back up the experiments generated by your system to:

Experiments « Protect against potential dataloss of data caused by an unforeseen failure of the
Regularly computer or its hard drive(s).

» Conserve space on the hard drive and to optimize performance, if you remove old
data after backing up.

See “ Select Protective Hardware and Software” on page 31 for more information on
backup storage devices.

Notes
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Maintenance

Perform the following procedures as needed to resolve problems as they arise:

Decontaminate the Sample Block(S) . ...t 145
Movethelnstrument . ............. it 148
Replacethe External FUSES . . . .. ... oo 150
Shipthelnstrument for Service ......... ... . i 152
Update the StepOne™ Software or the Operating System ................ 154
Update the StepOne™ Software ...t 154
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Decontaminate the Sample Block(s)

If you perform a background calibration and observe high fluorescent background that
you suspect to be contamination, decontaminate the sample block(s).

Materials * Bleach solution (10%)
Required « Cotton or nylon swabs and lint-free cloths
» Deionized water
» EtOH solution (95%)
 Pipettor and pipette tips (100-pL)
» Powder-free gloves
» StepOne system cable, yellow (from the system packing kit)

Guidelines for ACAUTION We recommend the use of 10% bleach solution for resolving

Bleach Solution fluorescent contamination on the instrument sample block(s); however, excessive use of
Use thesolution can corrode the block material.

To prevent block degradation:

» Use bleach solution to decontaminate the sample block(s) as alast resort. Rinse the
sampl e block(s) with bleach only after treatments of deionized water and 95%
ethanol fail to remove the contamination.

» Usedeionized water to rinse the sample block(s) thoroughly after treating the block
with bleach solution. Thoroughly removing residual bleach from the metal surfaces
with water minimizes the long term effects of bleach.

Clean the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Contaminated temperature of the sample block(s) can exceed 100°C. If the instrument has been used
Wells recently, keep your hands away until the sample block(s) reaches room temperature.

Prepare the 1. If you have not aready done so, use the StepOne system cable to connect the:
Instrument « Yellow Ethernet port (&1, of the instrument to the
o Ethernet port (=) of the computer running the StepOne™ software

IMPORTANT! Do not connect the StepOne system cable to the blue LAN Port (=5).

Computer Port

_.

Notes
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2. Using the data from the background calibration, identify the location of the
contaminated wells on the sampl e block(s).

3. Turn off and unplug the system. Allow it to cool for 15 min.

4. Open theinstrument drawer.

ACAUTION

=

5. Clean each contaminated well of the sample block(s):

a. Pipette asmall volume of water into the contaminated well, slowly pipette the
water up and down several times, then expel the water into a waste beaker.

b. Use acotton swab to scrub inside of the contaminated well.
c. Usealint-free cloth to absorb the excess deionized water in the well.

d. Repeat steps 5athrough 5d.

7. Perform abackground calibration to confirm that you have eliminated the
contamination.

Notes
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8. If the contamination persists, clean the wells with a 95% EtOH solution:

AWARNING CHEMICAL HAZARD. Ethanol isaflammable liquid and

vapor. Exposure causes eye, skin, and respiratory tract irritation and may cause
central nervous system depression and liver damage. Read the SDS, and follow the
handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

a. Perform steps 2 through 5, substituting a 95% EtOH solution in place of the
deionized water.

b. Repeat step 5 using deionized water to rinse the wells of the sample block(s).

c. Perform steps 6 and 7 to confirm that you have eliminated the contamination.

IMPORTANT! Use deionized water to rinse wells after they have been treated with
bleach or EtOH solution.

9. If the contamination persists, clean the wells with a 10% bleach solution:

AWARNING CHEMICAL HAZARD. Sodium hypochlorite (bleach) isa

liquid disinfectant that can be corrosive to the skin and can cause skin
depigmentation. Read the SDS, and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and powder-free gloves.

a. Perform steps 2 through 5, substituting a 10% bleach solution in place of the
deionized water.

b. Repest step 5 using deionized water to rinse the wells of the sample block(s).

c. Perform steps 6 and 7 to confirm that you have eliminated the contamination.

IMPORTANT! Use deionized water to rinse wells after they have been treated with
bleach or EtOH solution.

10. If the contamination is still present, contact technical support.

Notes
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Move the Instrument

Materials
Required

Prepare the
Instrument

Notes

148

Perform this procedure to safely move the instrument short distances (for example,
between laboratories in the same building).

Note: If you want to transport the instrument viaground or air shipping, package the
instrument for shipping as explained in “ Ship the Instrument for Service” on page 152.

Original packing plate or aMicroAmp® Optical Reaction Plate

1. Load the packing plate or empty reaction plate into the instrument:
a. Open the instrument drawer.

b. Place the packing plate or empty reaction plate onto the sample block(s).

c. Closetheinstrument drawer.

2. Raisethe sample block(s) to secure it for transport:
a. Touch the instrument touchscreen to awaken it, then touch
b. Inthe Main Menu, touch Tools M enu, touch Ship Prep, then touch Ship Prep.

c. Wait for the instrument to raise the sample block(s), then power off the
instrument when prompted.

3. Disconnect the power cord from the back of the instrument.

(55 = kvl
o[ @a:
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Move and AWARNING PHYSICAL INJURY HAZARD. Do not attempt to lift the

Reconnect the instrument or any other heavy objects unless you have received related training. Incorrect
Instrument lifting can cause painful and sometimes permanent back injury. Use proper lifting
techniques when lifting or moving the instrument. At least two people are required to lift
the instrument.

IMPORTANT! Moving your instrument can create subtle changes in the alignment of the
instrument optics. We recommend that you run a TagMan® RNase P Fast Instrument
Verification Plate after you move the instrument to confirm the performance of the
system.

1. Move your instrument according to the guidelines in step 6 on page 40.

' [ANH[e]{] Do not carry the instrument by the instrument drawer. Carrying

the instrument by the drawer can damage the instrument optics.

Yes

2. Install the components of the system according the chosen layout.

. Perform the installation
Layout Description described in...
Colocated In this layout, the instrument is connected to Chapter 3, “Install the
the colocated computer by the yellow Colocated Layout,” on
StepOne system cable. page 49
Standalone | In this layout, the instrument is not directly Chapter 4, “Install the
connected to the computer running the Standalone Layout,” on
StepOne™ software. page 75

If the RNase P experiment performed at the end of the installation:
» Passes, then you have successfully moved the instrument.
* Falils, recdibrate the instrument:
a. Perform aspatial calibration (see“Perform a Spatial Calibration” on page 118).
b. Perform abackground calibration (see “Perform a Background Calibration” on
page 122).
c. Perform adye calibration (see “Perform a Dye Calibration” on page 128).

d. Perform another RNase P experiment (see “ Perform the RNase P Experiment”
on page 65 or page 88).

Notes
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Replace the External Fuses

Notes

150

Materials
Required

Replace the
Fuses

Replace the fuses of the instrument as needed.

o Fuses, 10 A 250 VAC Slo-Blo®
e Small flatblade screwdriver

About the Fuses

The instrument usestwo 10 A 250 VAC fuses to protect the system electronics from
power surges. When replacing one fuse, we recommend that you replace the companion
fuse, regardless of its condition.

Note: Acceptable AC line voltage tolerances are 100, 120, 220, 230 £10%; 240 VAC
+6%/—10%, 50/60 Hz + 1%.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with Listed and Certified fuses of the same type and rating as those
currently in the instrument.

A P2\ [e]35] SHOCK HAZARD. To protect yourself against shock hazards, use a

properly wired three-terminal outlet. Do not use an adapter to atwo-terminal outlet since
this does not provide positive ground protection.

ADANGER ELECTRICAL SHOCK HAZARD. Severe electrical shock, which

could cause physical injury or death, can result from working on an instrument when the
high voltage power supply is operating. To avoid electrical shock, disconnect the power

supply to the instrument, unplug the power cord, and wait at least 1 min before working

on the instrument.

1. Power off the instrument.

2. Disconnect the power cord from the back of the instrument.
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3. Remove the power entry module and fuses from the power entry module:

a. Insert asmall flat-tip screwdriver into one of two slotsin the right side of the
power entry module containing the fuses, and pry open the door.

b. Insert the screwdriver into either side slot on the fuse compartment and eject
the power entry module.

c. Replace the burnt fuse(s) in the power entry module with anew 10 A fast-
acting 250 VAC fuse.

i [ | .
(T L
T (T

= =

4. Replace the power entry module:

a. Lightly sgueeze both mounted fuses between your thumb and forefinger and
insert the power entry module into the fuse compartment until it isfully seated.

b. Pressthe power entry module door until it locksin place.

i
1]
i

o
i
I

5. Connect the power cord to the back of the instrument.

6. Power on theinstrument, then wait for it to perform adiagnostic of all major system
components. If the diagnostic is successful, the instrument displays the main screen.

If the instrument detects a problem, it displays an error code for the related failed
test. Repeat the procedure above without replacing the fuses to reseat the fuse
holder. If the problem persists, contact Support as explained in “How to Obtain
Support” on page 14.

Notes
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Ship the Instrument for Service

If the instrument requires the attention of a service representative, decontaminate the
instrument and package it for transportation to Thermo Fisher Scientific.

Materials MicroAmp® Optical Reaction Plate
Required

Prepare for 1. Contact the Customer Care Center (see “How to Obtain Support” on page 14) and
Shipment request a Certificate of Decontamination.

2. Decontaminate the instrument according to the guidelines in the Certificate of
Decontamination.

3. Sign the completed Certificate of Decontamination and fax or e-mail it to the
Customer Care Center.

IMPORTANT! Do not dispose the completed Certificate of Decontamination. You
must include a copy in the package containing the instrument.

4. Raise the sample block(s) to secureit for transport:

a. Load the empty reaction plate into the instrument.

b. Touch the instrument touchscreen to awaken it, then touch
c. Inthe Main Menu, touch Tools M enu, touch Ship Prep, then touch Ship Prep.

d. Wait for the instrument to raise the sample block(s), then power off the
instrument when prompted.

5. Disconnect the power cord from the back of the instrument.

B E e )
= @ « (8
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6. Using the packaging material provided by Thermo Fisher Scientific, create a
package to ship the instrument that includes the:

+ StepOne™ or StepOnePlus™ instrument
» Caertificate of Decontamination (from step 3b on page 152)

IMPORTANT! Shipping an instrument swithout a completed Certificate of
Decontamination will delay service of the instrument.

» Payment for the servicein one of the following forms:
» Purchase order, or
» Company letterhead with the words “verbal purchase order,” or
» Visaor MasterCard credit card information
* Your address and contact information, including:
 Billing address
» Return shipping address
» Name and phone number of a contact

IMPORTANT! Do not include accessories or cordsin the package.

7. Affix the postage provided to the package.

8. Inform the courier to arrange pickup, then ship the package to the location specified
by the Customer Care Center.

Install the When you receive the serviced instrument, install it as you would a new instrument by
Serviced completing Chapters 1 through 5 of this guide.
Instrument

Notes
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Update the StepOne™ Software or the Operating System

Visit the For the latest services and support information for the StepOne™ and StepOnePlus™
StepOne™ and  systems, go to:

StepOnePlus™ info.appliedbiosystems.com/stepone
System Website app ad ' P
The website contains the latest software and documentation updates for the instrument

and analysis software.
At the system support page, you can:

» Submit a question directly to Technical Support

» Order user documents, SDSs, certificates of analysis, and other related documents
» Download documents in Adobe portable document format (PDF)

 Obtain information about customer training

» Download software updates and patches for the instrument

Update the Prepare for the Update
StepOne™

Software If you want to update the StepOne™ Software, prepare your computer by exporting the

application libraries and backing up your experiment files.

1. Back up the application libraries:
a. Inthe main menu of the StepOne™ software, select Tools » <desired library>.

b. When thelibrary dialog box opens, select the element(s) that you want to
export, then click Export.

c. Inthe Export dialog box, click Save to archive the selected records.

d. Repeat steps 1 through 3 for the remaining libraries to archive them.
2. Back up all experiment files by creating a copy of the directory that you are using to
storefiles.
The default directory for StepOne or StepOnePlus™ experimentsis:
D:\Applied Biosystems\<software name>\experiments
where < software name> is the current version of the StepOne software.
3. Back up the instrument data:

a. Connect aUSB driveto the USB port.

Notes
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b. Touch the instrument touchscreen to awaken it, then touch

c. Inthe Main Menu, touch Settings M enu, then touch Admin Menu,
touch Admin Menu, then touch Back Up Experimentsand Settings.

d. Touch Back Up, then wait for the instrument to transfer the data.

e. When thetransfer is complete, touch Done, then remove the USB drive.

Check for Updates

1. Goto:
http://info.appliedbiosystems.com/stepone
to open the StepOne and StepOnePlus system product page.

2. Under Software Download, view the available downloads.

3. If there are updates and/or patches for v2.1 or later, select the appropriate option,
then follow the prompts to begin the download.

You may be asked for your instrument serial number. The serial number is on the
back panel of your instrument, or can be obtained from the instrument touchscreen.

Determine the Do not upgrade or update the Microsoft Windows® operating system of the computer that
Compatibility of  runsthe StepOne™ software without first consulting the software release notes or the
an Operating  Thermo Fisher Scientific website. Future versions of the Windows® operating system
System Upgrade and updates to the current operating system may conflict with the StepOne™ software
or Update and render the software inoperable.

1. From the desktop, browse to and open:
<drive>:\Applied Biosystems\<software name>
where:

— <drive> isthe computer hard drive on which the StepOne software is installed.
The default installation drive for the softwareisthe D drive.

— <software name> isthe current version of the StepOne software.

2. Double-click release-notes.html, then read the SepOne™ Software Release Notes
for the compatibility of interest.

3. If the release notes do not mention the compatibility:

a. Goto:
info.appliedbiosystems.com/stepone

b. Search the system website for the compatibility of interest.

4. |f the website does not contain the information of interest, contact Support for the
information (see “How to Obtain Support” on page 14).

Notes
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A

How to Troubleshoot the Installation

This appendix covers:

B StepOne™ Software Problems. . ... . 160
B Network Connection Problems. . .......... ... .. i 161
B Background Calibration Failure. ... ... ... ... .. 164
B DyeCadlibrationFailure ........ ... . 166

Note: For more information about any of the topics discussed in this guide, access the
Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software
by pressing F1, or clicking @ in the toolbar, or selecting Help » StepOne Software
Help.

Notes
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StepOne™ Software Problems

If you encounter errors during the installation of the StepOne™ software, uninstall the
software before reinstalling it.

Uninstall the 1. Log onto the operating system as Administrator, or as amember of the
StepOne™ Administrators user group.
Software

IMPORTANT! If you are installing the StepOne™ software, you must log onto the
Windows® operating system using a user account that belongs to the Administrators
user group.

2. Remove the StepOne™ software:
a. Inthedesktop, select Sart » Control Panel » Add/Remove Programs.

b. Inthe Add/Remove Programs dialog box, select SepOne™ software, then
click Change/Remove.

c. Inthe Welcome page of the InstallShield Wizard dialog box, select Remove.
d. Inthe Confirm Uninstall dialog box, click OK.

e. When the uninstallation is complete, then click Finish.

f. Close the Add/Remove Programs dialog box.

3. Restart the computer and log in as Administrator, or as a member of the
Administrators user group.

4. Reinstall the StepOne™ software.

If the StepOne™ software installation continues to fail, reimage the computer and
repeat the installation.

Notes
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Network Connection Problems

Use this topic to resolve problems when setting up the instrument for remote monitoring.

Troubleshootin
g @ StepOne™ software cannot add instrument for

Workflow remote monitoring
: Connect the Ethernet
(I:s:);hneegz’gli??g cable for the network ol LAvport
—»| connection to the blue
network by the blue No LAN Port at rear of the
LAN Port? . |
instrument.
\|/Yes
Determine the IP address and network
settings of the instrument LAN port as
explained in step 1 on page 162.
A Confirm with your network administrator
Is the LAN Port of the that the static IP address, subnet mask,
instrument set up for ————— and default gateway settings are correct.
static IP or DHCP? Static IP | Correct the network settings as directed
by your network administrator.
[ DHCP

Determine the subnet address as
explained in “How to Determine the Subnet
Address” on page 163.

L

Are the instrument and
computer located on SN
the same subnet? No

\|{es

Confirm the network connection by
pinging the instrument as explained in
“How to Ping the Instrument” on page 162.

N

Add and monitor the instrument using the
IP address of the LAN Port.

thg;r]sg'a%;%itng;m Consult your network administrator to
~— | determine the source of the failed
a computer on the No network connection.
network?
Can you add or monitor When you add the instrument for remote
the instrument using the |™~————— monitoring, enter the instrument name
StepOne ™ software? No using lower case letters only.

I
If you cannot use the instrument name to
add the instrument for remote monitoring,
try using the IP address of the instrument.

|
Unplug the instrument from the network,
then ping the IP address. If you can ping
the address after removing the instrument
from the network, then another device is
using the same IP address and you must
reassign it to resolve the conflict.

Contact Support as explained
in “How to Obtain Support” on <«——
page 14.

Notes
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How to Ping the You can confirm the connection between a network computer and instrument by pinging the
Instrument  instrument name or IP address from the computer. The ping command issued from the DOS
command shell causes the computer to send a series of 32-byte data packets to the instrument.
If the network connection between the computer and the instrument is unobstructed, the
instrument sends data packetsin reply.
1. Determinethe IP address of the instrument:
a. Touch the instrument touchscreen to awaken it, then touch
b. Inthe Main Menu, touch Settings Menu » Admin Menu » Set |P Address.

c. RecordthelP addressin the IP Addressfield.

5
( @ IP Settings

| Assign IP address dynamically (using DHCF) v | st
IP Address: Il:l’d.lmuou.o-w
Subnet Mask: IEDD 233 255,000

Default Gateway: |1:|z.lss.uouml

Done |

Choose how the IP address Is assigned. For static [P
addresses. enter the required information from your
system administrator. When you are finished, touch Done.

2. Ping theinstrument:
a. Power on the instrument and wait for the instrument to boot.

b. Inthe computer desktop, select Sart » Programs » Accessories »
Command Prompt.

¢. Inthe Command Prompt window, enter pi ng <I P addr ess>, then

press Enter.
If the DOS prompt... Then...
replies to the pings the computer can communicate with the IP address.
displays “request Wait a few minutes for the network to update the IP address of
timed out” the instrument, then ping the instrument again.
If you still cannot ping the instrument after two attempts,
consult your network administrator to determine the source of
the failed network connection.
Notes
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Resolving an IP Address Conflict

If you suspect that the | P address used by either port of the instrument may conflict with
another device on your network, you can use the following procedure to test for the
conflict.

1. Unplug the instrument from the network.

2. Pingthe IP address of the instrument LAN port as explained above.

If you can ping the I P address, then another device on the network is already using
the address and you must reassign the I P address of the instrument to resolve the
conflict.

How to 1. Touch the instrument touchscreen to awaken it, then touch
Determine the 2. Inthe Main Menu, touch SettingsMenu » Admin Menu » Set | P Address.

Subnet Address
3. Record the IP addressin the IP Address field. The first three numbers of the IP
address are the subnet address.

For example, the italicized numbers in the following IP address are the subnet
address:

192.168.100.140

If the subnet address for the instrument is different than that of the computer used for
remote monitoring, then you cannot use the instrument name to add the instrument for
remote monitoring. The mDNS limitation explained in “Networking Guidelines and Best
Practices’ on page 105 restricts the use of the instrument name as an identifier to
network devices on the same subnet.

Note: To determine the subnet address of the computer that you want to use to monitor
the instrument, select Sart » Help and Support in the computer desktop, then use the
Microsoft Windows Help System search for the procedure appropriate for the operating
system.

Notes
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Background Calibration Failure

Use this topic to troubleshoot failed background calibrations.

Troubleshooting Start
Workflow P
Does the instrument Repeat the calibration. If the problem persists,
complete the —— contact Support as explained in “How to Obtain
background run? No  Support” on page 14.

Yes
One or more wells 1. Repeat the calibration using the
e backgroune, |, e baskaround lte.
calibration pass? No | ‘spectra that exceed 2. If the calibration fails again,

repeat the calibration using a

the maximum limit different background plate.

for the instrument.

3. If the calibration fails again,
determine the source of the
contamination as explained in
“Identify the Source and Location
of Contamination” below.

Identify the Signalsthat exceed the limit of normal background fluorescence may indicate the

Source and  presence of fluorescent contamination on the calibration plate or the sample block(s).

Location of Common contaminants include: ink residue from permanent pens, powder from
Contamination disposable gloves, and dust.

To determine the source and location of the contamination:

1. Whileviewing the raw spectra, locate the contaminated well position(s) by selecting
successively smaller regions of the plate layout.

2. Rotate the background plate 180°, then perform the background calibration again.

3. Repeat step 1 to locate the contamination. If the position(s) of the contamination in
steps 1 and 3 are:

 ldentical — The sample block(s) are contaminated. Decontaminate the sample
block(s) as explained on page 145.

» Reversed — The background plate is contaminated. Discard the background
plate and perform the background run using a new background plate.

If the calibration fails after you have replaced the background plate and decontaminated
the sample block(s), perform the following test:

1. Load aplate covered by a piece of black paper into the instrument.

2. Perform the background run as explained in “ Perform a Background Calibration” on
page 122.

3. After theruniscomplete, select all wells of the plate layout.

Notes
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4. View the Spectral plot for the peak(s). If the peak is:

» Visible—Theoptics of your instrument may be contaminated. Contact Support
as explained in “How to Obtain Support” on page 14.

* Absent — The sample block(s) are contaminated. Decontaminate the sample
block(s) as explained in “Decontaminate the Sample Block(s)” on page 145.

A

Notes
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Dye Calibration Failure

Use this topic to troubleshoot failed dye calibrations.

Troubleshooting Start

Workflow
)\ Reattempt the calibration. If the

Does the instrument :
complete the dve problem persists, contact Support
b y No . as explained in “How to Obtain

ibration?
calibration? Support” on page 14.
Yes
Orr;%l?gggjosre ;’:’;rl: Review the spectra for
Does the b P : irregularities as explained in
calibration pass? No | Beyond the detectable ——» «Analyze the Calibration Data”
o range for the system, or on page 135.
Yes ¢ In more than one filters
If the peaks of one or more spectra appear in the wrong
Do the dye spectra filter, confirm that:

peak in the correct » ¢ The spectral calibration plate was run in the correct
filters? No orientation (the plate was not rotated 180° when run).

e The correct dyes were loaded onto the spectral
calibration plate, if you are running a custom plate.

Notes
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Common Thefollowing table displaysirregular spectracommon to dye calibrations.

Irregularities

Spectra

One or more raw spectra are
at or below the detectable
threshold for the calibration.

Possible Cause

e The spectral calibration plate has
been centrifuged insufficiently.

e The spectral calibration plate

contains old or insufficient reagents.

¢ If you are running a custom spectral
calibration plate, the dye may not
be present at a sufficient
concentration.

Action

1. Unload the instrument and view the wells of the
spectral calibration plate. If the liquid in the wells
are not:

— At the bottom of the wells, centrifuge the plate
for a longer time, then repeat the calibration.

- Equivalent in volume, the plate is not sealed
and the reagents have evaporated. Discard it
and run another.

2. If the spectral calibration plate appears to be
normal, discard the plate and run another.

3. If the problem persists, contact Support as
explained in “How to Obtain Support” on page 14.

Note: If you are running a custom spectral
calibration plate, create another plate but increase
the concentration of the dye that produced
insufficient signal.

One or more raw spectra
exceed the maximum limit for
the instrument.

e Fluorescent contamination is
present on the sample block(s) or
spectral calibration plate.

¢ [f you are running a custom spectral
calibration plate, the dye may be
too concentrated.

The spectra contain peaks in
more than one filter.

Fluorescent contamination is present
on the sample block(s) or spectral
calibration plate.

Confirm that the presence of contamination by
performing a background calibration as explained
in “Perform a Background Calibration” on

page 122. If the background calibration does not
show sample block contamination, the spectral
calibration plate may be contaminated.

Note: If you are running a custom spectral
calibration plate, create another plate but decrease
the concentration of the dye that exceeds the
detectable limit.

Notes
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Advanced Setup

AlIF
allele

allelic discrimina-
tion plot

amplicon

amplification

amplification
efficiency (EFF%)

amplification plot

Glossary

In the StepOne™ software, a feature that allows you to set up your experiment according
to your experiment design. Advanced Setup providesyou with maximum flexibility inthe
design and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The alelic discrimination plot isa
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
guantitation experiments, fluorescence data collected during amplification are displayed
in an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope closeto
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:
« Range of standard quantities— To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 106 fold).
¢ Number of standard replicates— To increase the precision of the standard
quantities and decrease the effects of pipetting inaccuracies, include replicates.
* PCR inhibitors—PCR inhibitorsin the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed
as.

» Baseline-corrected normalized reporter (ARN) vs. cycle
* Normalized reporter (Rn) vs. cycle
» Threshold cycle (Cy) vs. well
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amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

baseline
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Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage
are displayed in an amplification plot, and the data are used to calculate results. For
genotyping or presence/absence experiments, fluorescence data collected during the
amplification stage are displayed in an amplification plot, and the data can be used for
troubleshooting. See aso cycling stage.

In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primersto
amplify atarget and a reagent to detect the amplified target.

| dentifier assigned by Thermo Fisher Scientific to TagMan® Gene Expression Assaysand
TagMan® SNP Genotyping Assays.

Datafile on aCD shipped with each assay order. The file name includes the number from
the barcode on the plate. Theinformation in the AlF is provided in atab-delimited format.

PCR reaction component in Thermo Fisher Scientific TagMan® Gene Expression Assays
and TagMan® SNP Genotyping Assays. The assay mix contains primers designed to
amplify atarget and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for astep
with each subsequent cyclein acycling stage. When AutoDeltais enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

* AutoDeltaon: &
* AutoDelta off: &

An analysis setting in which the software calcul ates the baseline start and end values for
the amplification plot. You can apply the automatic baseline setting to specific wellsin
the reaction plate. See also basdline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (C;). See aso threshold cycle (CT).

In the amplification plot, aline fit to the fluorescence levels during the initial stages of
PCR, when there islittle change in fluorescence signal.
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baseline-corrected
normalized reporter
(ARnN)

biological replicate

blocked IPC

calibrator
chemistry

colocated layout

Glossary

The magnitude of normalized fluorescence signal generated by the reporter:

1. Inexperiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs. Cycle amplification plot, ARn is calculated at each
cycleas:

ARnN (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the differencein
normalized fluorescence signal generated by the reporter between the pre-PCR read
and the post-PCR read. In the allelic discrimination plot (genotyping experiments)
and the presence/absence plot (presence/absence experiments), ARn is calcul ated
as.

ARN = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See a'so normalized reporter (Rn).

Reactionsthat contain identical components and volumes, but eval uate separate samples
of the same biological source (for example, samplesfrom three different mice of the same
strain, or separate extractions of the same cell line or tissue sample).

When using biological replicate groups in a comparative C; study, the values displayed
in the Biological Replicatestab are calculated by combining the results of the separate
biological samples and treating this collection as a single population (that is, as one
sample). For AC; computations (normalizing by the endogenous control) in asingleplex
experiment, the separate biological samples aretreated as unpaired datawhen computing
variability estimates of the single biological replicate. You can observe individual
contributions of the separate biological samples to the single biological replicate results
in the Technical Replicates tab.

Note: To view the Biological Replicates and Technical Replicates tabs, from the Study
Menu pane, select Analysis » Gene Expression.

In presence/absence experiments, areaction that contains IPC blocking agent, which
blocks amplification of theinternal positive control (IPC). In the StepOne™ software, the
task for the IPC target in wells that contain I PC blocking agent. See al so negative control -
blocked IPC wells.

See reference sample.

See reagents.

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly
connected to acolocated computer by the yellow cable. In thislayout, you can control the

instrument with the StepOne™ software on the col ocated computer or with the instrument
touchscreen.
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comparative C;
(AAC;) method

Cr

custom dye

cycle threshold

cycling stage

data collection

delta Rn (ARnN)

derivative reporter
(-Rn’)
Design Wizard

diluent

Diluted Sample
Concentration
(10X for Reaction
Mix)
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Method for determining relative target quantity in samples. With the comparative C;
(AAC;) method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples and in a reference sample. Measurements are normalized
using the endogenous control. The software determines the relative quantity of target in
each sample by comparing normalized target quantity in each sampleto normalized target
quantity in the reference sample.

See threshold cycle (CT).

Dyethat is not supplied by Thermo Fisher Scientific. Custom dyes may be adapted for
use in experiments on the StepOne™ and StepOnePlus™ systems. When using custom
dyes, the custom dye should be added to the Dye Library and a custom dye calibration
performed.

IMPORTANT! We do not recommend the use of TAMRA™ dye as reporter or quencher
with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the
StepOnePlus™ system.

See threshold cycle (CT).

In the thermal profile, a stage that is repeated. A cycling stage isalso called an
amplification stage. For cycling stages, you can enable AutoDelta settings. See also
amplification stage.

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the
signal to electronic data, and the data are saved in the experiment file. In the StepOne™
software, a data collection point isindicated by an icon in the thermal profile:

» Datacollection on:

» Data collection off:
See baseline-corrected normalized reporter (DRn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (-Rn") vs. temperature melt curve,
the derivative reporter signal is displayed in the y-axis.

A featurein the StepOne™ software that helps you set up your experiment by guiding you
through best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the StepOne™ software, afield displayed on the Sample Dilution Calculations tab of
the Reaction Setup screen. For thisfield, enter the sample concentration you want to use
to add to the reaction mix for all samplesin the experiment. “10X for Reaction Mix”
indicates that the software assumes the sample or standard component of the reaction mix
isat a10X concentration. For example, if the diluted sample concentration is50.0 ng/uL
(10X), the final sample concentration in the reaction is 5 ng/uL (1X).
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dilution factor
dissociation curve
EFF%

endogenous
control

endpoint read

experiment

experiment name

Glossary

See serial factor.
See melt curve.
See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levelsin all samplesyou are testing.
Endogenous controls are used in relative standard curve and comparative C; (AAC;)
experiments to normalize fluorescence signals for the target you are quantifying.
Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

When using multiple endogenous controls, the software treats all endogenous controls as
asingle population, and cal culates the experiment-appropriate mean to establish asingle
value against which the target of interest is normalized. In comparative C; experiments,
the mean calculated is the arithmetic mean of the C; values. In relative standard curve
experiments, the C; values are converted to relative quantities prior to normalization; the
mean calculated is subsequently the geometric mean of the relative quantities.

Note: Arithmetic and geometric means are related and equivalent due to logarithmic
transformation of the data.

Variability estimates for multiple endogenous controls are computed separately. Thefinal
variability estimate is a pooled combination of the individual variability estimates
(similar to computing pooled standard deviations).

See post-PCR read.

Refers to the entire process of performing arun using the StepOne™ or StepOnePlus™
systems, including setup, run, and analysis. The types of experiments you can perform
using the StepOne™ and StepOnePlus™ systems:

* Quantitation - standard curve

e Quantitation - relative standard curve

* Quantitation - comparative C; (AACy)

* Médt curve

» Genotyping

* Presence/absence

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters. forward slash (/), backslash (\), greater than sign (>), less than sign (<),
asterisk (*), question mark (?), quotation mark ("), vertical line (]), colon (2),

semicolon (;), and sign (&), percent sign (%), dollar sign ($), at sign (@), circumflex (*),
left parenthesis ( (), right parenthesis () ), or exclamation point (!).

IMPORTANT! If you run the instrument in standalone mode from the instrument
touchscreen, you cannot enter more than 32 charactersin the Experiment Name field and
you cannot include spaces in the name.
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Glossary

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent
IPC+
made-to-order

assays

manual baseline

manual Cy
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Thetype of experiment you are performing using the StepOne™ or StepOnePlus™ system:

e Standard curve
» Comparéative C; (AAC;)
* Relative standard curve
« Maélt curve (not available in the Design Wizard)
« Genotyping
* Presence/absence
The experiment type you select affects the setup, run, and anaysis.

Oligonucleatide that flanks the 5" end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

Inthethermal profile, astagethat includes one or more steps. You can add aholding stage
to the thermal profileto activate enzymes, to inactivate enzymes, or to incubate areaction.

A genethat isinvolved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the
target is absent in the samples) and negative results caused by PCR inhibitors, incorrect
assay setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assaysthat have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (1PC). In the
StepOne™ software, the task for the IPC target in wells that contain the IPC and do not
contain |PC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).

See negative control-IPC wells.

TagMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control
specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the
amplification plot. You can apply the manual baseline setting to specific wellsin the
reaction plate.

An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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melt curve

melt curve stage
melting
temperature (Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control
(NTC)

nonfluorescent
quencher-minor

groove binder
(NFQ-MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems

Glossary

A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate
the melting temperature (Tm) of thetarget or canidentify nonspecific PCR amplification.
In the StepOne™ software, you can view the melt curve as normalized reporter (Rn) vs.
temperature or as derivative reporter (—Rn") vs. temperature. Also called dissociation
curve.

In the thermal profile, a stage with atemperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA isdissociated into single-stranded DNA. The Tmisdisplayedinthe
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the StepOne™ software, the task for targets or SNP assays in wells that contain water
or buffer instead of sample. No amplification of the target should occur in negative control
wells. Previously called no template control (NTC).

In presence/absence experiments, wellsthat contain | PC blocking agent instead of sample
inthe PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked.
Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain |PC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-1PC wells
because the reaction contains no sample. Previously called |PC+.

See negative control-blocked 1PC wells.

See negative control (NC).

Molecules that are attached to the 3’ end of TagMan® probes. When the probe isintact,
the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence
signal. Because the NFQ does not fluoresce, it produces lower background signals,
resulting in improved precision in quantitation. The minor groove binder (MGB)
increases the melting temperature (Tm) without increasing probelength. It also allowsthe
design of shorter probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.

175
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Glossary

passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix
primer/probe mix
pure dye
quantitation

method

quantity

176

A dye that produces fluorescence signal. Because the passive reference signal should be
consistent across al wells, it is used to normalize the reporter dye signal to account for
non-PCR related fluorescence fluctuations caused by minor well-to-well differencesin
concentrations or volume. Normalization to the passive reference signal alows for high
data precision.

Anillustration of thegrid of wells and assigned content in the reaction plate. In StepOne™
systems, the grid contains 6 rows and 8 columns. In StepOnePlus™ systems, the grid
contains 8 rows and 12 columns.

In the StepOne™ software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be printed,
included in areport, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard
curve is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain
a sample with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the dlelic discrimination plot and used to make alele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also
called endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.

PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation
methods: standard curve, relative standard curve, and comparative C; (AACy).

In quantitation experiments, the amount of target in the samples. Absolute quantity can
refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-

difference between normalized quantity of target in the sample and normalized quantity
of target in the reference sample.
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quencher

QuickStart

R2 value

ramp

ramp speed

raw data plot

reaction mix

reagents

real-time PCR

Glossary

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from
emitting fluorescence signal while the probeisintact. With TagMan® reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher.
With SYBR® Green reagents, no quencher is used.

IMPORTANT! We do not recommend the use of TAMRA™ dye as reporter or quencher
with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the
StepOnePlus™ system.

A feature in StepOne™ and StepOnePlus™ systems that allows you to run an experiment
without entering plate setup information. QuickStart requires a col ocated layout with the
instrument powered on and an intact instrument-computer connection.

Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C; data points from the standard reactions. A value of 1.00 indicates a perfect
fit between the regression line and the data points.

The rate at which the temperature changes during the instrument run. Except for the melt
curve step, the ramp is defined as a percentage. For the melt curve step, theramp is
defined as atemperature increment. In the graphical view of the thermal profile, theramp
isindicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available ramp
speedsinclude fast and standard.

» For optimal results using the fast ramp speed, we recommend using fast reagentsin
your PCR reactions.

» For optimal results using the standard ramp speed, we recommend using standard
reagentsin your PCR reactions.

IMPORTANT! Fast reagents are not supported for presence/absence experiments.

A plot of raw fluorescence signal (not normalized) for each optical filter.

A solution that contains all components to run the PCR reaction, except for the template
(sample, standard, or contral).

The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the StepOne™ and StepOnePlus™ systems:

» TagMan® reagents
+ SYBR® Green reagents
« Other reagents

Processof collecting fluorescence dataduring PCR. Datafrom thereal-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping
or presence/absence experiments.
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reference sample

refSNP ID

regression
coefficients

regression line

reject well

relative standard
curve method

Remote Monitor

replicate group

replicates

reporter

reverse primer
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In relative standard curve and comparative C; (AAC;) experiments, the sample used as
the basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (ref SNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the
Thermo Fisher Scientific Store for an Thermo Fisher Scientific SNP Genotyping Assay.
Also called an rs number.

Values calculated from the regression line in standard curves, including the R? value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m{log (Qty)] +b
where misthe slope, b isthe y-intercept, and Qty is the standard quantity.

See al so regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard
curve method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples, in areference sample, and in a standard dilution series.
M easurements are normalized using the endogenous control. Data from the standard
dilution series are used to generate the standard curve. Using the standard curve, the
software interpol ates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

A feature in the StepOne™ software that allows you to monitor a StepOne™ or
StepOnePlus™ instrument over the network. With the Remote Monitor, you can monitor
the instrument status, send an experiment to the instrument, monitor amplification plots
and temperature plotsin real time, and download the resultsto your computer. You cannot
operate the StepOne™ or StepOnePlus™ instrument using the Remote Monitor.

A set of identical reactionsin an experiment.

Total number of identical reactions containing identical components and identical
volumes.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dyeisattached tothe5’ end. If you are using SY BR® Green reagents, the reporter
dyeis SYBR® Green dye.

An oligonuclectide that flanks the 3" end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.
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reverse
transcriptase

Rn

ROX™ dye

rs number

run method

sample

Sample DNA (10X)

Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target
reaction

serial factor

Glossary

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR
reaction to perform 1-step RT-PCR.

See normalized reporter (Rn).

A dye supplied by Thermo Fisher Scientific and precalibrated on the StepOne™ and
StepOnePlus™ systems. ROX dye is used as the passive reference.

SeerefSNPID.

Definition of the reaction volume and the thermal profile for the StepOne™ or
StepOnePlus™ instrument run.

The template that you are testing.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is
added to the reaction mix at a 10X concentration. For example, if the reaction volumeis
20 pL, the calculated volume of samplefor 1 reactionis2 uL.

In the StepOne™ software, a collection of samples. The Sample Library contains the
sample name and the sample color.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample or
standard is added to the reaction mix at a 10X concentration. For example, if the reaction
volumeis 20 uL, the calculated volume of sample or standard for 1 reactionis2 pL.

In genotyping experiments, the combination of which sampleto test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one

SNP assay.

In quantitation experiments, the combination of which sample to test and which target to
detect and quantify in one PCR reaction. In the Design Wizard, you can detect and
quantify only onetarget in one PCR reaction. Use Advanced Setup to detect and quantify
more than one target in one PCR reaction.

Inthe StepOne™ software, anumerical value that defines the sequence of quantitiesin the
standard curve. The seria factor and the starting quantity are used to calculate the
standard quantity for each point in the standard curve. For example, if the standard curve
isdefined with aserial factor of 1:10 or 10X, the difference between any 2 adjacent points
in the curve is 10-fold.

series See standard dilution series.

slope Regression coefficient calculated from theregression linein the standard curve. The slope
indicatesthe PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See aso amplification efficiency (EFF%) and regression line.

SNP Abbreviation for single nucleotide polymorphism. The SNP can consist of a base
difference or an insertion or deletion of one base.
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SNP assay

SNP Assay Library

spatial calibration

stage

standalone layout

standard

standard curve

standard curve
method

standard dilution
series
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Used in genotyping experiments, a PCR reaction that contains primersto amplify the SNP
and two probes to detect different alleles.

In the StepOne™ software, a collection of SNP assays to add to genotyping experiments.
The SNP assaysin thelibrary contain the SNP assay name, SNP assay color, and for each
alele, the allele name or base(s), reporter, quencher, and alele colors. The SNP assaysin
the library may also contain the assay ID and comments about the SNP assay.

Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the
positions of the wells in the sample block(s). Spatial calibration data are used so that the
software can associate increases in fluorescence during a run with specific wellsin the
reaction plate.

In the thermal profile, a group of one or more steps. There are three types of stages:
holding stage (including pre-PCR read and post-PCR read), cycling stage (also called
amplification stage), and melt curve stage.

A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to
acomputer by the yellow cable. In thislayout, you control the instrument only with the
instrument touchscreen, and you use a USB drive or network connection to transfer data
between the instrument and computer.

Sample that contains known standard quantities. Standard reactions are used in
quantitation experiments to generate standard curves. See also standard curve and
standard dilution series.

In standard curve and relative standard curve experiments:

* Thebest-fit linein aplot of the C; values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing arange of known quantities. Results from the
standard curve reactions are used to generate the standard curve. The standard curve
is defined by the number of pointsin the dilution series, the number of standard
replicates, the starting quantity, and the serial factor. See also standard dilution
series.

Method for determining absolute target quantity in samples. With the standard curve
method, the StepOne™ software measures amplification of the target in samplesand in a
standard dilution series. Data from the standard dilution series are used to generate the
standard curve. Using the standard curve, the software interpol ates the absol ute quantity
of target in the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution seriesis prepared by serialy diluting
standards. For example, the standard stock is used to prepare the first dilution point, the
first dilution point is used to prepare the second dilution point, and so on. In the StepOne™
software, the volumes needed to prepare a standard dilution series are calculated by the
number of dilution points, the number of standard replicates, the starting quantity, the
serial factor, and the standard concentration in the stock. See also standard curve.
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standard quantity

starting quantity

step

study name

SYBR® Green
reagents

Glossary

A known quantity in the PCR reaction.

« In standard curve experiments, the quantity of target in the standard. In the
StepOne™ software, the units for standard quantity can be for mass, copy number,
viral load, or other units for measuring the quantity of target.

« Inrelative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining astandard curve in the StepOne™ software, corresponds to the highest or
lowest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™
systems, which contain the VeriFlex™ blocks, each step contains 6 temperatures (1 for
each VeriFlex block).

Entered during study setup, the name that is used to identify the study. Study names
cannot exceed 100 characters and cannot include any of the following characters: forward
dlash (/), backslash (\), greater than sign (>), lessthan sign (<), asterisk (*), question mark
(?), quotation mark ("), vertical line(|), colon (:), semicolon (;), and sign (&), percent sign
(%), dollar sign ($), at sign (@), circumflex ("), left parenthesis ( (),

right parenthesis () ), or exclamation point (!).

PCR reaction components that consist of two primers designed to amplify the target and
SYBR® Green dye to detect double-stranded DNA.
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Glossary

system dye

TagMan® reagents

target

target color

Target Library

task

182

Dye supplied by Thermo Fisher Scientific and precalibrated on the StepOne™ or
StepOnePlus™ system. Before you use system dyes in your experiments, make sure the
system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne™ system:
« FAM™ dye
« JOE™ dye
+ ROX™ dye
+ SYBR® Green dye
« VIC®dye
System dyes on the StepOnePlus™ system:
- FAM™ dye
« JOE™ dye
« NED™ dye
+ ROX™ dye
+ SYBR® Greendye
« TAMRA™ dye
« VIC® dye

IMPORTANT! We do not recommend the use of TAMRA™ dye as reporter or quencher
with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the
StepOnePlus™ system.

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the StepOne™ software, a color assigned to a target to identify the target in the plate
layout and analysis plots.

In the StepOne™ software, a collection of targets to add to experiments. Thetargetsin the
library contain the target name, reporter, quencher, and target color. The target in the
library may also contain comments about the target.

In the StepOne™ software, the type of reaction performed in thewell for the target or SNP
assay. Available tasks:

¢ Unknown

» Negative Control

» Standard (standard curve and relative standard curve experiments)

 Positive control (genotyping experiments)

 |PC (presence/absence experiments)

» Blocked IPC (presence/absence experiments)
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technical replicate

temperature plot

template

thermal profile

threshold

threshold cycle (Cy)

Tm
touchscreen

unknown

unknown-IPC wells

Glossary

Reactions that contain identical components and volumes, and that evaluate the same
sample.

Inthe StepOne™ software, adisplay of temperaturesfor the sample, instrument cover, and
instrument block during the StepOne™ or StepOnePlus™ instrument run.

In the Design Wizard of the StepOne™ software (and in QuickStart for quantitation
experiments), the type of nucleic acid to add to the PCR reaction. The recommended
template varies according to experiment type:

* Quantitation experiments (standard curve, relative standard curve, and comparative
C;) —cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materialslist.

« Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
* Presence/absence experiments - DNA

For presence/absence experiments, we recommend adding DNA templates to the
PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

1. Inamplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic CT) or can be set manually (see manual CT).

2. In presence/absence experiments, the level of fluorescence above which the
StepOne™ software assigns a presence call.

The PCR cycle number at which the fluorescence meetsthe threshold in the amplification
plot.

See melting temperature (Tm).
Instrument display that you touch to control the StepOne™ or StepOnePlus™ instrumen.

In the StepOne™ software, the task for the target or SNP assay in wells that contain the
sample you are testing:

 |n quantitation experiments, the task for the target in wells that contain a sample
with unknown target quantities.

 |n genotyping experiments, the task for the SNP assay in wells that contain a
sample with an unknown genotype.

* In presence/absence experiments, the task for the target in wells that contain a
sample in which the presence of the target is not known.

In presence/absence experiments, wellsthat contain asample and internal positive control
(IPC).
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Glossary

VeriFlex™ The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex™

Technology blocks, creating up to six different zones for the 96 sample wells. After you enable the
VeriFlex blocksin the StepOne™ software, you can set a different temperature for one or
more of the VeriFlex blocks.

y-intercept In the standard curve, the value of y where the regression line crosses the y-axis. The y-
intercept indicates the expected threshold cycle (C;) for asample with quantity equal to 1.

zone One of up to six sample temperatures among the 96 wells formed by independently
thermally regulated VeriFlex™ blocks during the StepOnePlus™ instrument run. You can
set adifferent temperature for one or more of the VeriFlex blocks, or you can set the same
temperature for each of the VeriFlex blocks.

Note: For melt curve steps, you need to set the same temperature for each of the
VeriFlex blocks.

zone boundary The edge of azone for samples formed by the six independently thermally regulated
VeriFlex™ blocks. In the StepOne™ software, the zone boundaries are displayed in the
plate layout as thick red lines.
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A

advanced setup 169
AlF. See assay information file.
alele 169
alelic discrimination plot 169
amplicon 169
amplification 169
plot 169
stage 170
amplification efficiency (EFF%) 169
analyze
background calibration 126
dye calibration 135-138
RNase P experiment 70—72, 96—98
spatial calibration 121
antivirus software 32, 74, 99
APIPA. See Automatic Private |P Addressing.
Applied Biosystems
contacting 14
Technical Support 14
temperature verification service 117
Applied Biosystems StepOne and StepOnePlus Real -
Time PCR System. Seeinstrument or system.
archiving files 142

assay 170
ID 170

mix 170
assay information file (AIF) 170
AutoDelta 170
automatic baseline 170
automatic C; 170
Automatic Private |P Addressing compatibility 106

B

back up experiments 142

background calibration 122—127
analyzethedata 126
guidelines 122
perform 124
prepare 123—124
purpose 122

background component, about 122

background plate
about 122
create 127
number of reuses 123

Index

backup storage devices 31

baseline 170

baseline-corrected normalized reporter (ARn) 171
biohazardous waste, handling 21

bleach solution, usage 145

blocked IPC 171

bold text, use of 12

C

calibration
background 122—127
dye (custom) 139-141
dye (system) 128—137
schedule 116
spatial 118—121
calibrator 171
CAUTION, description 15
chemical
safety 19
waste safety 21
chemistry 171
chemistry installation kit 42
clearance requirement, instrument 39
colocated layout 33, 171
connect system components 61—63
connect to anetwork 102
example network layout 103
install computer 52—59
installation 50—74
installation workflow 50
perform RNase P experiment 65—73
whentoinstall 50
comparative C; (AAC;) method 172
computer
connect to instrument 61
default user name and password 55, 80
monitor instrument 110
name, define 58, 83
placement 53, 79
prepare operating system 56-58, 8183
remote monitoring set up 108
requirements 30
site preparation 53, 79
Computer Port
about 104
connect the computer and instrument 54
connect, instrument to computer 61
contamination, removal 145-147
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Index

conventions

bold text 12

for describing menu commands 12

IMPORTANTS! 12

inthisguide 12

italictext 12

Notes 12

safety 15

user attention words 12
create

background plate 127

custom dye plate 139-141
C;. Seethreshold cycle.
custom dye

about 172

calibration 139-141

plate, how to create 139-141
cyclethreshold 172

cycling stage 172

D

DANGER, description 15
data
about collection 27, 172
backup/storage devices 31
date and time settings
define for the instrument 45
define for the software 57, 82
deltaRn (ARn) 172
derivative reporter (- Rn") 172
Design Wizard 172
diluent 172
diluted sample concentration 172
dilution factor 173
dimensions
computer 53, 79
instrument 39
disable 'Local Area Connection' messages 63
disk space, checking 142
dissociation curve 173
documentation
obtain 14
related 13
shipped with the system 43
dye calibration 128—137
analyzing data 135
analyzing the data 135—138
perform 134—135
prepare 132—133
purpose 128
spectra, evaluating 131
dye plate
about 128
create 139
custom dye 128

186

dyes
custom 130, 172
system 28, 129, 182

E

EFF%. See amplification efficiency.
electrical protective devices 31
electrical safety 22

electromagnetic compatibility standards.
See EMC standards

EMC standards 24
encryption software 32, 74, 99
endpoint read 173
ergonomics, safety 23
experiment 173
download from instrument 112
RNase P. See RNase P experiment.
send to instrument 112
type 174

experiment workflow
colocated layout 33
standalone layout 34

F

FAM™ system dye 28, 129
spectral profile 137, 138

file compression software 32, 74, 99
firewall software 32, 74, 99
forward primer 174

G

guidelines
background calibration 122
bleach solution, usage 145
chemical safety 19
chemical waste disposal 21
chemical waste safety 21
lifting and moving 40, 53, 79
networking 105
remote monitoring 110

H

hardware, optional 31
hazard icons. See safety symbols, on instruments.
hazard symbols. See safety symbols, on instruments
hazards. See safety
Help system, accessing 13
holding stage 174
housekeeping gene 174
humidity requirement
computer 53, 79
instrument 39
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IMPORTANT, description 15
incompatibilities, testing third-party software 32
installation
category, overvoltagerating 22
colocated layout 50—74
instrument 38—47
network 102—114
operating system updates 154
preparation 29
required materials 30
service pack updates 155
site preparation 39, 53, 79
software 5659, 8184
software, administrator rights requirement 59, 84
software, third-party 32, 74, 99
standalone layout 76—99
third-party software 32
using thisguide 29
Windows service pack updates 155
workflow 35, 38

installation kit
chemistry kit 42
packing kit 41—42
software and documentation kit 43
installation specification 66, 71, 89, 97
instrument
Automatic Private IP Addressing 106
background calibration 122—127
Computer Port 104
connect to anetwork 106
connect to computer 61
define settings 45
download experiment from instrument 112
dye calibration 128137
dye calibration (custom) 139-141
dye spectra 137, 138
installation 38—47
IPV4LL 104
LAN Port 104
load 68, 91
MAC address 106
maintenance data 117
maintenance schedule 116
mMDNS/DNS compatibility 104
placement 40
send experiment to instrument 112
setup 44
site preparation 39
spatia calibration 118—121
temperature verification service 117
unload 73, 93
instrument name, define 45
instrument operation, safety 18
internal positive control (IPC) 174
inventoried assays 174

IP settings, LAN Port 107

Index

IPC 174

IPC blocking agent 174
IPC+ 174

IPv4 link-local (IPV4LL) 104
italic text, whentouse 12

J

JOE™ system dye 28, 129
spectral profile 137, 138

K

kits provided
installation chemistry kit 42
packing kit 41-42
software and documentation kit 43

L

LAN Port
about 104
define |P settings 107
layout. See colocated layout or standalone layout.
lifting guidelines 40, 53, 79
line conditioner, requirements 31
load, instrument 68, 91
local area connection messages, disable 63

M

MAC address, instrument 106
made-to-order assays 174

maintenance
archiving files 142
back up, experiments 142
decontamination 145—147
disk space, checking 142
infrequent procedures 144
notifications 116
optics verification 117
required connection 116
run cycle performance test 117
schedule 116
statistics, instrument 117
temperature verification service 117
using thisguide 29
view information 117
managed data network service. See mDNS.
manual baseline 174
manual C; 174
materials required, to
analyze the RNase P experiment 93
create a background plate 127
decontaminate the sample block(s) 145
install the system 30
move the instrument 148
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Index

network the instrument 106

perform a background calibration 122
perform a custom dye calibration 139
perform adye calibration 128

perform a spatial calibration 118
perform an RNase P experiment 65, 88
replace the instrument fuses 150

set up remote monitoring 108

set up the computer 52, 78

ship the instrument 152

materials, shipped with the system 41
MDNS/DNS compatibility 104

Media Access Code address. See MAC address.
melt curve stage 175

melt curve 175

melting temperature (Tm) 175

menu commands, conventions for describing 12
monitor the instrument. See remote monitoring.
moving and lifting, safety 18

moving guidelines 40, 53, 79
multicomponent plot 175

N

NED® system dye 28, 129
spectral profile 138

negative control (NC) 175
negative control-blocked IPC wells 175
negative control-IPC wells 175
network 102—114
example layouts 103
guidelines 105
set up workflow 102
setup 102
using thisguide 29
no amplification control (NAC) 175
no template control (NTC) 175

nonfluorescent quencher-minor groove binder (NFQ-
MGB) 175

normalized quantity 175
normalized reporter (Rn) 175
notification settings, enable 113

0]

omit well 70, 96, 175
online Help. See Help system
operating system
prepare 56—58, 81—83
update 154

optics verification 117
optimization software 32

P

packing kit, contents 41—42

packing material, removal 45

passive reference 176

password, default for computer 55, 80

perform
background calibration 124
dye calibration 134—135
RNase P experiment 68, 91
spatial calibration 120

placement
computer 53, 79
instrument 40

plate layout 176

plates
background plate 122
background plate, custom 127
MicroAmp plates 41, 42
number of reuses 123
RNase P plate 42, 65, 88
spectral calibration plate 118, 128

point 176

positive control 176

post-PCR read 176

power lineregulator 31, 52, 78

power options settings, for the software 56, 81

power reguirement
computer 53, 79
instrument 39
preparation, system installation 29
prepare
background calibration 123—124
dye calibration 132—133
RNase P experiment 67, 90
spatial calibration 118—119

pre-PCRread 176

primer mix 176

primer/probe mix 176

protective devices, electrical 31

pure dye calibration. See dye calibration.
pure dyes 176

Q

guantitation method 176
quantity 176

guencher 177
QuickStart 177

R
R2 value 72, 98, 177

outl!er 175 radioactive waste, handling 21

outliers 70, 96 . ramp 177

overvoltage category (rating) 22
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raw dataplot 177
reaction mix 177
reagents 177
rea-time PCR 177
reference sample 178
refSNPID 178
regression
coefficients 178
line 178
regulator, power line 31, 52, 78
reject well 178
relative standard curve method 178
remote monitoring 102, 178
enable notification settings 113
guidelines 110
monitor instrument 110
set up (computer) 108

removing outliers from RNase Pruns 70, 96

repetitive motion, safety 23
replicate group 178
replicates 178
reporter 178
reguirements
computer 30, 53, 79
instrument 39
See also materials required.
reverse primer 178
reverse transcriptase 179
Rn. See normalized reporter.
RNase P experiment 65, 88
analyze 7072, 96—98
materialsrequired 65, 88
perform 68, 91
prepare 67, 90
purpose 65, 88
R2 value 72, 98, 177
transfer data 94
when to perform 65, 88
ROX™ system dye 28, 129, 179
spectral profile 137, 138
rsnumber 179
run cycle performance test 117
run method 179

S

safety
before operating the instrument 18
biological hazards 23
chemical 19
chemical waste 21
conventions 15
electrical 22
ergonomic 23
guidelines 19, 21
instrument operation 18

labels, on instruments 17
moving and lifting instrument 18
moving/lifting 18
repetitive motion 23
standards 24
symbols, on instruments 16
workstation 23
sample 179
sample block(s), decontaminate 145—147
Sample DNA (105) 179
SampleLibrary 179
Sample or Standard 179
sample/SNP assay reaction 179
sample/target reaction 179
screen resolution, for the software 57, 82
screen saver, for the software 56, 81
SDSs
description 19
obtaining 14, 20
security software 32, 74, 99
serial factor 179
series 179
service pack, updates 154
set up
computer 53, 78
instrument 44

site requirements
computer 53, 79
instrument 39

slope 179

SNP 179

SNP assay 180

SNP Assay Library 180

software
administrator rights requirement 59, 84
antivirus 32, 74, 99
encryption 32, 74, 99
file compression 32, 74, 99
firewall 32, 74, 99
instalation 5659, 8184
installation (third-party) 32

Index

installation, administrator rights requirement 59, 84

optional 31
prepare for use 86
prepare operating system 56-58, 81—83
shipped with the system 43
system optimization 32
software, third-party 32
spatial calibration 118—121, 180
analyzing the data 121
perform 120
prepare 118-119
purpose 118
specification, installation 66, 71, 89, 97
spectrum, system dyes 137, 138
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Index

stage 180
standalone layout 180
connect to anetwork 102
description 34
example network layout 103
installation 76—99
installation workflow 76
whentoinstal 76
standard
curve 180
curve method 180
standard dilution series 180
standard quantity 181
standard 180
standards
EMC 24
safety 24
starting quantity 181
statistics, instrument 117
step 181
storage devices, backup 31
surge protector, requirements 31, 44, 52, 78
SYBR® Green | dsDNA Binding Dye 28, 129
reagents 181
spectral profile 137, 138
symbols, safety 16
system
chemistry kit 42
components 41
data collection 27
documentation 43
packing kit 4142
software 43
system dyes 129, 137, 138, 182

T

TAMRA® dye 28, 129
spectral profile 138
TagMan® Fast Universal PCR Master Mix, No
AmpErase® UNG 65, 88

TagMan® RNase P Instrument Verification Plate 42, 65,

88
See also RNase P experiment.
TagMan™ reagents 182
target 182
color 182
library 182
task 182
Technical Support, contacting 14
temperature
plot 183
requirement, computer 53, 79
requirement, instrument 39
verification service 117

template 183
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test
optics verification 117
run cycle performance 117
third-party software for incompatibilities 32

text conventions 12

thermal profile 183

third-party software 32

threshold 183

threshold cycle C; 183

Tm. See melting temperature.

Tools menu, maintenance tests 117
touchscreen 183

training, information on 14

transfer data 94
download experiment from instrument 112
send experiment to instrument 112

U

uninterruptabl e power supply, requirements 31, 44, 52,

78

unknown 183
unknown-1PC wells 183
unload, instrument 73, 93
update

operating system 154

service packs 154
UPS, requirements 31, 44, 52, 78
USB drive, transfer data 34, 94
user attention words, described 12
user name, default for computer 55, 80
using this guide

instalation 29

maintenance 29
networking 29

\'

VIC® system dye 28, 129
spectral profile 137, 138

W

WARNING, description 15
waste disposal, guidelines 21
waste profiles, description 21
weight
computer 53, 79
instrument 39
Windows operating system
operating system upgrades, installation 155
service pack updates, installing 155
workflow
install the instrument 38
install the system 35
workstation safety 23
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Y
y-intercept 184

y4

zone 184
zone boundary 184
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